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Safety

This chapter contains:

NOICES AN SAFOLY .. et 12
ELECEMICAL SAFOLY ..ot 13
OPErAtiONAL SAFELY ... e e 15
MAINEENANCE SAFELY ... e e 17
PIINEET SYMIDOLS. . ...t 18
Environmental, Health, and Safety Contact Information............ccoouiiiiiiiii e 20

Your printer and the recommended supplies have been designed and tested to meet strict safety requirements.
Attention to the following information ensures the continued safe operation of your Xerox printer.
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Safety

Notices and Safety

Read the following instructions carefully before operating your printer. Refer to these instructions to ensure the
continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These include safety
agency evaluation and certification, and compliance with electromagnetic regulations and established
environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox® materials
only.

j’ Note: Unauthorized alterations, which can include the addition of new functions or connection of external
devices, can affect the product certification. For more information, contact your Xerox representative.
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Electrical Safety

GENERAL GUIDELINES

& Warning:

e Do not push objects into slots or openings on the printer. Touching a voltage point or shorting out a
part could result in fire or electric shock.

e Do not remove the covers or guards that are fastened with screws unless you are installing optional
equipment and are instructed to do so. Power off the printer when performing these installations.
Disconnect the power cord when removing covers and guards for installing optional equipment. Except
for user-installable options, there are no parts that you can maintain or service behind these covers.

The following are hazards to your safety:

e The power cord is damaged or frayed.

e Liquid is spilled into the printer.

e The printer is exposed to water.

e The printer emits smoke, or the surface is unusually hot.

e The printer emits unusual noise or odors.

e The printer causes a circuit breaker, fuse, or other safety device to activate.
If any of these conditions occur, do the following:

1. Power off the printer immediately.

2. Disconnect the power cord from the electrical outlet.

3. Call an authorized service representative.

POWER CORD SAFETY INFORMATION

Carefully read the following instructions before operating your printer. For details, contact your Xerox representative.

A\ Warning:

e The electrical supply for the device must meet the requirements stated on the data plate on the rear
of the device. If you are not sure that your electrical supply meets the requirements, consult your local
electricity provider or a licensed electrician.

e Do not use an extension cord.

e Do not remove or modify the power cord.

Refer to these instructions to ensure the continued safe operation of your printer.
e Use the power cord supplied with your printer.

e Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the cord is
connected securely. If you do not know if an outlet is grounded, ask an electrician to check the outlet.
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Safety

Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a ground
connection terminal.

Warning: Avoid the potential of electrical shock by ensuring that the printer is grounded properly.
Electrical products can be hazardous if misused.

Verify that the printer is plugged into an outlet that is providing the correct voltage and power. Review the
electrical specification of the printer with an electrician if necessary.

Do not place the printer in an area where people can step on the power cord.

Do not place objects on the power cord.

Replace the power cord if it becomes frayed or worn.

Do not unplug or plug the power cord while the printer is turned on.

To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.

The electrical outlet must be near the printer and must be easily accessible.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary to
disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet. For details, see
Restarting, Placing in Sleep Mode, or Powering Off the Printer.

EMERGENCY POWER OFF

If any of the following conditions occur, power off the printer immediately and disconnect the power cord from the
electrical outlet. Contact an authorized Xerox service representative to correct the problem if:

The equipment emits unusual odors or makes unusual noises.

The power cable is damaged or frayed.

A wall panel circuit breaker, fuse, or other safety device has been tripped.
Liquid is spilled into the printer.

The printer is exposed to water.

Any part of the printer is damaged.

TELEPHONE LINE CORD

& Warning: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger

telecommunication line cord.

14
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Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include safety agency
examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your printer.

OPERATIONAL GUIDELINES

e Do not remove any paper trays while the printer is printing.

e Do not open the doors when the printer is printing.

e Do not move the printer when it is printing.

e Keep hands, hair, neckties, and so on, away from the exit and feed rollers.

e Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove the
protective covers.

e Do not override any electrical or mechanical interlock devices.

e Do not attempt to remove paper that is jammed deeply inside the product. Power off the printer promptly and
contact your local Xerox representative.

e Ensure that the rear right cover is attached. Open this cover to connecting an interface cable.

OZONE RELEASE

This printer produces ozone during normal operation. The amount of ozone produced is dependent on copy volume.
Ozone is heavier than air and is not produced in amounts large enough to harm anyone. Install the printer in a well-
ventilated room.

For more information in the United States and Canada, go to www.xerox.com/about-xerox/environment/enus.html.
In other markets, please contact your local Xerox representative or go to www.xerox.co.uk/about-xerox/
environment/engb.html.

PRINTER LOCATION

o Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. To find the
weight for your printer configuration, refer to Physical Specifications.

e Do not block or cover the slots or openings on the printer. These openings are provided for ventilation and to
prevent overheating of the printer.

e Place the printer in an area where there is adequate space for operation and servicing.

e Place the printer in a dust-free area.

e Do not store or operate the printer in an extremely hot, cold, or humid environment.

e Do not place the printer near a heat source.

e Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.

» Do not place the printer where it is directly exposed to the cold air flow from an air conditioning system.

e Do not place the printer in locations susceptible to vibrations.
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Safety

e For optimum performance, use the printer at the elevations specified in Elevation.

PRINTER SUPPLIES

e Use the supplies designed for your printer. The use of unsuitable materials can cause poor performance and a
possible safety hazard.

e Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.
e Store all consumables in accordance with the instructions given on the package or container.

e Keep all consumables away from the reach of children.

e Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame.

e When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can cause
irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase the risk of skin or
eye contact.

(D Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and
Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused
by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The Total
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these
areas. Please contact your Xerox representative for details.
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Maintenance Safety

e Do not attempt any maintenance procedure that is not specifically described in the documentation supplied
with your printer.

e Clean with a dry lint-free cloth only.

e Do not burn any consumables or routine maintenance items. For information on Xerox® supplies recycling
programs, go to www.xerox.com/recycling.

A Warning: Do not use aerosol cleaners. Aerosol cleaners can cause explosions or fires when used on
electromechanical equipment.

When installing the device in a hallway or similar restricted area, additional space requirements can apply. Ensure
that you comply with all workspace safety regulations, building codes, and fire codes for your area.
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Safety

Printer Symbols

DESCRIPTION

()]
=<
<
o
(@)
=

Warning:

Indicates a serious hazard that can result in death or serious injury if not avoided.

Hot Warning:

Hot surface on or in the printer. Use caution to avoid personal injury.

Warning: Moving parts. To avoid personal injury, use caution.

T

Caution:

Indicates a mandatory action to take in order to avoid damage to the property.

Caution:

To avoid damage to the property, be careful not to spill toner when handling the
waste cartridge.

Do not touch the part or area of the printer.

Do not expose the drum cartridges to direct sunlight.

Do not burn the toner cartridges.

Do not burn the waste cartridge.

Do not burn the drum cartridges.

Do not use paper attached with staples or any form of binding clip.

DAV PRB

Do not use folded, creased, curled, or wrinkled paper.

18
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SYMBOL DESCRIPTION
i' Do not use inkjet paper.

Do not use transparencies or overhead projector sheets.

Do not reload paper previously printed on or used.

Do not copy money, revenue stamps, or postage stamps.

For details about all the printer symbols that appear on your printer, refer to the Printer Symbols guide at www.
xerox.com/support/ALB80XXdocs.
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Safety

Environmental, Health, and Safety Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, contact:
e United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)

e FEurope: EHS-Europe@xerox.com

For product safety information in the United States and Canada, go to www.xerox.com/about-xerox/environment.

For product safety information in Europe, go to www.xerox.com/about-xerox/environment_europe.
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Parts of the Printer

FRONT VIEW

22
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Locking Casters

Tray 5
Left Side Door
USB Port

Document Cover

Document Glass
Control Panel
Center Output Tray

Front Door

© v o N o

Trays 1-4
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DUPLEX AUTOMATIC DOCUMENT FEEDER

1. Confirmation Indicator 5. Document Output Tray

2. Top Cover 6. Constant Velocity Transport (CVT) Glass
3. Document Guides 7. Document Glass

4. Document Feeder Tray
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Duplex Automatic Document Feeder Guidelines

The duplex automatic document feeder scans both sides of 2-sided documents at the same time. The confirmation
indicator illuminates when you load the original documents correctly.

The duplex automatic document feeder accommodates the following paper sizes and weights:

e Width: 138-297 mm (5.4-11.7 in.)

e Llength: 125-432 mm (4.9-17in.)

e Weight: 50-160 g/m?

Follow these guidelines when loading original documents into the duplex automatic document feeder:
e Load original documents face up so that the top of the document enters the feeder first.

e Place only loose sheets of undamaged paper in the duplex automatic document feeder.

e Adjust the paper guides so that they fit against the original documents.

e Insert paper in the duplex automatic document feeder only when ink on the paper is dry.

e Do not load original documents above the MAX fill line.

Document Glass Guidelines

The document glass accommodates original size documents up to A3 (297 x 420 mm, 11 x 17 in.). Use the
document glass rather than the automatic document feeder to copy or scan the following types of original
documents:

e Paper with paper clips or staples attached

e Paper with wrinkles, curls, folds, tears, or notches

e Coated or carbonless paper or items other than paper, such as cloth or metal
e Envelopes

e Books

CONTROL PANEL

The control panel consists of a touch screen and buttons you press to control the functions available on the printer.
The control panel:

Displays the current operating status of the printer.

e Provides access to print, copy, and scan features.

e Provides access to reference materials.

e Provides access to Tools and Setup menus.

e Prompts you to load paper, replace supplies, and clear jams.
e Displays errors and warnings.

e Provides the Power/Wake button used for powering on or off the printer. This button also supports the power-
saver modes, and blinks to indicate the power status of the printer.
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NAME
NFC Area

DESCRIPTION

Near Field Communication (NFC), is a technology that enables
devices to communicate when they are within 10 cm (4 in.) of each
other. Use the NFC area to obtain a network interface or to establish
a TCP/IP connection between your device and the printer.

Touch Screen Display

The screen displays information and provides access to printer
functions.

Home Button

This button provides access to the Home menu for access to printer
features, such as copy, scan, and fax.

Power/Wake

This button serves several power-related functions.

e When the printer is powered off, this button powers on the
printer.

e When the printer is powered on, pressing this button displays a
menu on the control panel. From this menu, you can choose to
enter Sleep mode, restart, or power off the printer.

e When the printer is powered on, but in Sleep mode, pressing this
button wakes the printer.

e When the printer is powered on, holding this button for 10
seconds turns off the printer.

This button blinks to indicate the power status of the printer.

e When the light blinks slowly, the printer is in Sleep mode.
e When the light blinks rapidly, the printer is powering down.

Status LED

This light blinks blue or amber to indicate printer status.
Blue

e Blinks blue once to acknowledge a successful Authentication
request.

e Blinks blue once slowly for a copy or print job initiated at the
control panel.
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ITEM

NAME

DESCRIPTION

e Blinks blue twice slowly for fax or print job received from the
network.

e Blinks blue rapidly while the printer is powering up, or to signal
detection of a Wi-Fi Direct connection request.

Amber

e Blinks amber to indicate an error condition or warning that
requires your attention. For example, an out-of-toner condition, a
paper jam, or out of paper for the current job.

e Blinks amber to indicate a system error, which typically is
associated with an error code.

Notification Area

Notifications are displayed above the Apps area. To view the full
notification, touch the notification area. After you have reviewed the
information, touch X.

Interrupt Button

This button pauses the current job to run a more urgent job.

f Note: This option may be hidden from view. To enable
Interrupt, refer to the System Administrator Guide at www.
xerox.com/support/ALB80XXdocs.

Pause Button

Use this button to pause the current job. The job pauses with the
option to resume printing or delete the job.

Language Button

The Language button allows you to set the language that appears
temporarily on the control panel display.

f Note: This option may be hidden from view. For details, see
the System Administrator Guide at www.xerox.com/support/
ALB80XXdocs.

10

Reset

f Note: Use the Reset button to reset all the apps to their
default settings.
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INTERNAL PARTS

1. Transfer Roller 4. Print Cartridge Release Lever
2. Fuser Assembly 5. Toner Cartridge
3. Fuser Module 6. Print Cartridge
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REAR VIEW
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1. Upper Rear Cover 6. USB Ports, Type A
2. Lower Rear Cover 7. Ethernet Connection
3. USB Memory Port, for service only 8. Status Indicator
4. USB Memory Card Connections 9. Foreign Device Interface (optional)
5. USB Port, Type B 10. Fax Connections (optional)
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CONFIGURATIONS AND OPTIONS

—_

Duplex Automatic Document Feeder

Tray 5 - Bypass Tray

Tray 1

Tray 2

Trays 3 and 4 - High Capacity Tandem Trays
Tray 6 - High Capacity Feeder

Convenience Stapler and Work Surface

Office Finisher

© % N o & W N

Office Finisher with Booklet Maker

—_
(@]

. High Volume Finisher with Booklet Maker
11. Post Process Inserter Tray

12. C/Z Folder Unit

13. External Keyboard

14. RFID Kit
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Paper Tray Options

Configuring Dedicated Paper Trays

The system administrator can set trays to Fully Adjustable mode or Dedicated mode. When a paper tray is set to
Fully Adjustable mode, you can change paper settings each time that you load the tray. When a paper tray is set to
Dedicated mode, the control panel prompts you to load a specific paper size, type, and color.

Your printer can have three high-capacity paper trays installed, depending on configuration. High-capacity trays are
configured as Dedicated trays. Each high-capacity tray can feed A4 (210 x 297 mm) or Letter (8.5 x 11 in.) paper as
standard. Tray 6 can feed more paper sizes if the optional kits are installed. High-capacity trays are designed to hold
larger amounts of paper for fewer printing interruptions.

f Note: To configure tray settings, refer to the System Administrator Guide at www.xerox.com/support/
ALB80XXdocs.

Configuring Trays 3 and 4

Trays 3 and 4 in the Tandem Tray Module are high-capacity paper trays that can hold A4-size (210 x 297 mm) or
Letter-size (8.5 x 11 in.) paper. You can adjust these trays to hold either of these paper sizes.

To configure Trays 3 and 4 in the Tandem Tray Module:

f Note: Access to the rear paper guide in Tray 3 is limited. If you require assistance to adjust the paper trays,
contact your local Xerox representative.

1. To access the rear paper guides in Trays 3 and 4, remove Tray 2 from the printer.
2. Pull out Tray 3 or 4 and remove any paper from the tray.

3. To adjust the front paper guide, slide forward the green clips, then lift the front paper guide gently to release it
from the tray. Move the guide to the new paper-size position. Align the tabs at the top and bottom of the
guide with the corresponding slots on the tray, then slide back the green clips.
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4. To adjust the rear paper guide, slide back the green clips, then lift the rear paper guide gently to release it from
the tray. Move the guide to the new paper-size position. Align the tabs at the top and bottom of the guide with
the corresponding slots on the tray, then slide forward the green clips.

5. To adjust the front right-side paper guide, press the pin on the outside of the tray inward. To release the black
paper guide from the side of the tray, gently pull out the guide, then pull it up. Move the guide to the new
position, align the bottom hook of the guide with the new position, then press the guide firmly into place.
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6. To adjust the rear right-side paper guide, press the pin on the outside of the tray inward. To release the black
paper guide from the side of the tray, gently pull out the guide, then pull it up. Move the guide to the new
position, align the bottom hook of the guide with the new position, then press the guide firmly into place.

7. Replace Tray 2.

8. To change the settings for the new paper size, refer to Configuring Tray Settings.

Configuring Tray 6

Tray 6 is a dedicated high-capacity tray that holds A4-size (210 x 297 mm) paper or Letter-size (8.5 x 11 in.) paper.
You can adjust the tray to hold either of these paper sizes.

j’ Note:

e If the narrow SEF (Short-Edge Feed) conversion kit is installed, you can adjust the tray for A4-size (210 x
297 mm), Letter-size (8.5 x 11 in.), or Legal-size (8.5 x 14 in.) paper.

e If the wide SEF conversion kit is installed, you can adjust the tray for A3-size (297 x 420 mm) or Tabloid-
size (11 x 17 in.) paper.

1. Open the door to Tray 6 and remove any paper.
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2. To adjust the two paper guides at the back of the tray, slide up the paper-guide retainer to the unlock position.
Move the paper guide to the new slot, then slide it down into position.

3. To secure the paper guide, slide down the paper-guide retainer to the lock position.
4. Load the new paper size into the tray, then close the tray door.

5. To change the tray settings for the new paper size, refer to Configuring Tray Settings.

Wireless Network Adapter

The wireless network adapter is a USB device that transfers data between the printer and a wireless local area
network (LAN). The wireless network adapter supports common wireless security protocols, such as WEP, WPA,
WPA2, and 802.1X standard port-based network access control.

The wireless network adapter allows multiple users on a wireless LAN to print to and scan from Xerox® printers. The
wireless network adapter also supports printers that include network scan and fax features.
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Power Options

POWERING ON THE PRINTER OR EXITING SLEEP MODE

The printer has a single multifunction button on the control panel. The Power/Wake button restarts, powers up, or
powers down the printer. This button also enters and exits sleep mode, and flashes when the printer is in power
saver mode.

To power on the printer, or to exit Sleep mode, press the Power/Wake button.

fo Note:

e The Power/Wake button is the only power button on the printer.

e When in Sleep mode, the touch screen and scanner are powered off and unresponsive during a print job
execution. To wake the printer manually, press the Power/Wake button.

e If Auto Power Off is enabled, the printer powers off automatically after the specified conditions are met.
To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System
Administrator Guide at www.xerox.com/support/ALB80XXdocs.

® Caution: Do not plug or unplug the power cord while the printer is powered on.

RESTARTING, PLACING IN SLEEP MODE, OR POWERING OFF THE PRINTER

To restart the printer, place the printer in Sleep Mode, or power off the printer:
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1. At the printer control panel, press the Power/Wake button.

2. Select an option.
e To restart the printer, touch Restart.
e To place the printer in Sleep Mode, touch Sleep.
In Sleep Mode, the touch screen goes dark and the Power/Wake button flashes.
e To power off the printer, touch Power Off.

e If the printer does not respond to a single press of the Power/Wake button, then press and hold the button
for 5 seconds. A Please Wait message appears as the printer powers down.

After 10 seconds, the touch screen goes dark and the Power/Wake button flashes until the printer powers
down.

@ Caution: Do not unplug the power cord while the printer powers down.
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Accessing the Printer

AUTHENTICATION

Authentication is the process of confirming your identity. When the system administrator enables authentication,
the printer compares the information that you provide to another source of information, such as an LDAP directory.
The information can be a user name and password, or the information stored on a magnetic, proximity, RFID, or
smart card. If the information is valid, you are considered an authenticated user.

There are several ways to authenticate a user:

e User Name/Password - Validate on the Device: This option enables local authentication. Users prove their
identity by typing a user name and password at the control panel or in the Embedded Web Server. The printer
compares the user credentials to the information stored in the user database. If there are a limited number of
users, or you do not have access to an authentication server, use this authentication method.

e User Name/Password - Validate on the Network: This option enables network authentication. Users prove
their identity by typing a user name and password at the control panel or in the Embedded Web Server. The
printer compares the user credentials to the information stored on an authentication server.

o Convenience Authentication: If this option is enabled, a card with a magnetic strip or a Radio Frequency
Identification (RFID) card is used. A convenience authentication card is different from a Smart Card, which uses
an embedded chip and typically requires a login and password. If the optional integrated RFID reader is
installed, for authentication, users place a pre-programmed card over the RFID reader at the control panel.

e Xerox Secure Access - Unified ID System: This option enables authentication for the Xerox Secure Access
Unified ID System. Users present a pre-programmed identification card to a card reader at the control panel.
The printer compares the user credentials to the information stored on the Xerox® Secure Access server.

¢ Smart Cards: This option enables authentication for a Smart Card Reader. Users insert a pre-programmed
identification card in a card reader at the control panel.

j’ Note: The system administrator can allow you to type your user name and password when Convenience
Authentication or Smart Card is the primary authentication method. If the administrator configures an
alternative authentication method, and you misplace your card, you can still access the printer.

For information about configuring Authentication settings, refer to the System Administrator Guide at www.xerox.
com/support/ALB80XXdocs.

AUTHORIZATION

Authorization is the function of specifying the features that users are allowed to access, and the process of
approving or disapproving access. You can configure the printer to allow users to access the printer, but restrict
access to certain features, tools, and apps. For example, you can allow users to access copying but restrict access to
scanning. You can also control access to features at specific times of the day. For example, you can restrict a group
of users from printing during peak business hours.

There are two types of authorization:
e Local Authorization verifies user information on the printer to approve access.

o Network Authorization verifies user information stored externally in a network database, such as an LDAP
directory, to approve access.

36 Xerox® AltaLink® B80XX Series Multifunction Printer User Guide


http://www.support.xerox.com/support/altalink-b8000-series/documentation
http://www.support.xerox.com/support/altalink-b8000-series/documentation

Getting Started

For information about configuring Authorization settings, refer to the System Administrator Guide at www.xerox.
com/support/ALB80XXdocs.

PERSONALIZATION

Personalization is the process of customizing apps for a specific user. When a user logs in to the device and
personalized information is required, the device searches an LDAP directory for the information. Personalized
information examples are a Home destination or email address. The device uses the personalized information to
complete the task.

For information about configuring settings, refer to the System Administrator Guide at www.xerox.com/support/
ALB80XXdocs.

ACCOUNTING

Accounting is used to track and record the numbers of Copy, Print, Workflow Scanning, Server Fax, and Fax jobs that
the device produces for each user. The system administrator must create user accounts and enable the accounting
feature. After Accounting is enabled, log in to the printer to access restricted apps. Before printing documents from
a computer, provide your account details in the print driver.

The system administrator can set limits to restrict the total number of jobs by type that a user can send to the
printer. The administrator can generate reports listing usage data for individual users and groups.

For details, refer to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

LOGGING IN

Logging in is the process by which you identify yourself to the printer for authentication. If authentication is set, to
access printer features, you log in with your user credentials.

Logging In at the Control Panel

& Note:
e Before logging in for the first time at the Xerox device control panel, log in to the Embedded Web Server,
then update your password. For details, refer to Logging In Using the Embedded Web Server.
e If you do not know your user name or password, contact your system administrator.
1. At the printer control panel, press the Home button.
Touch Log In.

For User Name, use the keypad and enter your name, then touch Next.

&owe N

If prompted, enter the password, then touch Done.

j’ Note: To access each app that is password-protected, repeat steps 3 and 4.
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Introduction to Xerox® Apps

Xerox ® Apps are a gateway to the features and functions of your device. There are standard Apps already installed
and displayed on the Home screen. Some Apps are installed as standard, but are hidden when you use your device
for the first time. You can show, hide, or reorder Apps on the Home screen using the settings available in the
Embedded Web Server.

For details about displaying, configuring, and customizing the Apps, refer to the System Administrator Guide at
www.xerox.com/support/ALB80XXdocs.

A range of Apps are available for download and installation from the Xerox ® App Gallery. These include Xerox
®Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed apps on compatible printers.

For more information about using the Xerox ® App Gallery and downloading Apps, refer to Xerox® App Gallery.
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Your printer has a set of information pages that you can print. These pages include configuration and font

information, demonstration pages, and more.

To print an information page, select an option, then touch Print.

The following Information Pages are available:

NAME DESCRIPTION

Configuration Report

The Configuration Report provides printer information
including the serial number, installed options, network
settings, port setup, tray information, and more.

Billing Summary

The Billing Summary Report provides information
about the device and a detailed listing of the billing
meters and sheet counts.

Quick Use Guide This guide provides an overview of the key features of
the printer.
PCL Font List The PCL Font List provides a printout of all PCL fonts

that are available on the printer.

PostScript Font List

The PostScript Font List provides a printout of all
PostScript fonts that are available on the printer.

CONFIGURATION REPORT

The Configuration Report provides product information including installed options, network settings, port setup, tray

information, and more.

Printing the Configuration Report
1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.

3. Touch Configuration Report.

4. To return to the Home screen, press the Home button.

Xerox® AltaLink® B80XX Series Multifunction Printer User Guide

39



Getting Started

The Embedded Web Server

The Embedded Web Server is the administration and configuration software that is installed in the printer. It allows
System Administrators to modify network and system settings on the printer remotely using a Web browser.

You can check the status of the printer, monitor paper and supply levels, and submit and track print jobs. All these
functions can be accessed from the convenience of your computer.

The Embedded Web Server requires:
e ATCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux environments.
e TCP/IP and HTTP enabled in the printer.

e A network-connected computer with a Web browser that supports JavaScript.

ACCESSING THE EMBEDDED WEB SERVER

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or
Return.

To use the Embedded Web Server, click the page required:

e Home: This page provides a description of the printer and current notifications, the status of the paper trays,
and supplies and billing information. There is a Quick Links area at the bottom of the page that provides direct
access to key functions and pages.

e Jobs: The Jobs page enables you to manage active jobs on the printer, view, print, and delete saved jobs, and
create and manage saved job folders.

e Print: This page enables you to submit print-ready files to the printer for printing. You can select options for
print jobs using this page. Only print-ready files can be submitted, for example PDF, PS, PCL, and XPS file
formats.

e Scan: The Scan page enables you to create distribution workflows and mailboxes for scanned documents.

e Address Book: Use the Address Book page to create a Device Address Book containing contacts for use with
the fax, email, and scanning apps. You can configure the printer to use a Network Address book that looks up
addresses from an LDAP directory. The printer can also be configured to use a Network Address Book, which
looks up addresses from an LDAP directory. If both the Address Book and Device Address Book are configured,
users are presented with a choice when they use a compatible app.

e Properties: You can use the Properties tab to access and configure settings for your device. System
administrator login credentials are required to change most settings.

e Support: This page provides access to general support information and telephone numbers. You can use the
Support page to access the Remote Control Panel and send diagnostic information to Xerox.

The Embedded Web Server has a Help option that provides information about all available device features and
functions. To access Help, click the Help link displayed at the bottom of each page. Navigate to the topic required,
or use the Search function to find specific information.

For detailed instructions on how to use the Embedded Web Server to configure printer settings, refer to the System
Administrator Guide at www.xerox.com/support/ALB80XXdocs.
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LOGGING IN USING THE EMBEDDED WEB SERVER

To access certain features, tools, and apps, log in to the Embedded Web Server for your device.

j’ Note: Access to some restricted functions requires administrator rights. For more information, refer to the
System Administrator Guide atwww.xerox.com/support/ALB80XXdocs.

To log in to the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

2. Inthe top right area of the page, click Login.

3. Enter your User ID and password, then click Login.

4. If you are logging in for the first time, set up a password.
Type the old password.

a
b. Type anew password. To verify the password, retype it.

j’ Note: The new password must adhere to all minimum password requirements. For details, contact your
systemn administrator, or refer to the System Administrator Guide atwww.xerox.com/support/ALB80XXdocs.

c. Click Save. The new password is stored.

FINDING THE IP ADDRESS OF YOUR PRINTER

To install the print driver for a network-connected printer, it is often necessary to know the IP address of your
printer. Also, the IP address is used to access the settings of your printer through the Embedded Web Server. You
can view the IP address of your printer on the control panel or on the Configuration Report.

j’ Note: To view the TCP/IP address on the control panel, wait until the printer has been on for 2 minutes. If
the TCP/IP address is 0.0.0.0, or begins with 169, it indicates a network connectivity issue. However, if Wi-Fi
is set as the primary Ethernet connection, 0.0.0.0 is displayed as the IP address for the printer.

Viewing the IP Printer Address on the Control Panel
To view the IP address of the printer on the control panel:
1. At the printer control panel, press the Home button.
Touch Device > About.

Record the IP address from the display.

&N

To return to the Home screen, press the Home button.

Obtaining the Printer IP Address from the Configuration Report
To obtain the printer IP address from the Configuration Report:
1. At the printer control panel, press the Home button.

2. Touch Device > About > Information Pages.
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3. Touch Configuration Report.
The IP address appears in the Connectivity section of the Configuration Report for IPv4 or IPvé.

4, To return to the Home screen, press the Home button.

DOWNLOADING THE CONFIGURATION REPORT FROM THE EMBEDDED WEB SERVER

From the Embedded Web Server, you can download and save a copy of the Configuration Report to your computer
hard drive. Use Configuration Reports from multiple devices to compare software versions, configurations, and
compliance information.

To download a copy of the Configuration Report from the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

f Note: For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your
Printer.

2. To download the Configuration Report, scroll to the bottom of the page. In the Quick Links section, click
Download Configuration Report.

j’ Note: If the Download Configuration Report feature does not appear, log in as a system administrator.

The document is saved automatically as an XML file in the default download location on your computer hard
drive. To open the Configuration Report, use an XML viewer.
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Installation and Setup
For reference:
e Installation Guide packaged with your printer

e Online Support Assistant at www.xerox.com/support/ALB80XXdocs

INSTALLATION AND SETUP OVERVIEW

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected. Configure
the initial settings of the printer, then install the print driver software and utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect to a network using an Ethernet
cable or wireless connection. Hardware and cabling requirements vary for the different connection methods.
Routers, network hubs and switches, modems, Ethernet cables, and USB cables are not included with your printer
and must be purchased separately. Xerox recommends an Ethernet connection because it is typically faster than a
USB connection, and it provides access to the Embedded Web Server.

For more information, refer to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

SELECTING A LOCATION FOR THE PRINTER

1. Select a dust-free area with temperatures from 10-28°C (50-83°F), and relative humidity 15-85%.

j’ Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can cause
condensation inside the printer, directly interfering with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight of the
printer. The printer must be horizontal with all four castors in solid contact with the surface. To find the weight
for your printer configuration, refer to Physical Specifications. Select a location with adequate clearance to
access supplies and to provide proper ventilation. To find the clearance requirements for your printer, refer to
Clearance Requirements.

3. After positioning the printer, you are ready to connect it to the power source and computer or network.
CONNECTING THE PRINTER

Connecting to a Wired Network

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is used for
one or more computers and supports many printers and systems simultaneously. An Ethernet connection provides
direct access to printer settings using the Embedded Web Server.

To connect the printer:
1. Connect the power cord to the printer, then plug the cord into an electrical outlet.

2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the back of the printer.
Connect the other end of the cable to a correctly-configured network port.

3. Power on the printer.
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For details on configuring connection settings, refer to the System Administrator Guide at www.xerox.com/support/
ALB80XXdocs.

Connecting to a Wireless Network

If you have purchased the Wireless Network Adapter, you can use the Wireless Wizard to connect the device to a
wireless network. If the device is connected to a wired network, you can configure wireless settings in the
Embedded Web Server.

f Note:

e For more information, refer to the Xerox® Wireless Network Adapter Kit Hardware Install and Setup
instructions that are included with the kit.

e The device uses either the wireless or the wired network connection. Activating one network connection
deactivates the other network connection.

For details on configuring wireless network settings, refer to the System Administrator Guide at www.xerox.com/
support/ALB80XXdocs.

Connecting with Wi-Fi Direct

You can connect to your printer from any Wi-Fi-enabled mobile device, such as a tablet, computer, or smart phone,
using Wi-Fi Direct or Soft AP features. The Wi-Fi Direct feature is disabled by default on the Xerox device.

j’ Note: The Wi-Fi Direct feature is available only on printers with the optional Wireless Network Adapter
installed. After you install the Wireless Network Adapter, the Wi-Fi Direct feature is enabled by default.

Wi-Fi Direct Overview

The Wi-Fi Direct feature allows you to print from a mobile device to your printer, using one of the following
methods.

e WPS push button, for Wi-Fi Direct-enabled Android devices with the Mopria print plug-in installed.
e Soft Access Point (AP), for Apple iPhones and other mobile devices that do not support the Wi-Fi Direct function.

For information about using the Wi-Fi Direct feature on your mobile device, or connecting to the printer using the
Soft AP feature, refer the mobile device documentation from the manufacturer.

For information about configuring the Wi-Fi Direct feature on your printer, refer to the System Administrator Guide
at www.xerox.com/support/ALB80XXdocs.

Using Wi-Fi Direct on Your Mobile Device

The Wi-Fi Direct WPS Push Button feature requires the Mopria Print Service App installed on your mobile device. The
printer does not require a wireless connection.

Installing Mopria Print Service

1. On your mobile device, go to the Google Play Store, then search for Mopria Print Service.
Install the Mopria Print Service App.

Go to Settings, then touch Printing.

& W N

Go to the notification area, then touch Mopria Print Service.
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To enable Mopria Print Service, touch On.

Exit Settings.

Your mobile device searches for Wi-Fi Direct-enabled printers that are in range of the mobile device.

Using Wi-Fi Direct on your Printer

Wi-Fi Direct is a direct wireless connection from your mobile device to the printer. The Wi-Fi Direct feature is
enabled by default when the Wi-Fi hardware is installed.

Using the Wi-Fi Direct feature does not require a wireless network connection to a printer. Contact your System
Administrator to connect your printer to a wired or wireless network.

Printing Using Wi-Fi Direct

To print a document from a Wi-Fi-enabled mobile device:

1.
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On the mobile device, open the document that you want to print.

In the device application, select the Print button.

If there is more than one printer in the area with Wi-Fi Direct enabled, select the required printer from the list.
Select the print settings required for the job.

Submit the job for printing.

A message appears on the mobile device.

Select Connect.

When the connection is made, a message appears on the printer.

At the printer control panel, touch OK.

The job prints.

Connecting to a Computer Using USB

Ensure that you have one of the following operating systems installed on your computer.

Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server 2008 R2, and Windows Server
2012.

Macintosh OS X version 10.9 and later.

UNIX and Linux: Your printer supports connection to various UNIX platforms through the network interface.

To connect the printer to the computer using a USB cable:

1.
2.
3.
4.

Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the printer.
Connect the A end of the USB cable to the USB port on the computer.
If the Windows Found New Hardware Wizard appears, cancel it.

Install the print driver.

For more information, refer to Installing the Print Driver Software.
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Connecting with Near Field Communication (NFC)

NFC Overview

when they are in close range. NFC allows you to add a printer to your Android mobile
device easily. After you add the printer, there is no need to use NFC on that printer. You
can use NFC to obtain the network interface to establish a TCP/IP connection between
your device and the printer.

ff@ Near field communication (NFC) is a technology that enables devices to communicate

Devices can communicate using NFC when they are within the following ranges:
e Device with case: 17-20 mm (0.7 x 0.8 in.)

e Device without case: 20-25 mm (0.8 x 1 in.)

f Note: The range can vary depending on the device manufacturer. For information about the required
settings for individual mobile devices, refer the documentation supplied by the manufacturer of your mobile
device.

For details about configuring NFC on your printer, refer to the System Administrator Guide at www.xerox.com/
support/ALB80XXdocs.

Using NFC on your Mobile Device
The NFC feature requires installation of the Xerox Print Service app on the mobile device.

Your mobile device must use the same Wi-Fi network environment as the printer. The printer does not need to have
a wireless connection.

f Note: NFC supports Android 4.4 or greater devices.

Installing the Xerox Print Service Plugin

1. On your mobile device, go to the Google Play Store, then search for Xerox Print Service Plugin.
Install the Xerox Print Service Plugin app.

Go to Settings, then touch Printing.

Go to the notification pull-down bar, then touch Xerox Print Service.

To enable Xerox Print Service, touch On.

o v &~ W N

Exit Settings.

Enabling NFC on the Mobile Device

Most mobile devices have NFC disabled by default.
To enable NFC:

1. Go to Settings.

2. Go to the NFC setting, then touch On.

3. Exit Settings.
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Using NFC on your Printer

The NFC chip is on the bottom right of the control panel. When NFC is enabled, the NFC icon is lighted, and you
can use the NFC function.

cee e @

Refer to your mobile device user documentation for the mobile device NFC chip location.

f Note: The NFC function must be enabled before use. For NFC enable instructions, refer to the System
Administrator Guide at www.xerox.com/support/ALB80XXdocs.

Mapping the Printer to your Mobile Device

1. Open the Xerox Print Service Plugin.

At the top right side of the screen, touch the selection button, then select Add Printer.
Touch the NFC option.

&~ W N

Hold the mobile device over the NFC icon on the control panel.

|
e 1
SN
The mobile device and the printer communicate with each other. The mobile device searches the network for the
printer. When the printer is located, it is added to the list as a mapped printer.

You can submit print jobs from your mobile device to the printer.

Printing using Mopria

1. Open the document that you want to print.

At the top of the screen, select the Print button.

If there is more than one printer mapped for use with NFC, select the printer required.

Select the print settings required for the job.

voBw N

Submit the job for printing.
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Configuring AirPrint

AirPrint is a software feature that allows you to print documents from Apple iOS-based mobile devices and Mac OS-
based devices without a print driver. AirPrint-enabled printers allow you to print or fax directly from a Mac or from
an iPhone, iPad, or iPod touch. You can use AirPrint to print from a wired or wireless device directly without using a
print driver. You can also use AirPrint to scan from a printer to supported Apple devices.

AirPrint

f Note:

e Not all applications support AirPrint.
e When AirPrint is enabled, HTTP, IPP, and Multicast DNS are enabled automatically.
e [PPenablement requires a Web server reset.

e The device that submits the AirPrint job must be on the same subnet as the printer. To allow devices to
print from different subnets, configure your network to pass multicast DNS traffic across subnets.

e Supported mobile devices: all models of iPad, iPhone 3GS or later, and iPod touch third generation or
later, running the latest version of iOS.

e If AirPrint is not available on your device, contact your Xerox representative.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

f Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. Inthe Embedded Web Server, click Properties > Connectivity > Setup.

j’ Note: If this feature does not appear, log in as a system administrator. For details, refer to the System
Administrator Guide at www.xerox.com/support/ALB80XXdocs.

3. For Mobile Workflows, for AirPrint, click Edit.
4. Configure HTTP, IPP, and Multicast DNS Registration as required. To configure a protocol, click Edit.
5. To enable AirPrint, for Enablement, select one or both options:

e Allow Printing/Faxing to be initiated From AirPrint Supported Devices

e Allow Scanning to be initiated From AirPrint (or Mopria) Supported Devices
& Note:

e AirPrint Faxing is supported only on devices that have embedded fax enabled and are configured to
allow sending.

e AirPrint Printing/Faxing is enabled by default.
e To require authentication for AirPrint Printing and Faxing, configure IPP authentication.

e Enabling scanning for AirPrint also enables scanning for Mopria.
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6. For Require Authentication for Scanning, select an option:
e Off: This option allows the device to scan without requiring authentication.

e HTTP Basic: This option authenticates with user accounts that are configured in the device user database
or in the network database.

f Note: HTTP Basic sends user login credentials as plain, unencrypted text over HTTP. To send encrypted login
credentials, use HTTPS.

e HTTP Digest: This option authenticates with user accounts that are configured in the device user database.
7. If you selected HTTP Basic authentication, for Validation Location, select an option:

e Validation on the Device: This option enables IPP authentication of user accounts that are configured in
the device user database.

e Validation on the Network: This option enables IPP authentication of user accounts that are configured
on the network authentication server for the device.

f Note: The same network authentication configuration is used on the printer for each login method that is
configured for Network Authentication.

8. To edit the device name or location, for Device Name, Device Location, or Geographic Location, click Edit.
j’ Note: Providing a device name can help users identify the device.

9. Click Save.

For additional information about AirPrint configuration and settings, refer to the System Administrator Guide at
www.xerox.com/support/ALB80XXdocs.

Configuring Google Cloud Print

Google Cloud Print allows you to print documents from an Internet-connected device without using a print driver.
Documents stored in the cloud, a personal computer, tablet, or smartphone can be sent to the printer from
anywhere.

For more information on Google Cloud Print, including procedures for managing accounts, sharing printers, and
printing, refer to the Google Cloud Print Help Center.

Before you begin:

e Set up a Google email account.

e Configure the printer to use IPv4.

e Configure Proxy Server settings as needed.
To configure Google Cloud Print:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

f Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.
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2. Inthe Embedded Web Server, click Properties > Connectivity > Setup.

j’ Note: If this feature does not appear, log in as a system administrator. For details, refer to the System
Administrator Guide at www.xerox.com/support/ALB80XXdocs.

3. For Mobile Workflows, for Google Cloud Print Service, click Edit.
4. For Status, for Registration Status, click Register Printer. The Printer Registration Options page opens.

5. To give the printer a user-friendly name, click Edit.

j’ Note: Xerox recommends that you choose a user-friendly name that includes the printer location and
department.

6. Click Continue to Register. The Options for Registering Your Printer page opens.
7. To change enablement settings, for Enablement, select options as needed.

8. Click Register Printer. The Google Cloud Print Service page reappears with a link that allows you to complete
the device registration.

j’ Note: If printer registration does not continue, to troubleshoot the problem, refer to the System
Administrator Guide at www.xerox.com/support/ALB80XXdocs.

9. Within 15 minutes, click the link for Enabled - Finish device registration. The Google Cloud Print Printer
confirmation page opens in a new browser tab.

¢ Note:

e If prompted, log in to your Google account.
e If you do not click the link within 15 minutes, begin the registration process again.

10. Click Finish printer registration. A message confirms that the printer is registered. The Cloud Printer is now
ready to print.

11.  To access the Google Cloud Print feature, in your Google account, click Manage Your Printer.
j’ Note: The default printer name appears in this format: Model name (MAC address).

For additional information about Google Cloud Print configuration and settings, refer to the System Administrator
Guide at www.xerox.com/support/ALB80XXdocs.

Connecting to a Telephone Line

If an optional fax kit has been installed, connect the telephone line to enable and configure the fax settings.

f Note: One-line or two-line fax kits are available. To enable fax functions, install the fax card provided with the
kit, using the installation instructions provided.

& Warning: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger
telecommunication line cord.

1. Ensure that the printer is powered off.

2. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on the back of
the printer.
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3. Connect the other end of the RJ11 cable to an operating telephone line.
4, Power on the printer.

5. Enable and configure the Fax functions.

INITIAL PRINTER SETUP

Before installing the printer software, verify that the printer is set up correctly. Setup includes enabling the optional
features and assigning an IP address for the Ethernet network connection. Printer settings can be configured at the
printer control panel or by using the Embedded Web Server. To configure settings at the printer control panel, the
Installation wizard starts the first time that you power on the printer. The wizard prompts you with a series of
questions to help configure basic printer settings.

The System Administrator can configure the following settings:
e language

e Network Connection

e Proxy Server Setup

e Date and Time

e Measurements

e | DAP Settings

e Apps Setup

e Security Settings

For more information on configuring the printer settings at the control panel or using the Embedded Web Server,
refer to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

UPDATING THE PRINTER SYSTEM SOFTWARE

Before installing print driver software, verify that the printer has the latest version of system software loaded. You
can update your device when Xerox releases a new version of printer system software or firmware. To ensure a
successful software update, follow the steps provided with the software files. Printer system software is downloaded
from www.xerox.com/support/ALB80XXsupport.

Before you download and install new software, determine the current software version installed on your device.
Print the Configuration Report to compare the system software version with the version available for download. For
instructions about printing a Configuration Report, refer to Printing the Configuration Report.

Follow the instructions provided with the software to download the files and upgrade your device. You can configure
the device to connect routinely to an FTP directory on your network to update device software automatically. You
can also update the device software manually. For more information about updating system operating software,
refer to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

INSTALLING THE PRINT DRIVER SOFTWARE

Before installing print driver software, verify that the printer is plugged in, turned on, connected correctly, and has a
valid IP address. If you cannot find the IP address, refer to Finding the IP Address of Your Printer.
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If the Software and Documentation disc is not available, download the latest drivers from www.xerox.com/support/
ALB80XXdrivers.

Operating System Requirements

Windows Vista SP2

Windows 7, Windows 8, Windows 8.1, Windows 10

Windows Server 2003 SP2 R2, Windows Server 2008 and R2, Windows Server 2012 and R2
Mac 0S 10.8, 10.9, 10.10, 10.11

UNIX and Linux: Your printer supports connection to various UNIX platforms through the network interface.

Installing the Print Drivers for a Windows Network Printer

1.
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Insert the Software and Documentation disc into the appropriate drive on your computer. If the installer does
not start automatically, navigate to the drive, and double-click the Setup.exe installer file.

Select your printer model.

Click Install Drivers.

Select Install Print Driver, Install Scan Driver, or Install Print and Scan Drivers.
At the License Agreement, click I Agree.

From the list of discovered printers, select your printer.

j’ Note: When installing drivers for a network printer, if your printer does not appear in the list, click the IP

Addressor DNS Name computer icon. In the IP Address or DNS Name field, type the IP address of your
printer, then click Search to locate and select your printer. If you do not know the IP address of the printer,
refer to Finding the IP Address of Your Printer.

Click Next.

If needed, you can name your printer by typing a name in the Queue Name field.
If installing a print driver, make a print driver selection.

If installing a scan driver, make a scan driver selection.

Click Install.

If needed, set the printer as the default printer.

f Note: Before selecting Share Printer, contact your system administrator.

13.

To complete the installation, click Finish, then click Close.

Installing the Print Drivers for a Windows USB Printer

1.
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Insert the Software and Documentation disc into the appropriate drive on your computer.
If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer file.
Click Install Software.

At the License Agreement, select I Agree, then click Next.
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To install the printer support software, select Software, then click Next.
In the Software and Documentation window, clear the check box for any undesired options.
Click Next.

To complete the installation, click Finish.

Installing the Print Drivers for Macintosh OS X

1.
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10.

11.
12.
13.

Insert the Software and Documentation disc into the appropriate drive on your computer.

j’ Note: The latest print drivers are available for download from www.xerox.com/support/ALB80XXdrivers.

Open Xerox® Print Drivers 3.xx.x.dmg/.pkg as needed for your printer.

To run Xerox® Print Drivers 3.xx.x.dmg/.pkg, double-click the appropriate file name.
When prompted, click Continue.

To accept the license agreement, click Agree.

To accept the current installation location, click Install, or select another location for the installation files, then
click Install.

If prompted, enter your password, then click Install Software.

From the list of discovered printers, select your printer, then click Next.

If your printer does not appear in the list of discovered printers:

a. Click the IP Address or DNS Name computer icon.

b. Type the IP address of your printer, then click Continue.

c. Select your printer in the list of discovered printers, then click Continue.

If your printer was not detected, verify that the printer is powered on and that the Ethernet or USB cable is
connected properly.

To accept the print queue message, click OK.
Select or clear the Set Printer as Default and Print Test Page check boxes.

Click Continue, then click Close.

Installing Print Drivers and Utilities for UNIX, Linux and AS/400 Printing

UNIX-based printing uses LPD/LPR port 515 or Ip to port 9100 to provide printer spooling and network print server
functionality. Xerox® printers can communicate using either protocol.

Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in UNIX and
Linux environments. Xerox® Printer Manager allows you to:

Configure and check the status of network connected printers.
Set up a printer on your network and monitor the operation of the printer after installation.
Perform maintenance checks and view supplies status at any time.

Provide a common look and feel across the many different suppliers of UNIX and Linux operating systems.
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To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS print driver. You do not need
both drivers. Xerox recommends that you install one of the full-featured custom print drivers for Linux. To locate
drivers for your printer, go to www.xerox.com/support/ALB80XXdrivers.

For details about UNIX, Linux and AS/400 printing and drivers, refer to the System Administrator Guide at www.
xerox.com/support/ALB80XXdocs.

Installing the Printer as a Web Service on Devices

Web Services on Devices (WSD) allow a client to discover and access a remote device and its associated services
across a network. WSD supports device discovery, control, and use.

To install a WSD printer using the Add Device Wizard
1. At your computer, click Start, then select Devices and Printers.
2. To launch the Add Device Wizard, click Add a Device.

3. Inthe list of available devices, select the one you want to use, then click Next.

f Note: If the printer you want to use does not appear in the list, click the Cancel button. Add the WSD
printer manually using the Add Printer Wizard.

4. Click Close.

To install a WSD printer using the Add Printer Wizard

1. At your computer, click Start, then select Devices and Printers.

To launch the Add Printer Wizard, click Add a Printer.

Click Add a network, wireless, or Bluetooth printer.

In the list of available devices, select the one you want to use, then click Next.

If the printer you want to use does not appear in the list, click The printer that I want is not listed.
Select Add a printer using a TCP/IP address or hostname, then click Next.

From the Device type field, select Web Services Device.

Enter the printer IP address in the Hostname or IP address field, then click Next.

Click Close.
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Getting Started

You can obtain more information about your printer from these sources:

RESOURCE LOCATION

Installation Guide

Packaged with the printer.

Quick Use Guide

Print from the control panel. For details, refer to
Information Pages.

Other documentation for your printer

www.xerox.com/support/ALB80XXdocs

Recommended Media List

United States: www.xerox.com/rmlna

European Union: www.xerox.com/rmleu

Technical support information for your printer,
including online technical support, Online Support
Assistant, and print driver downloads.

www.xerox.com/support/ALB80XXsupport

Information Pages

Print from the control panel. For details, refer to
Information Pages.

Embedded Web Server information

In the Embedded Web Server, click Help.

Order supplies for your printer

www.xerox.com/supplies

A resource for tools and information, including
interactive tutorials, printing templates, helpful tips,

and customized features to meet your individual needs.

www.xerox.com/businessresourcecenter

Local sales and Technical Customer Support

www.xerox.com/worldcontacts

Printer registration

www.xerox.com/register

Xerox® Direct online store

www.direct.xerox.com/

LOCATING THE SERIAL NUMBER

When you order supplies or contact Xerox for assistance, you need the serial number of your device. You can obtain
the serial number in several ways. To locate the serial number, print the Configuration Report. You can view the
serial number on the control panel or on the Embedded Web Server home page. The serial number is printed on a
label that is affixed to the printer. To view the label, open the left side door.

For details on how to print the Configuration Report, refer to Information Pages.

To view the serial number on the control panel:

1. At the printer control panel, press the Home button.

2. Touch Device.

3. Touch About.

The model, serial number, and software version is displayed.
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Getting Started

4, To return to the Home screen, press the Home button.
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Customize and Personalize Overview

This chapter provides information on how to customize and personalize your device to meet the specific demands
of your workflows.

. You can customize your apps, hide, or show apps on the Home screen, and rearrange the
.“’. order to suit your job priorities. For each app, you can hide or show individual features and
[T configure default settings to meet the needs of your workgroup. You can save job settings

for repeated use.

Customization enables users to work more productively.

You can create 1-Touch Apps to save and simplify lengthy or frequent workflows. Once
. created, 1-Touch Apps appear on the Home screen. To start a job, touch the app.

Personalization options ensure that the features and functions displayed meet individual
user needs, improving efficiency.
The customize and personalize settings are configured by a system administrator. For details, contact your system

administrator, or refer to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

System administrators can use the Fleet Orchestrator feature to clone and install 1-Touch Apps on other devices.
For information about Cloning and using the Fleet Orchestrator feature, refer to the System Administrator Guide at
www.xerox.com/support/ALB80XXdocs.
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Customizing or Personalizing the Home Screen

Using the customization options, you can show, hide, or change the display order of apps for the Home screen.

DISPLAYING OR HIDING AN APP ON THE HOME SCREEN

To display or hide an app on the Home screen:

j’ Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.xerox.com/support/ALB80XXdocs.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Scroll to the bottom, then touch Customize.
4. Touch Customize Home.
5. Todisplay an installed, but hidden app:
a. Touch the Plus (+) icon.
b. Touch the app that you want to appear on the control panel.
6. To hide an installed app:
a. For the required app, touch X.
b. Touch Hide.
7. Touch Done.

8. Verify that only the required apps appear on the Home screen.

REARRANGING APPS ON THE HOME SCREEN

To rearrange apps on the Home screen:

j’ Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.xerox.com/support/ALB80XXdocs.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

Scroll to the bottom, then touch Customize.
Touch Customize Home.
Touch and hold the required app, then drag the app to the new location. Release the app.

Touch Done.

N o v =W

Verify that the apps appear in the correct location on the Home screen.
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DELETING AN APP FROM THE HOME SCREEN

To delete an app from the Home screen permanently:

j’ Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.xerox.com/support/ALB80XXdocs.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Scroll to the bottom, then touch Customize.
4. Touch Customize Home.
5. To delete an installed app:

a. For the required app, touch X.

b. At the prompt, touch Delete.
j’ Note: Deletion is permanent. You cannot restore a deleted app.

6. Touch Done.

7. Verify that only the required apps appear on the Home screen.

REMOVING CUSTOMIZATION FROM THE HOME SCREEN

To remove customization from the Home screen:

f Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.xerox.com/support/ALB80XXdocs.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Scroll to the bottom, then touch Customize.
4. Select an option:

e Remove Home Customization: This option removes all customization from the Home screen.

(D Caution: The Remove Home Customization option removes customization from the Home screen, and
other customized device settings.

e Remove All Customizations: This option removes all customizations for the device.
j’ Note: This option can cause deletion of 1-Touch, EIP, Single Touch, and Weblet apps.

5. At the prompt, touch Remove.

Apps appear in the default location on the Home screen.

6. Touch Done.
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Customizing or Personalizing the Apps

The app customization options enable you to modify the features available, save app default settings, or remove
customized settings applied to an app.

You can customize the Copy, ID Card Copy, Email, Fax, and Scan To apps for your device.

CUSTOMIZING OR PERSONALIZING THE FEATURE LIST

To customize the Features list for an app:

j’ Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.xerox.com/support/ALB80XXdocs.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

Touch the app required.
Scroll to the bottom, then touch Customize.

Touch Customize Feature List.

o v & W

Touch the required option.

e To hide a feature, for the required feature, touch the Eye icon. To signify that the feature is hidden, the Eye
icon appears with a line across it.

e To show a feature, for the required feature, touch the Eye icon. To signify that a feature is visible, the Eye
icon appears with no line across it.

7. To reorder the menu features, touch and drag the features into the appropriate order.

8. To save the current configuration, touch Done.

SHOWING ALL FEATURES IN THE FEATURES LIST
To show all the hidden features for an app:

1. At the printer control panel, press the Home button.
Touch the app required.

Select the job settings.

& W N

Scroll to the bottom, then touch Show Additional Features.

The hidden features list appears.
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SAVING APP DEFAULT SETTINGS
You can use this feature to save a particular combination of app settings as the default settings.

To save the current app settings as default settings:

j’ Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.xerox.com/support/ALB80XXdocs.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

Touch the app required.
Select the job settings that you want to save as the default settings.

Scroll to the bottom, then touch Customize.

o v & W

Touch Save Settings as Default.

The new settings override the previous default settings.

REMOVING APP CUSTOMIZATION USING THE CONTROL PANEL

To remove the current app customization settings:

j’ Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.xerox.com/support/ALB80XXdocs.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

Touch the app required.
Scroll to the bottom, then touch Customize.

Touch Remove App Customizations.

o v &= W

At the prompt, touch Remove.
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Creating and Using 1-Touch Apps

You can use 1-Touch Apps to create individual apps for completing frequent jobs or tasks. After you create a 1-
Touch App, the app appears on the printer Home screen. To run the job, load the original documents in the
automatic document feeder or on the document glass, then touch the required 1-Touch App.

System administrators can use the Fleet Orchestrator feature to clone and install 1-Touch Apps on other devices.
For information about Cloning and using the Fleet Orchestrator feature, refer to the System Administrator Guide at
www.xerox.com/support/ALB80XXdocs.

CREATING A 1-TOUCH APP

To create a 1-Touch App:

j’ Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.xerox.com/support/ALB80XXdocs.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

Touch the app required.

Select the job settings.

Scroll to the bottom, then touch Create 1-Touch App.

Touch Save as 1-Touch App.

Touch the Enter App Name entry field, then use the keypad to enter a name. Touch Next.
Touch a color scheme option for your 1-Touch App, then touch Next.

Touch an icon that best suits the 1-Touch App that you are creating, then touch Next.

© v ® N o v &~ w

Touch the Enter App Instructions entry field, then use the keypad to enter instructions for users. Touch Next.
When the 1-Touch App is selected, the instructions appear at the top of the screen.

11.  Touch the app settings required.

e Allows Editing Quantity: Use this option to allow users to view and update the quantity.

e Show Feature Settings: Use this option to display a summary of the features programmed for the 1-
Touch App.

12. Touch Done.

The 1-Touch App appears on the Home screen.

DELETING OR HIDING A 1-TOUCH APP

To delete or hide a 1-Touch App from the Home screen:

j’ Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.xerox.com/support/ALB80XXdocs.

1. At the printer control panel, press the Home button.
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2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Touch Customize.
4. Touch Customize Home.
5. For the required 1-Touch App, touch X, then touch an option.
e Delete: Use this option to delete the 1-Touch App from the printer permanently.

e Hide: Use this option to remove the 1-Touch App from the Home screen. The 1-Touch App is still available,
and you can add the app to the Home screen at any time.

6. Touch Done.

USING A 1-TOUCH APP

To use a 1-Touch App:

1. At the printer control panel, press the Home button.

Load the original documents in the automatic document feeder or on the document glass.

Select the 1-Touch App for your job.

&= WN

Do one of the following.

e For Copy Jobs, if you selected Allow Editing Quantity during 1-Touch App setup, update the number of
copies, as required.

e If you selected the Show Feature Settings option during the 1-Touch App setup, update the feature settings,
as required.

5. Touch Start.

6. To return to the Home screen, press the Home button.
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Removing All Customizations

To remove all customizations from the device:

f Note: To use this feature, log in as a system administrator. For details, refer to the System Administrator
Guide at www.xerox.com/support/ALB80XXdocs.

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Scroll to the bottom, then touch Customize.

4. Touch Remove All Customizations.

(D Caution: The Remove Home Customization option removes customization from the Home screen, and
other customized device settings.

5. At the prompt, touch Remove All.
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Xerox ® Apps are a gateway to the features and functions of your device. There are standard Apps already installed
and displayed on the Home screen. Some Apps are installed as standard, but are hidden when you use your device
for the first time. You can show, hide, or reorder Apps on the Home screen using the settings available in the
Embedded Web Server.

For details about displaying, configuring, and customizing the Apps, refer to the System Administrator Guide at
www.xerox.com/support/ALB80XXdocs.

A range of Apps is available for download and installation from the Xerox® App Gallery. These apps include Xerox®
Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed apps on compatible printers.

For more information about using the Xerox® App Gallery and downloading Apps, refer to Xerox® App Gallery.
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Xerox® App Gallery

XEROX® APP GALLERY OVERVIEW

Use the Xerox® App Gallery to find apps that provide new features or capabilities for
your device. The Xerox® App Gallery provides direct access to apps that can improve
your productivity, simplify workflows, and enhance your user experience.

The Xerox® App Gallery enables you to browse and update apps easily. You can browse through the App Gallery
without logging in. The moving banner provides an active display of apps, or you can scroll the full list of apps. To
get more details on an app, touch the app name in the list.

To use the Xerox® App Gallery App, ensure that your device uses either the wireless or the wired network connection.

j’ Note: If a local server inside a firewall hosts your device and a proxy is enabled, set a proxy exception at the
‘ device.

For more information and instructions on using the Xerox® App Gallery, refer to the Xerox® App Gallery User Guide
available at www.xerox.com/support/xerox-app-gallery.

CREATING A XEROX® APP GALLERY ACCOUNT

With an App Gallery account, you have direct access to all the available Apps for your device. An App Gallery
account allows you to view and acquire Apps, install Apps on your device, and manage your Apps and licenses.

You can set up an App Gallery account using the control panel or the Xerox ® App Gallery Web portal. For more
information about the Xerox ® App Gallery Web portal, refer to www.xerox.com/support/xerox-app-gallery.

f Note: If you have an existing Xerox App Gallery Account, refer to Logging in to your Xerox® App Gallery
Account.

To create an App Gallery account using the Control Panel:

1. At the printer control panel, press the Home button.

2. Touch Xerox App Gallery.
3. Touch Login.
4. Touch Request an Account.
5. To enter a valid email address, use the touch screen keypad, then touch OK.
A message is displayed stating completion instructions have been sent to the email address entered.
6. Touch Close.
7. Access your email account for the email address that you provided to Xerox App Gallery.
8. Open the Xerox App Gallery Account Request email, then click the URL link for creating an account.
9. Review and accept the Terms of Use. To continue creating an account, click the Agree button.
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10. Enter the information required into the appropriate fields:
e UserID
e Password
e Confirm Password
e First and Last Name
e Company Name
e Country
11.  Click OK.
12.  After the account is created, a confirmation message appears.

13. At the printer control panel, log in to your App Gallery Account.

LOGGING IN TO YOUR XEROX® APP GALLERY ACCOUNT

When you are logged in to the App Gallery, you can browse available Apps, and install and update Apps.

j’ Note: The first time that any user logs in to the Xerox ® App Gallery from the device, the Xerox® App Gallery
software updates automatically. Once the upgrade completes, a message instructs the user to exit and
reselect the Xerox® App Gallery. All future Xerox® App Gallery upgrades are manual and initiated by the user.

To log in to your App Gallery Account:

1. At the printer control panel, press the Home button.
Touch Xerox App Gallery.

To enter your User Name, use the touch screen keypad.

To enter your Password, use the touch screen keypad.

v B wWN

Touch OK or Enter. The Xerox® App Gallery opens.

INSTALLING OR UPDATING AN APP FROM THE XEROX® APP GALLERY

Xerox® Apps add, extend, or customize the functionality of your device. You can use the Xerox®App Gallery App to
browse and install Apps at your device control panel.

To install an App from the App Gallery:

1. At the printer control panel, press the Home button.
Touch Xerox App Gallery.

To enter your User Name, use the touch screen keypad.
To enter your Password, use the touch screen keypad.

Touch OK or Enter. The Xerox® App Gallery opens.

o v & W N

Touch the App required, then touch Install. The License Agreement screen appears.

j’ Note: If the App was installed previously and a new version is available, the button is labeled as Update.
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7. Touch Agree. The installation process begins.
If the App does not successfully install, to attempt the installation process again, touch Install.

8. To exit the Xerox® App Gallery App, touch Exit, or press the Home button.

Updating an App from the App Gallery

1. At the printer control panel, press the Home button.

Touch Xerox App Gallery.

To enter your User Name, use the touch screen keypad.

To enter your Password, use the touch screen keypad.

Touch OK or Enter. The Xerox® App Gallery opens.

Touch the App required, then touch Update. The License Agreement screen appears.
Touch Agree.

When the update is complete, the Update button is labeled as Installed.

© s N o W N

To exit the Xerox® App Gallery App, touch Exit, or press the Home button.
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Device

DEVICE OVERVIEW

The Device App gives you access to information about your printer, including the serial
number and model. You can view the status of the paper trays, billing and supplies
information, and print information pages.

Many Device options can be configured to meet your individual needs. For details about configuring all of the
Device settings, refer to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

Device Options

The following Device options are available:

DESCRIPTION

About The About option provides an overview of your device, the device serial
number, and information about current settings.

o
©
-
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Information Pages | Your printer has a set of information pages that you can print. These pages
include configuration and font information, demonstration pages, and more.

Notifications Use the Notifications option to see details of any current alerts or errors on
the device. A Fault History button displays fault codes and the date that
they occurred on the device.

Paper Trays Use the Paper Trays option to see the paper size, type, and color set for each
paper tray and the tray-capacity status.

i [ == ]~

Supplies Use the Supplies section to monitor the status of the components you can
replace. The supply level and estimated number of impressions or days left
for each unit is displayed.

Billing/Usage Use the Billing/Usage option to view the serial number and the total number
of impressions made by your device.

Tools Use the Tools option to customize settings such as the power-save modes,
date and time, and control panel brightness. You can configure settings
using the device control panel, or by using the Embedded Web Server.

f Note: For details on configuring the printer settings, see the System
Administrator Guide at www.xerox.com/support/ALB80XXdocs.

Remote Services Use the Remote Services option to send error and usage information to the
Xerox support team.

(1 BRE

f Note: Your System Administrator must enable this feature using the
Embedded Web Server.
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For details on configuring the printer settings, refer to the System Administrator Guide at www.xerox.com/support/
ALB80XXdocs.

ABOUT

The About option provides an overview of your device and its current settings and status. You can view the serial
number, model number, and software version.

INFORMATION PAGES

Your printer has a set of information pages that you can print. These pages include configuration and font
information, demonstration pages, and more.

To print an information page, select an option, then touch Print.

The following Information Pages are available:

NAME DESCRIPTION

Configuration Report The Configuration Report provides printer information
including the serial number, installed options, network
settings, port setup, tray information, and more.

Billing Summary The Billing Summary Report provides information
about the device and a detailed listing of the billing
meters and sheet counts.

Quick Use Guide This guide provides an overview of the key features of
the printer.
PCL Font List The PCL Font List provides a printout of all PCL fonts

that are available on the printer.

PostScript Font List The PostScript Font List provides a printout of all
PostScript fonts that are available on the printer.

SUPPLY STATUS

You can check the status and percentage of life remaining for your printer supplies at the control panel or from the
Embedded Web Server. When printer supplies near their replacement time, warning alerts appear on the control
panel. You can customize the alerts that appear on the control panel and configure email alert notifications.

To check the supplies status at the control panel:

1. To view status information for the printer supplies, touch Device > Supplies.

2. To view details about a specific item, including its part number for reordering, touch the required item.
3. Toreturn to the Supplies screen, touch X.

4. To return to the Device screen, touch X.

To check the supplies status and set up alerts, use the Embedded Web Server. For details about configuring all
Device settings, refer to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.
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BILLING AND USAGE COUNTERS

The Billing/Usage menu displays the total number of impressions that the printer generated or printed during its
lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper. For example, a sheet of
paper that is printed on two sides counts as two impressions.

To view the Billing and Usage Counters:

1. At the printer control panel, press the Home button.

2. Touch Device > Billing/Usage.

3. To view more details, touch Usage Counters, then select an option.

Impression Counters: This option provides the number of impressions made by the printer. The number of
impressions cannot equal the number of sheets counted, depending on the printer setup. If your printer is
set up to count large sheets as large impressions or as multiple smaller impressions, the number of
impressions can differ.

Sheet Counters: This option provides the number of impressions made by the printer. Impressions for 2-
Sided sheets are identified as a separate line from 1-Sided sheets.

Images Sent Counters: This option provides the number of images sent using the Fax, Email, or Scan
features.

Fax Impressions Counters: This option provides the number of images sent using the Fax features. Each
fax feature is identified on a separate line.

All Usage Counters: This option provides all printer usage information.

4. After viewing the usage readings, to return to the Home screen, press the Home button.

REMOTE SERVICES

You can use the Remote Services option in the Embedded Web Server to send error and usage information to the
Xerox support team to help them resolve problems quickly.

For information about enabling Remote Services and uploading information to Xerox, refer to the System
Administrator Guide at www.xerox.com/support/ALB80XXdocs.
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Jobs

JOBS OVERVIEW

E— You can use Jobs to view current jobs, print saved and secure jobs, and view details

— about completed jobs. You can pause, delete, print, or view job progress or job details for

- a selected job.

MANAGING JOBS

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs. You can
interrupt, pause, or delete jobs that are printing. You can also view job progress or job details for a selected job.

A print job can be held by the printer when it is unable to complete the job. For example, if the printer needs
attention, paper, or supplies. When the condition is resolved, the printer automatically resumes printing. When you
send a Secure Print job, the job is held until you release it by entering a passcode at the control panel. For more
details, refer to Managing Special Job Types.

From the Jobs window in the Embedded Web Server, you can view a list of active and saved print jobs. For more
details, refer to Managing Jobs using the Embedded Web Server.

Interrupting Printing

1. At the control panel, touch the Interrupt button. The printer continues to print while it determines the best
place to pause the spooled print job.

2. Printing stops to allow the printer to complete another job.

3. Toresume printing, touch the Interrupt button again.

Pausing or Deleting a Print Job
1. At the printer control panel, press the Home button.
2. To pause a job that is printing, touch the pause button on the control panel.
3. Select a task.
e To resume the print job, touch Resume.
e To delete the print job, touch Delete. At the prompt, touch Delete.

4. To return to the Home screen, press the Home button.

Pausing, Promoting, or Deleting a Job Waiting to Print
1. At the printer control panel, press the Home button.

2. Touch Jobs, then touch the name of the desired print job.
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3. Select atask.

f Note: If you do not make a selection, the job automatically resumes after the set timeout period.
e To pause the print job, touch Hold. To resume the print job, touch Release.
e To delete the print job, touch Delete. At the prompt, touch Delete.
e To move the job to the top of the list, touch Promote.
e To view the status of the job, touch Job Progress.
e To view information about the job, touch Job Details, then touch Job Settingsor Required Resources.

4. To return to the Home screen, press the Home button.

j’ Note:

e The system administrator can restrict users from deleting jobs. If a system administrator has restricted
job deletion, you can view the jobs, but cannot delete them.

e Only the user that sent the job, or the system administrator, can delete a Secure Print job.

Printing a Job Held for Resources
1. At the printer control panel, press the Home button.
Touch Jobs.

From the jobs list, touch the held job name. The resources required for the job appear on the control panel.

&wN

Do one of the following steps.

To print the job, replenish the resources required. The job resumes automatically when the required
resources are available. If the job does not print automatically, touch Resume.

To choose an alternative paper source to enable the job to print, touch Print On Alternate Paper. Select a
paper tray, then touch OK.

e To delete the print job, touch Delete. At the prompt, touch Delete.

j’ Note: The Print On Alternate Paper option is enabled using the Embedded Web Server. For details about the
Print On Alternate Paper option, refer to the System Administrator Guide at www.xerox.com/support/
ALB80XXdocs.

5. Toreturn to the Home screen, press the Home button.

MANAGING SPECIAL JOB TYPES

Special job types allow you to send a print job from your computer, then print it from the printer control panel.
Select special job types in the print driver, Printing Options tab, under Job Type.

Saved Job

Saved Jobs are documents sent to the printer and stored there for future use. All users can print or delete a Saved
Job.

On the control panel, from the Print From menu, you can view and print saved jobs. In the Embedded Web Server,
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on the Jobs window, you can view, print, and delete saved jobs, and you can manage where jobs are stored.

To print a saved job from the control panel, refer to Printing from Saved Jobs.

Printing using Saved Job

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button can vary.
e For Macintosh, in the Print window, in the print options list, click Xerox Features.
3. For Job Type, select Saved Job.
a. Type ajob name or select a name from the list.
b. Type a folder name or select a name from the list.
c. To add a passcode, click Private, type the passcode, then confirm the passcode.
d. Click OK.
4. Select other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Print, Delete, Move, or Copy a Saved Job in the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

In the Embedded Web Server, click Home.
Click Jobs.
Click the Saved Jobs tab.

For the job that you want to process, select the check box.

o v &~ W N

From the menu, select an option.

e Print Job: This option prints a job immediately.

e Delete Job This option deletes the saved job.

e Move Job: Use this option to move the job to another folder location.
e Copy Job: Use this option to duplicate the job.

7. Click Go.

Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the printer until
you enter your passcode at the printer control panel.

After a Secure Print job is printed, it is deleted automatically.
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Printing using Secure Print

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Secure Print.

4. Type the passcode, confirm the passcode, then click OK.

5. Select any other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Secure Print job

1. At the printer control panel, press the Home button.
Touch Jobs.

To view Secure Print jobs, touch Personal & Secure Jobs.
Touch your folder.

Enter the passcode number, then touch OK.
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Select an option:

e To print a Secure Print job, touch the job.

e To print all the jobs in the folder, touch Print All.

e To delete a Secure Print job, touch the Trash icon. At the prompt, touch Delete.

e To delete all the jobs in the folder, touch Delete All.
j’ Note: After a Secure Print job is printed, it is deleted automatically.

7. Toreturn to the Home screen, press the Home button.

Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining copies. After
reviewing the sample set, you can either print the remaining copies or delete them at the printer control panel.

Sample Set is a type of saved job with these features:

e A Sample Set job appears in a folder named after the user ID associated with the print job.

e A Sample Set job does not use a passcode.

e Any user can print or delete a Sample Set job.

e A Sample Set prints one copy of a job to allow you to proofread the job before printing any remaining copies.

After a Sample Set job is printed, it is deleted automatically.
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To print a Sample Set, refer to Printing using Sample Set.

Printing using Sample Set

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Sample Set.

4, Select any other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Sample Set
1. At the printer control panel, press the Home button.
2. To view available jobs, touch Jobs.

3. Touch the Sample Set job.

j’ Note: The Sample Set file description shows the job as Held for Future Printing, and shows the number of
remaining copies of the job.

4, Select an option.
e To print the remaining copies of the job, touch Release.
e To delete the remaining copies of the job, touch Delete.

5. Toreturn to the Home screen, press the Home button.

MANAGING JOBS USING THE EMBEDDED WEB SERVER

In the Embedded Web Server Active Jobs list, you can view a list of active jobs and delete print jobs. You can use
the Embedded Web Server to submit jobs for printing at the device. You can use the Job Submission feature to print
.ps, .pdf, .pcl, and xps files without installing a print driver. You can select jobs for printing from your local computer
hard drive, mass storage devices, or a network drive.

Saved jobs are documents sent to the printer and stored there for future use. Any saved jobs appear on the Saved
Jobs page. Use the Saved Jobs page to view, print, and delete saved jobs, and create and manage folders in which
they are stored.

To manage jobs using the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

2. Inthe Embedded Web Server, click Jobs.
3. Click the job name.
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From the menu, select an option.
e To pause the print job, click Pause, then click Go.
e To delete the print job, click Delete, then click Go. At the prompt, click OK.

To return to the Home screen, click Home.

Submitting Jobs for Printing using the Embedded Web Server

1.

9.
10.

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

In the Embedded Web Server, click Home.

Click Print.

For File Name, click Browse or Choose File, then do one of the following steps.

¢ Navigate to the file, then select it.

e Type the path to the file that you want to select.

In the Printing areq, for Copies, select Auto, or enter the number of copies to print.

For Job Type, select an option:

e Normal Print: This option prints a job immediately.

e Secure Print: This option prints a job after you enter your passcode at the printer control panel.

e Sample Set or Proof Print: These options print one copy of a multiple-copy print job. The device holds the
remaining copies in memory until you release them for printing at the control panel.

e Save Job for Reprint: This option saves a print job in a folder on the print server for future printing. You can
specify a job name and folder.

e Delay Print: This option prints a job at a specified time up to 24 hours from the original job submission.
As needed, for Paper Selection, select paper size, color, type, and tray.

As needed, select job options.

e 2-Sided Printing

e Collate

e Orientation

e Staple

e Folding

e Output Destination

j’ Note: The available options vary by device.

If Accounting is enabled, enter your User ID and Account ID.

Click Submit Job.
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Reprinting Saved Jobs using the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

In the Embedded Web Server, click Home.
Click Jobs.
Click the Saved Jobs tab.

For the job that you want to process, select the check box.

S

From the menu, select an option.

e Print Job: This option prints a job immediately.

e Delete Job This option deletes the saved job.

e Move Job: Use this option to move the job to another folder location.
e Copy Job: Use this option to duplicate the job.

7. Click Go.
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Copy

COPY OVERVIEW

— To make a copy, the device scans your original documents and temporarily stores the
r— images. It then prints the images based on the options that you selected. You can
E m change settings for individual jobs based on the original documents. You can save

settings that you use for regular jobs and retrieve them for later use.

For details on configuring and customizing the Apps, refer to the System Administrator Guide at www.xerox.com/
support/ALB80XXdocs.

If Authentication or Accounting is enabled on your device, to access Copy features, enter your login details.

For information about all the App features and available settings, refer to Apps Features.

MAKING A COPY

To make a copy:
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1.

Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in
the upper-left corner of the document glass.

e For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any staples and
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against
the original documents.

)
& Note: When the original documents are detected, the automatic document feeder confirmation indicator

o v &~ W N
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LED illuminates.
At the printer control panel, press the Home button.
Touch Copy.
To clear previous app settings, touch Reset.
To enter the number of copies needed, use the numeric keypad.
Adjust copy settings as needed.

e To scan more documents using the document glass, or to change settings for different sections of the job,
touch Build Job.

e If you are scanning from 2-sided original documents, touch 2-Sided Copying, then select an option.
For details about available features, refer to Apps Features.

Touch Start. If you placed documents in the feeder, scanning continues until the feeder is empty.
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8. If Build Job is enabled, touch Scan, then, when prompted, do these steps.
e To change settings, touch Program Next Segment.
e To scan another page, touch Scan Next Segment.
e To finish, touch Submit.

9. To return to the Home screen, press the Home button.

COPY WORKFLOWS

f Note: Some features are hidden from view when the Copy App is installed. For details on configuring and
customizing the Apps, refer to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

Erasing the Edges of Copies

You can erase content from the edges of your copies using the Edge Erase feature. You can specify the amount to
erase on the right, left, top, and bottom edges.

To erase the edges of copies:

1. At the printer control panel, press the Home button.
Touch Copy.

Touch Edge Erase.

- W N

Select one of the following options.

e All Edges: This option erases all four edges by the same amount. To adjust the amount to erase, move the
slider.

o Individual Edges: This option allows you to specify different amounts to erase from the edges. Touch the
required Top, Bottom, Left or Right field. To enter the amount to erase, use the numeric keypad, or touch
the arrows.

5. To mirror the same erase amount applied to Side 1 on Side 2, touch the Mirror Side 1 check box.
6. To select a pre-defined amount of erase, use the Presets option.

7. Touch OK.

Specifying the Size of the Original

Use the Original Size feature to set a standard or custom size for scanning, or for the printer to determine the
original size document automatically. You can use this feature to enable mixed-size original document scanning.

To specify the original size:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Original Size.
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4, Select an option.
e Auto Detect: This option allows the printer to determine the size of the original document.

e Preset Scan Area: This option specifies the area to scan when it matches a standard paper size. In the
scrolling list, touch the desired paper size.

e Custom Scan Area: You can specify the width and length of the area to scan. To specify the original width
or length, touch the appropriate field. To enter the size, use the numeric keypad, or use the arrows.

e Mixed Size Originals: You can scan standard-size originals of varying sizes. To determine which original
sizes can be mixed in the same job, use the diagram on the screen.

5. Touch OK.

Shifting the Image

You can change the placement of an image on the copy page. This is useful if the image is smaller than the page
size. For image shift to work correctly, position original documents as follows.

e Document Feeder: Position original documents face up, long edge entering the feeder first.

e Document Glass: Position original documents face down, in the upper-left corner of the document glass, long
edge to the left.

To change the placement of the image:

1. At the printer control panel, press the Home button.
Touch Copy.

Touch Image Shift.
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Select one of the following options.
e Off: This option is the default setting.
e Auto Center: This option centers the image on the page.

5. To enter a specific amount of image shift, touch More, then touch Margin Shift. Touch the required Up /
Down or Left / Right fields. To enter the amount of shift, use the numeric keypad, or touch the arrows.

6. To mirror the same image shift applied to Side 1 on Side 2, touch the Mirror Side 1 check box.
7. To select a pre-defined amount of shift, use the Presets option.

8. Touch OK.

Book Copying

You can use the Book Copying feature to copy books, magazines, or other bound documents. You can use this
feature to copy images for different results.

You can copy either the left or right page onto a single sheet of paper. You can copy both the left and right pages
onto two sheets of paper.

j’ Note: Use the document glass to make copies from books, magazines, or other bound documents. Do not
place bound originals in the document feeder.

To set up book copying:
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1. At the printer control panel, press the Home button.
Touch Copy.
Touch Book Copying.
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Select one of the following options.
e Off: This option is the default setting.
e Both Pages: This option scans both pages of an open book onto two sheets of paper.

e Left/Right Page Only: This option scans the left or right page of an open book onto a single sheet of
paper.

5. If Binding Edge Erase is required, touch More. Touch the Binding Edge Erase field. To enter the amount to
erase, use the numeric keypad, or touch the arrows. You can erase up to 50 mm (2 in.) from both pages, or 25
mm (1 in.) from one page.

6. Touch OK.

Creating a Booklet

The Booklet Creation feature prints two pages on each side of the paper. The printer reorders and reorients the
pages so that they are in the correct order and orientation when folded. If more finishing options are available, the
pages can be stapled and folded to create a booklet.

To create a booklet:

f Note: In this mode, the printer scans all the original documents before it prints the copies.
1. At the printer control panel, press the Home button.
Touch Copy.

Touch Booklet Creation.
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Select one of the following options.
e Off: This option is the default setting.

e On: This option enables Booklet Creation.

j’ Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the required
paper tray, then touch OK.

5. To change the Original Input, Paper Supply or finishing options, touch More, then select an option.
e To scan 1 or 2-sided originals, touch Original Input, then select an option.
e To change the paper source for the booklet, touch Paper Supply, then select an option.
e If your printer has a finisher installed, for Fold & Staple, select a staple or fold option.

6. Touch OK.
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Adding Covers

You can print the first and last pages of your copy job on different paper, such as colored or heavyweight paper.
The printer selects the paper from a different tray. The covers can be blank or printed.

To add covers to your copy job:
1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Special Pages > Covers.

j’ Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the required
paper tray, then touch OK.

4. For Covers Options, select an option.
e Front & Back Same: This option includes front and back covers from the same tray.
e Front & Back Different: This option includes a front and a back cover from different trays.
e Front Only: This option includes a front cover only.
e Back Only: This option includes a back cover only.
5. For Printing Options, select an option.
e Blank Cover: This option inserts a blank cover.

e Print on Side 1 Only: This option prints on the front side of the cover only. To rotate the image on side 2
by 180degrees, touch Rotate Side 2.

Print on Side 2 Only: This option prints on the back of the cover only. To rotate the image on side 2 by
180degrees, touch Rotate Side 2.

Print on Both Sides: This option prints on both sides of the cover.

Rotate Side 2: If covers are 2-Sided, touch this option to rotate the image on side 2 by 180 degrees.
For Paper Supply, touch the required tray.

Touch OK. The options that you selected appear on the Special Pages screen.

To edit or delete a special page entry, touch the entry in the list. From the menu, touch the required option.

Touch OK.
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Adding Inserts

You can insert blank pages or pre-printed sheets in specific locations in your copy job. To do this, you specify the
tray that contains the inserts.

To add inserts to a copy job:
1. At the printer control panel, press the Home button.

2. Touch Copy.
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3. Touch Special Pageslnserts.

j’ Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the required
paper tray, then touch OK.

4. To specify the number of sheets to insert, touch the Insert Quantity field. To enter the number of sheets, use
the numeric keypad, or use the arrows. Touch Enter.

5. To enter a location for the insert, touch the Insert After Page entry box. To enter a page number, use the
numeric keypad. Touch Enter.

6. To specify the paper tray to use for the insert:
a. Touch Paper Supply.
b. Touch the required paper tray.
c.  Touch OK.
7. Touch Add. The insert appears in the list on the Inserts screen. To add more inserts, repeat the previous steps.
8. Touch X. The options that you selected appear on the Special Pages screen.
9. To edit or delete a special-page entry, touch the entry in the list. From the menu, touch the required option.

10. Touch OK.

Specifying Chapter Start Pagination

If you select 2-sided copies, you can set each chapter to start on the front or back of the page. If necessary, the
printer leaves one side of the paper blank so that the chapter starts on the specified side of the paper.

To specify chapter start pagination:

1. At the printer control panel, press the Home button.
Touch Copy.

Touch Special Pages > Chapter Starts.
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To specify the chapter start page, touch Page Number. To enter the page number, use the numeric keypad.
Touch Enter.

5. For Start Chapter, select an option.

¢ On Right Page: This option specifies the front of the paper.

e On Left Page: This option specifies the back of the paper.

Touch Add. The page is added to the list on the right side of the screen.

To set other pages, repeat the previous steps.

Touch X. The options that you selected appear on the Special Pages screen.

To edit or delete a special-page entry, touch the entry in the list. From the menu, touch the required option.

Touch OK.
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Specifying Exception Pages

You can specify exception pages to print on paper that is loaded in a different paper tray than the paper for the
rest of the document. Ensure that the paper you use for the exception pages is the same size as the paper that you
use for the rest of the document.

To specify the exception pages:
1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Special Pages > Exceptions.

j’ Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the required
paper tray, then touch OK.

4. To enter the range of pages to print on different paper:

e To enter the starting page number, touch the first Page Number field. To enter the starting page number,
use the numeric keypad. Touch Enter.

e To enter the ending page number, touch the second Page Number field. To enter the last page number,
use the numeric keypad. Touch Enter.

j’ Note: To specify a single page as an exception, enter that page number as the start and end of the range.

5. To specify the paper to use for the exception pages:

a. Touch Paper Supply.

b. Touch the tray that contains paper to use for the exception pages.

c. Touch OK.

Touch Add. The page range is added to the list on the right side of the screen.

To set other pages, repeat the previous steps.

Touch X. The options that you selected appear on the Special Pages screen.

To edit or delete a special-page entry, touch the entry in the list. From the menu, touch the required option.

Touch OK.
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Adding Annotations

You can automatically add annotations such as page numbers and the date to your copies.

j’ Note:

e You cannot add annotations to covers, inserts, or blank chapter-start pages.
o If Booklet Creation is selected, you cannot add annotations.

To add annotations:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Annotations.
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4. To add page numbers:
a. Touch Page Number.
b. Touch On.

c. Touch the Starting Page Number entry box. To enter a page number, use the numeric keypad, then touch
Enter.

d. Touch Apply To, then select an option.
e. To position the page number, touch an arrow. The sample page shows the location of the page number.
f.  Touch OK.
5. Toinsert a comment:
a. Touch Comment.
b. Touch On.
c. For Stored Comments, touch an option in the list.
e Touch an existing comment.

e To create a comment, touch an Available option. To enter the annotation text, use the touch screen
keypad, then touch OK.

¢ To edit or delete a comment, use the buttons below the Stored Comments list.
d. Touch Apply To, then select an option.
e. To position the comment, touch an arrow. The sample page shows the location of the comment.
f.  Touch OK.
6. Toinsert the current date:
a. Touch the desired current date location.
b. Touch Date.
c.  Touch On, then touch the date format that you wish to use.
d. Touch Apply To, then select an option.

e. To position the date in the header or footer, touch an arrow. The sample page shows the location of the
date.

f.  Touch OK.
7. Toinsert a Bates Stamp:
a. Touch Bates Stamp.
b. Touch On.
c. For Stored Prefixes, touch an option in the list.
e Touch an existing prefix.
e To create a prefix, touch an Available option. To enter text, use the touch keypad, then touch OK.

o To edit or delete a prefix, use the buttons below the Stored Prefixes list.
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d. Touch Starting Page Number. To enter the starting page number, use the alphanumeric keypad. You can
use leading zeros to indicate the number of digits required. Touch Enter.

e. Touch Apply To, then select an option.

f. To position the Bates Stamp in the header or footer, touch an arrow. The sample page shows the location
of the Bates Stamp.

g. Touch OK.
8. To change the text formatting, touch Format & Style, choose the required settings, then touch OK.
9. Toremove all entered annotations, touch Delete All.

10. Touch OK.

Changing the Page Layout

You can use Page Layout to place a defined number of pages on one or both sides of the paper.
To change the page layout:

1. At the printer control panel, press the Home button.

Touch Copy.

Touch Page Layout.
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Select one of the following options.

e Pages per Side: This option places a defined number of pages on one or both sides of the paper. Select
the required number of pages per side.

e Repeat Image: This option places a defined number of the same image on one or both sides of the paper.
Select the number of images required. Auto Repeat allows the printer to determine the maximum number
of images that can fit on the currently selected paper size.

5. To enter a specific number of rows and columns, touch Specify Rows & Columns. Touch the Rows or Columns
field. To enter the number of rows and columns, use the numeric keypad, or touch the arrows. To rotate the
paper, select the check box for Rotate Background.

6. To change the original orientation, touch Original Orientation. Select Portrait or Landscape.

7. Touch OK.

Building a Copy Job

Use this feature to produce complex jobs that include a variety of originals requiring different App settings. Each
segment of the job can have different settings. After all the segments are programmed, scanned, and temporarily
stored in the printer, the job is processed and completed.

To build a job:
1. At the printer control panel, press the Home button.
Touch Copy.

To clear previous App settings, touch Reset.

&ownN

Touch Build Job.
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5. Split the job into the required segments for scanning.
6. Program and scan the first segment:
a. Load the original document for the first segment.
b. Select the options required for the segment.
¢. Touch Scan.
7. Set the required build job display options.
8. Print a Sample segment or delete a segment.
a. To print a sample of the previous segment scanned, touch the segments option, then touch Sample Last
segment.
b. To delete the previous segment scanned, touch the segments option, then touch Delete Last Segment.
c. To delete all the previous segment scanned, touch the segments option, then touch Delete All Segments.
9. Program and scan more segments.
a. Load the originals for the next segment.
b. To change the settings for the next segment, touch Program Next Segment, then select the options
required for the segment.
c. Touch Scan Next Segment.
10. Continue scanning segments until all original documents are scanned.
11. Touch Submit.
Printing a Sample Copy

Sample Copy allows you to print a test copy of a job to inspect before printing multiple copies. This feature is useful
for complex or high-volume jobs. After you print and inspect the test copy, you can choose to print or cancel the
remaining copies.

To print a sample copy of your job:

1.
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At the printer control panel, press the Home button.

Touch Copy.

Adjust the copy settings as needed.

Enter the number of copies needed.

Touch the Sample Copy toggle button.

Touch the Start button. The sample copy prints.

Inspect the sample copy, then select one of the following options.

o If the copy is unsatisfactory, touch Delete. Touch Delete to confirm. The job is canceled and no more
copies are printed.

o If the copy is satisfactory, touch Release. The remaining copies are printed.

To return to the home screen, press the Home button.
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Saving Current Copy Settings

To use a particular combination of copy settings for future copy jobs, you can save the settings with a name and
retrieve them for later use.

To save the current copy settings:

1.
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At the printer control panel, press the Home button.

Touch Copy.

Change the settings required.

Touch Save Current Settings.

To create a new saved setting, touch any option labeled <Available>.

Enter a name for the saved setting using the touch screen keyboard, then touch OK.

Retrieving Saved Copy Settings

You can retrieve and use any previously saved copy settings for current jobs.

j’ Note: To save the copy settings with a name, refer to Saving Current Copy Settings.

To retrieve saved settings:

1.
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At the printer control panel, press the Home button.
Touch Copy.
Touch Retrieve Saved Settings.

Touch the saved setting required.

j’ Note: To delete a saved setting, touch the setting, then touch Delete Settings. Touch Delete to confirm.

5.
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Touch OK. The saved settings are loaded for the current copy job.
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ID Card Copy

ID CARD COPY OVERVIEW

s

onto one side of paper. To copy the card properly, place each side in the upper-left
corner of the document glass. The printer stores both sides of the document, then prints
them side by side on the paper.

B You can use the ID Card Copy App to copy both sides of an ID card or small document

The ID Card Copy App is hidden from view on initial device setup. For details about configuring and customizing the
Apps, refer to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

For information about all the App features and available settings, refer to Apps Features.

COPYING AN ID CARD

To copy an ID card:

1. Lift the document feeder, then place the original document in the upper-left corner of the document glass.
At the printer control panel, press the Home button.

Touch ID Card Copy.

To clear previous App settings, touch Reset.

Adjust the settings as required.

Touch Scan Front.
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When scanning is finished, lift the document feeder. Place the second side of the original document in the
upper-left corner of the document glass.

8. To scan the second side of the original document and print the copies, touch Scan Back.

9. To return to the home screen, press the Home button.
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Email

EMAIL OVERVIEW

You can use the Email App to scan images and attach them to emails. You can specify
the file name and format of the attachment, and include a subject heading and
message for the email.

For details about configuring and customizing the Apps, refer to the System Administrator Guide at www.xerox.com/
support/ALB80XXdocs.

For information about all the App features and available settings, refer to Apps Features.

SENDING A SCANNED IMAGE IN AN EMAIL

To send a scanned image in an email:
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Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original documents face down
in the upper-left corner of the document glass.

e For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove all staples or
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against

the document originals.

)
& Note: When the original documents are detected, the automatic document feeder confirmation indicator

LED illuminates.
2. At the printer control panel, press the Home button.
3. Touch Email

4. To clear previous app settings, touch Reset.
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Enter recipients.

V4

To organize the recipients, touch one of the recipient names on the list. From the menu, select To:, Cc:, or Bcc:.

10.
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If the entry screen appears, to enter a recipient, touch an option, or touch X.

To select a contact or group from the Address Book, touch the Device Address Book option. Touch
Favorites or Contacts, then select a recipient. Touch OK.

To select a contact from the Network Address Book, touch the Network Address Book option. Enter a
name, touch Search, then select a recipient. Touch OK.

To enter the email address manually, touch Manual Entry. In the Enter Email Address field, enter the email
address, then touch Add.

To add your own email address to the recipient list, touch Add Me. If necessary, enter your login details.

To add more recipients, touch Add Recipient, then repeat the procedure.

Note: The choices available for adding recipients depends on system configuration.

Adjust the email settings as needed.

To change the subject, touch Subject, enter a new subject, then touch OK.

To save the scanned document as a specific filename, touch the attachment filename, enter a new name,
then touch OK.

To save the scanned document as a specific file format, touch the attachment file format, then select the
required format. To create a searchable file or to add password protection, from the file format menu, select
More.

To change the email message, touch Message, enter a new message, then touch OK.

To scan more documents using the document glass, or to change settings for different sections of the job,
touch Build Job.

If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.

For details about available features, refer to Apps Features.

To start the scan, touch Send.

If Build Job is enabled, touch Scan, then, when prompted, do these steps.

To change settings, touch Program Next Segment.
To scan another page, touch Scan Next Segment.

To finish, touch Submit.

To return to the Home screen, press the Home button.
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ADDING OR EDITING CONTACTS IN THE DEVICE ADDRESS BOOK FROM THE CONTROL PANEL

You can set up the Device Address Book using the Embedded Web Server. The Address Book can contain up to
5000 contacts that you can access when you enter recipients or destinations using apps.

To add or edit contacts in the Device Address Book from the control panel:

f Note: Before you can use this feature, the system administrator must enable Create/Edit Contact from Touch
Screen for All Users.

1. Load your original documents.

At the printer control panel, press the Home button.

Touch Email.

To clear previous App settings, touch Reset.

Touch Manual Entry. To enter an email address, use the touch screen keypad.

To add the recipient to the Device Address Book, touch the Address Book icon.
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Do one of the following steps.

e To create an entry, touch Create New Contact. To enter contact details, touch a field, then use the touch
screen keypad. Touch OK.

e To add to an existing entry, touch Add to Existing Contact. In the list, touch a contact. To find a contact,
touch Search.

8. To mark a recipient to appear as a favorite option, touch the Star icon.
9. Adjust the email settings as needed.
10. To start the scan, touch Send.

11.  To return to the Home screen, press the Home button.
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Workflow Scanning

WORKFLOW SCANNING OVERVIEW

The Workflow Scanning App allows you to scan an original document, distribute, and
))) archive the scanned image file. The Workflow Scanning feature simplifies the task of

scanning many multi-page documents and saving the scanned image files in one or
more file locations.

fo Note: The system administrator must set up this feature before you can use it. For details, refer to the
System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

The Workflow Scanning App enables you to scan documents using pre-defined settings to a range of file
destinations quickly and easily. There are several workflow options:

e Distribution workflows enable you to scan documents to one or more file destinations. File destinations include
an FTP site, a website, and a network server. You can add fax destinations to workflows too.

e Scan to Mailbox enables you to scan documents to public or private mailbox folders on the printer hard drive.
e Scan to Home enables you to scan documents to a personal Home folder on your network.

e Scan to USB enables you to scan documents to a connected USB Flash drive.

f Note:

e To scan original documents to a file destination associated with a contact in the address book, refer to
Scan To.

e To scan original documents to an email address, refer to Email.

For information about all the App features and available settings, refer to Apps Features.

USING WORKFLOW SCANNING

To scan an original document:
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1. Load your original documents.

e For single pages or paper that cannot be fed in the duplex automatic document feeder, use the document
glass. Lift the duplex automatic document feeder, then place the original documents face down in the
upper-left corner of the document glass.

e For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove all staples or
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against
the document originals.

)
& Note: When the original documents are detected, the automatic document feeder confirmation indicator
LED illuminates.

2. At the printer control panel, press the Home button.
3. Touch Workflow Scanning.

4. To clear previous app settings, touch Reset.

5

To select a workflow, from the Pick a Workflow screen, touch an option. If necessary, to refresh the workflow list,
touch Update.

f Note: If the Pick a Workflow screen does not appear automatically, to display it, touch Change Workflow.

6. If needed, enter recipients, workflow destination details, or browse to the location required for the scanned
original documents.
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7. To add a file destination, touch Add File Destinations. From the list, select a file destination.
f Note: You can add file destinations to a workflow from the predefined list of file repository settings.

e Inthe Embedded Web Server, to create a new workflow, you can add file destinations from the
predefined list.

e In the Workflow Scanning App, for a selected workflow, you can add more file destinations from the
predefined list.

For details, refer to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.
8. Adjust the workflow scanning settings as needed.

e To save the scanned document as a specific filename, touch the attachment filename, enter a new name,
then touch OK.

e To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

e To define what action the device takes when the filename is used already, touch If File Already Exists.
Select an option, then touch OK.

j’ Note: If the Add to pdf folder option is not available, access the Embedded Web Server, then enable the
Filing Option settings. For details, refer to the System Administrator Guide at www.xerox.com/support/
ALB80XXdocs.

If you are using the document glass, to combine pages into a single scan file, enable the Build Job feature.
To enable the feature, touch the toggle button for Build Job.

e If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
For details about available features, refer to Apps Features.
9. To start the scan, touch Scan.
10. If Build Job is enabled, when prompted, do these steps.
e To change settings, touch Program Next Segment.
e To scan another page, touch Scan Next Segment.
e To finish, touch Submit.

11.  To return to the Home screen, press the Home button.

¢ Note:

e For remote scanning, a network connection is required.
o For details about remote scanning, refer to the Help in the Embedded Web Server.

e Print, copy, and fax jobs can print while you are scanning original documents or downloading files from
the printer hard drive.

Distribution Workflows

Distribution Workflows are customized workflows used in the Workflow Scanning App. A workflow contains pre-
programmed settings for a scan job that specify how and where scanned documents are distributed. A workflow
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can include one or more file destinations, as well as fax destinations. You can store customized scan settings in each
workflow.

Using the Embedded Web Server, you can create a workflow using one or more scan destinations. The following
options are available:

e Predefined scan destinations from the list of file repositories.
e New scan destinations such as an FTP site, a website, or an SMB server.
e Fax number destinations.

When you create a workflow, it appears in the list of workflows in the Pick a Workflow screen of the Workflow
Scanning App.

At the printer control panel, when you select a workflow, you can change the scan settings and add more scan
destinations from the predefined list.

Predefined Network File Repositories

A file repository is a predefined file destination that you can use in a workflow. You can use the printer control panel
to add a file repository to a workflow.

The system administrator configures the file repositories available as predefined scanned file destinations. At least
one repository must be set up for the Workflow Scanning feature to be available. For details, refer to the System
Administrator Guide at www.xerox.com/support/ALB80XXdocs.

j’ Note: On the Pick a Workflow screen, the DEFAULT workflow is associated with the default file repository.

Creating a New Workflow

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter
or Return.

f Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer.

2. Click the Scan tab.
3. Inthe Display areq, select Workflows, then select Create New Workflow.
4. For Add Destination to Workflow, select an option:

e To add an existing file destination to the workflow, select Select from a Predefined List.
e To add a file destination to the workflow, select Enter a Scan Destination.
* To add a fax destination to the workflow, select Enter a Server Fax Number.
5. For Select from a Predefined List, select a destination from the File Destination list, then click Add.
6. For Enter a Scan Destination, add these details:
a. Click the Friendly Name field, then enter a name for the scan destination.
b. For Protocol, select an option, then enter the destination address.
e For IP Address, enter the IP Address: Port number.
e For Host Name, enter the Host Name: Port number.

c. Enter the name of the destination folder as needed. In SMB, the destination folder is the shared folder.
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d. In Document Path, enter the name of the subfolder within the destination folder. Select a Filing Policy.

e. Enteravalid login name and password.

j’ Note: Use the login name for the computer that holds the destination folder. The login name can include
the domain name, such as domain name\login name.

f.  Click Add.
7. For Enter a Server Fax Number, add a Fax Number, set the Delivery options, then click Add.
8. To add another destination to the workflow
e To add a file destination, for File Destinations, click Add.
e To add a fax destination, for Fax Destinations, click Add.
9. Set the scan settings for the workflow as required.
After a workflow is created in the Embedded Web Server, the workflow is added to the list in the Workflow Scanning
App.
Scanning to a Shared Network Folder

You can scan to a shared folder on a network using SMB. The folder can be on a server or computer running SMB
services.

To scan to a shared network folder, create a shared folder with read and write access privileges.

Sharing a Folder on a Windows Computer

1. Open Windows Explorer.

Right-click the folder you want to share, then select Properties.

Click the Sharing tab, then click Advanced Sharing.

Select Share this folder.

Click Permissions.

Select the Everyone group, then verify that all permissions are enabled.

Click OK.
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f Note: Remember the Share name for later use.

8. Click OK again.
9. Click Close.

Sharing a Folder in Macintosh OS X Version 10.7 and Later
1. From the Apple menu, select System Preferences.
2. From the System Preferences window, select Sharing, then select File Sharing.

3. Under Shared Folders, click the Plus icon ( +). Browse to the folder that you want to share on the network, then
click Add.

4. To modify access rights for your folder, select the folder. The groups activate.

5. From the Users list, click Everyone, then use the arrows to select Read & Write.
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Click Options, then select a share-folder option.

To share the folder, select Share files and folders using SMB.

To share the folder with specific users, next to the user name, select On.

Click Done.

Close the System Preferences window.

j’ Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the folder and

subfolders.

Scanning to a Mailbox Folder

Scanning to a folder is the simplest scanning method. This function allows users to scan files to mailboxes, which
are folders created on the printer hard drive. When you scan an image at the printer, the scan file is stored in a
folder on the internal hard drive. You can use the Embedded Web Server to retrieve the stored scan file to save to
your computer.

The default settings create a 1-sided, color, portable document format .pdf file. You can change the default settings
using the printer control panel, or using the Embedded Web Server at your computer. Control panel selections
override the settings in the Embedded Web Server.

Scanning to the Public Mailbox Folder

The printer provides a public mailbox folder to store scanned images. You do not need a password to scan images
to the public mailbox folder, or to retrieve the scanned images. All users can view scanned documents in the public
mailbox folder. You can create a password-protected private mailbox folder. For details, refer to Creating a Private
Mailbox Folder.

To scan an image to the public mailbox folder:

1.
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Load your original documents.

At the printer control panel, press the Home button.

Touch Workflow Scanning.

To select a workflow, from the Pick a Workflow screen, touch Default Public Mailbox.

f Note: If the Pick a Workflow screen is not automatically displayed, to display it, touch Change Workflow.

To add a file destination, touch Add File Destinations, then select a file destination from the list.

Adjust the workflow scanning settings as needed.

To save the scanned document as a specific file name, touch the attachment file name, enter a new name,
then touch OK.

To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

If you are using the document glass, to combine pages into a single scan file, enable Build Job.

If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.

For details about available features, refer to Apps Features.
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To start the scan, touch Scan. The Job Progress screen appears, and the original document is scanned. The
printer stores the scanned image on the printer hard drive.

If Build Job is enabled, when prompted, do these steps.
e To change settings, touch Program Next Segment.
e To scan another page, touch Scan Next Segment.
e To finish, touch Submit.

To move the file to your computer, use the Embedded Web Server. For details, refer to Retrieving Scan Files
from a Mailbox Folder.

Scanning to a Private Mailbox Folder

This feature allows you to scan documents to a private mailbox folder. Private mailbox folders can require a
password.

You can use the Embedded Web Server to create your private mailbox folders. For details, refer to Creating a Private
Mailbox Folder.

To scan to a private mailbox folder:

1.
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Load your original documents.
At the printer control panel, press the Home button.
Touch Workflow Scanning.

To select a workflow, from the Pick a Workflow screen, select a private mailbox folder.

f Note: If the Pick a Workflow screen is not automatically displayed, to display it, touch Change Workflow.

On the Mailbox Password screen, enter the password, then touch OK.
To add a file destination, touch Add File Destinations, then select a file destination from the list.
Adjust the workflow scanning settings as needed.

e To save the scanned document as a specific file name, touch the attachment file name, enter a new name,
then touch OK.

e To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

e If you are using the document glass, to combine pages into a single scan file, enable Build Job.

e If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
For details about available features, refer to Apps Features.

To start the scan, touch Scan.

If Build Job is enabled, when prompted, do these steps:

e To change settings, touch Program Next Segment.

e To scan another page, touch Scan Next Segment.

e To finish, touch Submit.

To move the file to your computer, use the Embedded Web Server. For details, refer to Retrieving Scan Files
from a Mailbox Folder.
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Creating a Private Mailbox Folder

If the scan policy to allow additional folders is enabled, you can create a private mailbox folder. The system
administrator can create a private mailbox folder at any time. For details, refer to the System Administrator Guide at
www.xerox.com/support/ALB80XXdocs.

To create a private mailbox folder with a password:

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter
or Return.

f Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer.
2. Click the Scan tab.

3. Inthe Display section, select Mailboxes.

j’ Note: If the Display section does not appear, Scan to Mailbox is not enabled. For details, refer to the System
Administrator Guide at www.xerox.com/support/ALB80XXdocs.

In the Scan to Mailbox section, click Create Folder.
Click the Folder Name: field, then type a name for the folder.
In the Folder Password field, type a password that adheres to the password rules.

In the Confirm Folder Password field, type the password again.
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Click Apply.

Your private mailbox folder appears in the mailbox folder list in the Embedded Web Server and on the printer touch
screen under Pick a Workflow. The contents are stored on the printer hard drive.

Retrieving Scan Files from a Mailbox Folder

You can use the Embedded Web Server to retrieve scan files from a mailbox folder and copy the files to your
computer.

To retrieve your scan files:

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter
or Return.

f Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer.
2. Click the Scan tab.
3. Inthe Display section, select Mailboxes.

4. In the Scan to Mailbox section, click the folder containing the scan.

f Note:
o Fora password protected private folder, click the Folder Password field, type the password, then click
OK.

e If your image file does not appear, click Update View.

Your scan file appears in the Folder Contents window.
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5. Under Action, select an option, then click Go.

e Download saves a copy of the file to your computer. When prompted, click Save, then navigate to the
location on your computer to save the file. Open the file or close the dialog box.

e Reprint prints the file without saving a copy of the file to your computer.

e Delete removes the file from the mailbox. When prompted, click OK to delete the file or Cancel to cancel
the operation.

f Note: You can also print a mailbox file using the Print From App. For details, refer to Print From.

Scanning to a User Home Folder

Scan to Home allows you to scan documents to a home directory on an external server. The home directory is
distinct for each authenticated user. The directory path is established through LDAP.

The Scan to Home feature is available as the Home workflow in the Workflow Scanning App.
To enable the Home workflow:
e Ensure that LDAP Network Authentication is configured.

e Ensure that Home folder locations are defined for each user in the LDAP directory.

j’ Note: When a user logs in to the printer using network credentials, the Home workflow appears on the Pick a
Workflow screen.

To use the Home workflow:

1. Load your original documents.

To log in to the printer, touch Log In, then log in with your network credentials.
At the printer control panel, press the Home button.

Touch Workflow Scanning.
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From the Pick a Workflow screen, touch the Home workflow.
f Note:

o If the Pick a Workflow screen is not automatically displayed, to display it, touch Change Workflow.
o If the Home workflow is not displayed, check that you have logged in with the required credentials.
6. To add a file destination, touch Add File Destinations, then select a file destination from the list.
7. Adjust the workflow scanning settings as needed.

e To save the scanned document as a specific file name, touch the attachment file name, enter a new name,
then touch OK.

e To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

e If you are using the document glass, to combine pages into a single scan file, enable Build Job.
e If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.

For details about available features, refer to Apps Features.
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8. To start the scan, touch Scan.

9. If Build Job is enabled, when prompted, do these steps.

To change settings, touch Program Next Segment.
To scan another page, touch Scan Next Segment.

To finish, touch Submit.

10. To return to the Home screen, press the Home button.

Scanning to a USB Flash Drive

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function produces scans
in .jpg, .pdf, .pdf (a), .xps, and tif file formats.

The Scan to USB feature is available as the USB workflow in the Workflow Scanning App.

j’ Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To scan to a USB Flash drive:

1. Load your original documents.
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At the printer control panel, press the Home button.
Insert the USB Flash drive into the USB memory port.
At the USB Drive Detected screen, touch Scan to USB.

f Note: If the USB Flash drive is inserted in the printer already, touch Workflow Scanning. Touch Change

Workflow, then touch USB.

5. To add a file destination, touch Add File Destinations, then select a file destination from the list.

6. Adjust the workflow scanning settings as needed.

To save the scanned document as a specific file name, touch the attachment file name, enter a new name,
then touch OK.

To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

If you are using the document glass, to combine pages into a single scan file, enable Build Job.

If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.

For details about available features, refer to Apps Features.

7. To start the scan, touch Scan.
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8. If Build Job is enabled, when prompted, do these steps.
e To change settings, touch Program Next Segment.
e To scan another page, touch Scan Next Segment.

e To finish, touch Submit.

& Warning: Do not remove the USB Flash drive while the printer is processing the scan job. If you remove
the Flash drive before the transfer is complete, the file can become unusable and other files on the drive
can be damaged.

9. To return to the Home screen, press the Home button.

Single-Touch Apps

A Single-Touch App enables you to use a workflow without having to use the Workflow Scanning App. Single-Touch
Apps are displayed on the Home screen, and used with a single touch.

You can use the Embedded Web Server to design the app, associate it with a workflow, and assign user rights. For
details about creating Single-Touch Apps for workflow scanning destinations, refer to the System Administrator
Guide at www.xerox.com/support/ALB80XXdocs.
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Scan To

SCAN TO OVERVIEW

You can use the Scan To App to scan documents to multiple destinations and recipients
in a single scan. A Scan To destination can be a USB Flash drive, a shared network folder,
or an SMB network location. A Scan To recipient can be a contact in the device address
book or network address book, an email address, or the logged-in user.

The Scan To App supports the following scanning functions:
e Scan original documents to an email address. For details, refer to Scanning to an Email Address.

e Scan original documents to a USB Flash drive. For details, refer to Scanning to a USB Flash Drive.

e Scan original documents to a folder in a shared network location using SMB transfer protocol. For details, refer
to Scanning to a Shared Folder on a Networked Computer.

e Scan original documents to the email address associated with the logged-in user. For details, refer to Scanning
to the Logged-In User.

To scan documents to one or more file destinations using customized workflows, refer to Workflow Scanning.

For details about configuring and customizing apps, refer to the System Administrator Guide at www.xerox.com/
support/ALB80XXdocs.

For information about all app features and available settings, refer to Apps Features.

SCANNING TO AN EMAIL ADDRESS

You can scan a document and send the scanned file to an email address. The Scan To App produces scans in .jpg, -
pdf, .pdf (a), .xps, and .tif file formats.

Before you scan to an email address, ensure that you configure the printer with the email server information. For
details, refer to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

To scan an image and send it to an email address:

1. Load the original document on the document glass or into the automatic document feeder.

j’ Note: When the original documents are detected, the automatic document feeder confirmation indicator
LED illuminates.

2. At the control panel, touch Home.
3. Touch Scan To.

4, If the Scan To destination window does not appear, touch Add Destination.
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10.
11.

12.

Add recipients.
e To enter the email address manually, touch Email. Enter an email address, then touch Add.

e To select a contact or group from the Device Address Book, touch Device Address Book. Touch Favorites
or Contacts, then select a recipient.

e Toselect a contact or group from the Network Address Book, touch Network Address Book. In the search
bar, type the name of the contact or group that you want to add, then touch Search. From the list of
results, select a recipient.

f Note: For details about using the Address Book and managing and creating Favorites, refer to the System

Administrator Guide at www.xerox.com/support/ALB80XXdocs.
To add another Scan To destination, touch Add Destination, then select the required destination.

To save the scanned document as a specific filename, touch the attachment filename, then enter a new name
using the touch screen keypad. Touch Enter.

To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

f Note: To make scanned documents searchable, your system administrator can enable the Searchable

feature.
Adjust scanning options as needed.

e To change the email subject line, touch Subject. Enter a new subject line using the touch screen keypad,
then touch Enter.

e To change the email body message, touch Message. Enter a new message, then touch OK.

To scan multiple pages using the document glass, or to change settings for different sections of the job,
touch Build Job.

To begin the scan, touch Scan.

If Build Job is enabled, when prompted, do these steps.

e To change settings for the next segment of the document, touch Program Segment.

e To scan another page, load the new document onto the document glass, then touch Scan Segment.
e To finish, touch Submit.

To return to the Home screen, press the Home button.

SCANNING TO A USB FLASH DRIVE

You can scan a document and store the scanned file on a USB Flash drive. The Scan To App produces scans in .jpg, -
pdf, .pdf (a), .xps, and .tif file formats.

j’ Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To scan to a USB Flash drive:

1.
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Load the original document on the document glass or in the automatic document feeder.
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At the printer control panel, press the Home button.
Touch Scan To.

If the Scan To destination window does not appear, touch Add Destination.

v W N

Insert your USB Flash drive into the USB port on the front of the printer, then touch USB.

j’ Note: If you select USB as the Scan To destination before inserting a USB Flash drive, you will be prompted
to insert it.

6. To add another Scan To destination, touch Add Destination, then select the required destination.

7. To save the scanned document as a specific file name, touch the attachment file name, then enter a new name
using the touch screen keypad. Touch Enter.

8. To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

9. Adjust scanning features as needed.

10. To scan multiple pages using the document glass, or to change settings for different sections of the job, touch
Build Job.

11.  To begin the scan, press Scan.
12. If Build Job is enabled, when prompted, do these steps.
e To change settings for the next segment of the document, touch Program Segment.
e To scan another page, load the new page onto the document glass, then touch Scan Segment.
e To finish, touch Submit.
The printer scans your images to the root folder of the USB Flash drive.

13. If you are scanning from the document glass, when prompted, to finish, touch Done or to scan another page,
touch Add Page.

j’ Note: If you are scanning a document from the automatic document feeder, a prompt does not appear.

(D Caution: Do not remove the USB Flash drive while the device is scanning and processing the job. If you
remove the Flash drive before the transfer is complete, the file can become unusable and other files on
the drive can be damaged.

14.  To return to the Home screen, press the Home button.

SCANNING TO A SHARED FOLDER ON A NETWORKED COMPUTER

You can scan a document and save the scanned file to a folder on a networked computer. The Scan To App
produces scans in .jpg, .pdf, .pdf (a), .xps, and .tif file formats.

j’ Note: To scan to a user home folder, use the Workflow Scanning App. For details, refer to Scanning to a User
Home Folder.

Before You Begin

Before scanning to a folder on a networked computer, perform these steps:
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e Create a shared folder on your computer:
—  For Windows, refer to Sharing a Folder on a Windows Computer.
—  For Macintosh, refer to Sharing a Folder in Macintosh OS X Version 10.7 and Later.

o Configure an SMB Folder. For details, refer to the System Administrator Guide, at www.xerox.com/support/
ALB80XXdocs.

e Use the Embedded Web Server to associate a Scan To destination with a Device Address Book contact. For
details, refer to Adding a Scan To Destination to an Address Book Entry.

f Note: Ensure that the Address Book contains at least one contact with a scan-to destination.

Scanning to a Shared Folder on a Networked Computer
1. Load the original document on the document glass or into the automatic document feeder.
At the printer control panel, press the Home button.

Touch Scan To.
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To specify the destination of the scanned document, select one of the following options.

e To scan to an SMB folder on a networked computer, touch Network. Browse to the required folder, or enter
the network path name, then touch OK.

j’ Note: For information on configuring SMB folders, refer to the System Administrator Guide at www .xerox.
com/support/ALB80XXdocs.

To scan to a folder associated with a contact in the address book, touch Device Address Book. Select the
required contact, then touch the Scan To location.

f Note: For details on how to associate a networked folder with an address book contact, refer to Adding a
Scan To Destination to an Address Book Entry.

5. To add another Scan To destination, touch Add Destination, then select the required destination.

6. To save the scanned document as a specific filename, touch the attachment filename. Enter a new name using
the touch screen keypad, then touch Enter.

7. To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

8. Adjust scanning options as needed.

9. To scan multiple pages using the document glass, or to change settings for different sections of the job, touch
Build Job.

10. To begin the scan, press Scan.

11. If Build Jobis enabled, when prompted, do these steps.
e To change settings for the next segment of the document, touch Program Segment.
e To scan another page, load the new document onto the document glass, then touch Scan Segment.
e To finish, touch Submit.

12. To return to the Home screen, press the Home button.
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SCANNING TO THE LOGGED-IN USER

You can use the Add Me function to scan a document and send the scanned file to the email address associated
with a logged-in user.

j’ Note: Only users authenticated through an LDAP server can have an associated email address.

Before scanning to a logged in user, ensure that LDAP user authentication is configured. For details, refer to the
System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

The Scan To App produces scans in .jpg, -pdf, .pdf (a), .xps, and tif file formats.

To scan an image and send it to the email address of the logged-in user:

1. Load the original document on the document glass or into the automatic document feeder.
At the control panel, touch Home.

Touch Scan To.

If the Scan To destination window does not appear, touch Add Destination.

Touch Add Me.
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If you are not logged in, a login screen appears. Enter your LDAP network user name and password, then touch
Done.

7. To add another Scan To destination, touch Add Destination, then select the required destination.

8. To save the scanned document as a specific file name, touch the attachment file name, then enter a new name
using the touch screen keypad. Touch Enter.

9. To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

j’ Note: To make scanned documents searchable, your system administrator can enable the Searchable
‘ feature.

10. Adjust scanning options as needed.

11. To scan multiple pages using the document glass, or to change settings for different sections of the job, touch
Build Job.

12. To begin the scan, touch Scan.

13. If Build Jobis enabled, when prompted, do these steps.
e To change settings for the next segment of the document, touch Program Segment.
e To scan another page, load the new document onto the document glass, then touch Scan Segment.
e To finish, touch Submit.

14.  To return to the Home screen, press the Home button.
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ADDING A SCAN TO DESTINATION TO AN ADDRESS BOOK ENTRY

You can create Address Book contacts using the Embedded Web Server. A contact is a user with an associated email
address, fax number, or scan to destination. If a contact has been set up to include a scan to destination, the
contact is available for selection in the Scan To App. Contacts can be marked as a Favorite.

To create an address book contact and add a scan to destination:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

f Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.
2. Click Address Book.
3. To add or edit a contact in the address book:
e To add a contact, click Add, then enter the contact information.

e To edit a contact, select the contact, then click Edit.

f Note: If the Add button is unavailable, the address book has reached its limit. The Device Address Book can
contain up to 5000 contacts.

4. To associate a scan destination with this contact, for Scan To Destination, click the Add Destination ( +)
button. Enter the nickname that you want to appear in the Address Book.

5. Under Protocol, select an option, then enter the destination address:
e For FTP, SFTP, or SMB:
e For IP Address, enter the IP Address: Port number.
e For Host Name, enter the Host Name: Port number.
e For Netware, enter the Server Name, Server Volume, NDS Tree, and NDS Context.

6. For SMB, in the Share field, enter the name of the destination folder. For example, to save scanned files to a
shared folder named scans, type scans.

7. In Document Path, enter the name of the subfolder within the destination folder. For example, to save the
scanned files to a folder named colorscans inside the scans folder, type colorscans.

8. Enter avalid login name and password.

j’ Note: Use the login name for the computer that holds the destination folder. For SMB, the login name is
your computer user name.

9. To confirm the validity of the destination details, click Destination Test.

10. Click Save, or select Add Another Contact After Saving, then click Save.

j’ Note: To mark a contact as a Favorite for email, fax, or scan to destination, for the appropriate field, click the
Staricon. If you click the Star icon for Display Name, the contact becomes a Global Favorite.
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Fax

FAX OVERVIEW

When you send a fax from the printer control panel, the document is scanned and
transmitted to a fax machine, using a dedicated telephone line. You can use the Fax App
to fax documents to a fax number, an individual contact, or to a group of contacts.

You can use the Fax App to do the following tasks:

e Delay the send of your fax job for up to 24 hours.
e Send a fax from your computer.

e Forward fax documents to an email address.

e Print a fax from a secure folder.

The fax function works best with an analog phone line. Voice-Over-Internet Protocols (VOIPs) such as FIOS and DSL
are not supported. Before you use the Fax App, configure the Fax Settings to ensure that they are compatible with
your local connection and regulations. The Fax Settings include optional features you can use to configure the
printer for faxing.

j’ Note: Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

For details about configuring the fax function and customizing the Apps, refer to the System Administrator Guide at
www.xerox.com/support/ALB80XXdocs.

For information about all the App features and available settings, refer to Apps Features.

SENDING A FAX

To send a fax:
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1. Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in

the upper-left corner of the document glass.

e For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove all staples and
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against

the documents.

)
& Note: When the original documents are detected, the automatic document feeder confirmation indicator

LED illuminates.
2. At the printer control panel, press the Home button.
3. Touch Fax.

4, To clear previous app settings, touch Reset.

116 Xerox® AltaLink® B80XX Series Multifunction Printer User Guide



Xerox® Apps

5. Enter recipients.
e If the entry screen appears, to enter a recipient, touch an option, or touch X.

e To select a contact or group from the Device Address Book, touch the Device Address Book option. Touch
Favorites or Contacts, then select a recipient.

e To enter the fax number manually, touch Manual Entry. In the Enter Fax Number field, enter the fax
number, then touch Add.

e To add more recipients, touch Add Recipient, then repeat the procedure.

f Note: To insert a pause as needed, touch Dial Pause. To enter longer pauses, touch Dial Pausemultiple
times.

6. Adjust the fax settings as needed.

e To scan more documents using the document glass, or to change settings for different sections of the job,
touch Build Job.

e If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
For details about available features, refer to Apps Features.
7. Touch Send.
8. If Build Job is enabled, touch Scan, then, when prompted, do these steps.
e To change settings, touch Program Next Segment.
e To scan another page, touch Scan Next Segment.
e To finish, touch Submit.

9. To return to the Home screen, press the Home button.
FAX WORKFLOWS

Sending a Delayed Fax

You can set a time in the future for the printer to send your fax job. You can delay the send of your fax job for up to
24 hours.

f Note: Before you use this feature, ensure that the printer is set to the current time. For details, refer to the
System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

To specify the time to send your fax:
1. Load your original documents.
At the printer control panel, press the Home button, then touch Fax.

Add fax recipients, then adjust fax settings as needed. For details, refer to Sending a Fax.
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Touch Delay Send.
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5. Touch Delay send, then set the time to send the fax.
e To set the hour, touch the Hour field, then use the numeric keypad, or touch the arrows.
e To set the minutes, touch the Minute field, then use the numeric keypad, or touch the arrows.
e If your printer is set to display the 12-hour clock, touch AM or PM.

6. Touch OK.

7. Touch Send. The fax is scanned and saved, then sent at the specified time.

Adding a Cover Sheet

You can use the Cover Sheet option to add an introduction page to the beginning of your fax. You can add a short
comment to the cover sheet, as well as To and From details.

To include a cover sheet:

1. Load your original documents.

2. At the printer control panel, press the Home button, then touch Fax.
3. Add fax recipients, then adjust fax settings as needed. For details, refer to Sending a Fax.
4. Touch Cover Sheet > On.
5. To enter the name of the recipient, touch the To field, then use the touch screen keyboard. Touch OK.
6. To enter the name of the sender, touch the From field, then use the touch screen keyboard. Touch OK.
7. To add a comment, do one of the following steps.
e Touch an existing comment.
e Touch an <Available> comment, then touch the Edit icon. To type text, use the touch screen keypad. Touch
OK.
f Note:
e To delete an existing comment, touch the comment, then touch X. To confirm the action, touch Delete.
e To edit an existing comment, touch the comment, then touch the Edit icon. To change the comment,
use the touch screen keypad. Touch OK.
8. Touch OK.

Printing a Secure Fax

When the Fax Secure Receive option is enabled, all faxes that the device receives are held in the Job list until you
enter a passcode. After you enter the passcode, the faxes are released and printed.

j’ Note: Before you can receive a Secure Fax, ensure that the Secure Fax Receive feature is enabled. For details,
refer to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

To print a secure fax:

1. At the printer control panel, press the Home button.

2. Touch Jobs.

118 Xerox® AltaLink® B80XX Series Multifunction Printer User Guide


http://www.support.xerox.com/support/altalink-b8000-series/documentation

Xerox® Apps

To view Secure Print jobs, touch Secure Jobs.
Touch your folder.

Enter the passcode number, then touch OK.
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Select an option.

e To print a Secure Print job, touch the job.

e To print all the jobs in the folder, touch Print All.

e To delete a Secure Print job, touch the Trash icon. At the prompt, touch Delete.
e To delete all the jobs in the folder, touch Delete All.

7. To return to the Home screen, press the Home button.

Polling a Remote Fax Machine

Fax Polling allows you to store a fax document on the printer and make it available for other fax machines to poll.
You can also retrieve faxes stored on other fax machines. To use this feature, both the polling printer and the
remote printer must have the Fax Polling feature.

Storing a Fax for Polling

You can store faxes for polling as Non-Secure or Secure. When you select Secure Storage, you create a list of remote
device fax numbers that are allowed to access secure faxes.

Storing a Fax for Non-Secure Polling

1. Load your original documents.

At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.
Touch Store Polling Files.

Touch Non-Secure Storage, then touch OK. To confirm, touch Update Setting.
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Touch Send. The original documents are scanned and stored for non-secure polling.

Storing a Fax for Secure Polling

1. Load your original documents.

At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.

Touch Store Polling Files.

Touch Secure Storage.

Touch Enter a Fax Number. To enter the fax number for the remote device, use the keypad. Touch OK.
Touch the + button. The fax number is added to the access list.

Continue to enter fax numbers for all remote devices that require access to the secure documents.
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Touch OK. To confirm, touch Update Setting.
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10. Touch Send. The original documents are scanned and stored for secure polling.

Deleting Documents Stored for Polling

1.
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At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.
Touch Store Polling Files.

Touch Empty Fax Polling. To confirm, touch Empty Fax Polling again.

Touch OK.

Printing Faxes Stored for Polling

To print faxes stored for polling:

1.
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6.
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At the printer control panel, press the Home button, then touch Fax.
If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.
Touch Print From Polling Device.
To print faxes that are stored for polling on the local device:
a. Touch Local Fax Polling.
b.  Touch Print.
c. To delete stored faxes after they print, touch Empty Fax Polling. To confirm, touch Empty Fax Mailbox.
The local faxes that are stored for polling print.
To print faxes that are stored for polling on a remote device:
a. Touch Remote Fax Polling.
b. Touch Enter Fax Number. To enter the fax number of the remote device, use the keypad. Touch OK.
c. To add a number to the list, touch the + button. Enter more fax numbers as needed.
d. To edit the list of fax numbers, touch a number in the list, then touch Remove or Edit.
e. To set a specific time to poll the remote device, touch Delay Polling.
e Touch Delay Polling.
e To set the hour, touch the Hour field, then use the numeric keypad, or touch the arrows.
e To set the minutes, touch the Minute field, then use the numeric keypad, or touch the arrows.
e If your printer is set to display the 12-hour clock, touch AM or PM.
e Touch OK.
f. Touch Print.
The faxes that are stored on the remote device for polling print.

Touch X to exit.
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Storing a Fax in a Local Mailbox

The system administrator must create a mailbox before you can use this feature. For details, refer to the System
Administrator Guide at www.xerox.com/support/ALB80XXdocs.

To store a fax in a local mailbox:

1. Load your original documents.

At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Mailboxes, or touch Add Recipient, then touch Mailboxes.
Touch Store To Mailbox.

Touch Local Mailbox.

Touch a mailbox from the list.
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If a passcode is required, touch the Mailbox Passcodefield. To enter the four-digit mailbox passcode, use the
keypad. Touch OK.

8. Touch OK. The mailbox appears as the recipient of the fax.
9. To select a different mailbox, touch the recipient field, then touch Remove or Edit.

10. Touch Send. The original documents are scanned and stored in the mailbox.

Printing Local Mailbox Documents

To use this feature, you must have documents stored in a mailbox. For details, see Storing a Fax in a Local Mailbox.
To print local mailbox documents:

1. At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Mailboxes, or touch Add Recipient, then touch Mailboxes.

Touch Print From Mailbox.

Touch Local Mailbox.

Touch a mailbox from the list.

A

If a passcode is required, touch the Mailbox Passcode field. To enter the four-digit mailbox passcode, use the
keypad. Touch OK.

7. Touch Print. The documents in the mailbox print.

8. To delete the contents of the mailbox after the device finishes printing, touch Empty Mailbox. To confirm,
touch Empty Mailbox.

9. To exit, touch X.

Storing a Fax in a Remote Mailbox

To store a fax in a remote mailbox:

1. Load your original documents.

2. At the printer control panel, press the Home button, then touch Fax.

3. If the entry screen is displayed, touch Mailboxes, or touch Add Recipient, then touch Mailboxes.
4. Touch Store To Mailbox.
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9.
10.

Touch Remote Mailbox.

To enter the fax number of the remote device, touch Enter Remote Fax Number, then use the numeric
keypad. Touch OK.

To enter the mailbox number, touch the Mailbox Number field, then use the numeric keypad. Touch Enter.

If a passcode is required, touch the Mailbox Passcode field. To enter the four-digit mailbox passcode, use the
numeric keypad. Touch OK.

Touch OK. To select a different mailbox, touch the recipient field, then touch Remove or Edit.

Touch Send. The original documents are scanned and stored in the remote mailbox.

Printing Remote Mailbox Documents

To print remote mailbox documents:

1.
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At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Mailboxes, or touch Add Recipient, then touch Mailboxes.
Touch Print From Mailbox.

Touch Remote Mailbox.

To enter the fax number of the remote device, touch Enter Remote Fax Number, then use the numeric
keypad. Touch OK.

To enter the mailbox number, touch the Mailbox Number field, then use the numeric keypad. Touch Enter.

If a passcode is required, touch the Mailbox Passcode field. To enter the four-digit mailbox passcode, use the
keypad. Touch OK.

Touch Print. The documents in the remote mailbox print.

Touch X to exit.

Adding or Editing Contacts in the Device Address Book from the Control Panel

You can set up the Device Address Book using the Embedded Web Server. The Address Book can contain up to
5000 contacts that you can access when you enter recipients or destinations using apps.

To add or edit contacts in the Device Address Book from the control panel:
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f” Note: Before you can use this feature, the system administrator must enable Create/Edit Contact from Touch

Screen for All Users.
Load your original documents.
At the printer control panel, press the Home button.
Touch Fax.
To clear previous App settings, touch Reset.
Touch Manual Entry. To type the fax number, use the touch screen keypad.

To add the recipient to the Device Address Book, touch the Address Book icon.
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7. Do one of the following steps.

e To create an entry, touch Create New Contact. Touch each field, then enter the contact details using the
touch screen keypad. Touch OK.

e To add to an existing entry, touch Add to Existing Contact. Touch a contact in the list, or use the Search
option to find a contact.

8. To mark a recipient to appear as a favorite option, touch the Star icon.
9. Adjust the fax settings as needed.
10. To start the scan, touch Send.

11.  To return to the Home screen, press the Home button.

Sending a Fax From Your Computer

You can send a fax to the printer from an application on your computer.

Sending a Fax From Windows Applications
You can use the print driver to send a fax from Windows applications.

You can use the fax window to enter recipients, create a cover page with notes, and set options. You can send a
confirmation sheet, set the send speed, resolution, send time, and dialing options.

To send a fax from Windows applications:

1. With the desired document or image open in your application, open the Print dialog box. For most software
applications, click File > Print or press CTRL+P.

Select the required printer, then to open the print driver dialog box, click Printer Properties.
On the Printing Options tab, from the Job Type list, select Fax.

In the Fax window, click the Recipients tab.
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To add recipients manually:

a. Click the Add Recipient icon.

b. Type the recipient name and fax number, then add other information as required.
c. Click OK.

d. To add more recipients, repeat this procedure.

6. To add existing contacts from a phonebook:

a. Click the Add From Phonebook icon.

b. Select the required phonebook from the list.

c.  Select names from the list, or search for a contact using the search bar.

d. To add the selected contacts to the Fax Recipients list, click the Down Arrow.
e. Click OK.

f.  To add more recipients, repeat this procedure.
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7. Toinclude a cover sheet, click the Cover Sheet tab. From the Cover Sheet Options list, select Print a Cover
Sheet. Enter the details as needed, then click OK.

8. On the Options tab, select the required options, then click OK.
9. To save your settings and return to the main print dialogue page, click OK.

10. Click Print. In the Fax Confirmation window, click OK.

Sending a Fax From Macintosh Applications

You can use the fax driver to send a fax from many Macintosh applications. To install the fax driver, refer to
Installing the Print Driver Software.

To send a fax from Macintosh applications:

1. With your document or image open in your application, open the Print dialog box. For most software
applications, click File > Print or press CMD+P.

2. Select the required printer.

3. To access the fax driver settings, in the print options list, click Xerox Features, then from the Job Type list, select
Fax.

To add a recipient, in the Fax window, click the Recipients tab, then click the Add Recipient icon.
Type the recipient name and fax number, add other information as needed, then click OK.

To add more recipients, repeat this procedure.

To include a cover sheet, click the Cover Sheet tab.

From the Cover Sheet list, select Print a Cover Sheet, then enter the details as needed.
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On the Options tab, select the required options. To save your settings and return to the main print dialog
window, click OK.

10. To send the fax, click Print.
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Server Fax

SERVER FAX OVERVIEW

Server Fax allows you to send a fax over a network to a fax server. The fax server then
sends the fax to a fax machine over a phone line. Before you can send a server fax,
configure a fax filing repository or filing location. The fax server retrieves the documents
from the filing location and transmits them over the telephone network.

For details about configuring and customizing the Apps, refer to the System Administrator Guide at www.xerox.com/
support/ALB80XXdocs.

For information about all the App features and available settings, refer to Apps Features.

SENDING A SERVER FAX

If a fax server is connected to the network, you can send a document to a fax machine without requiring a
dedicated telephone line.

When using the server fax, a document is scanned and sent to a fax repository on the network. The fax server sends
the fax over a telephone line to a fax machine.

Before you can use the server fax, the system administrator is required to enable the server fax app and configure a
fax repository, or filing location.

To send a server fax:
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1. Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in

the upper-left corner of the document glass.

e For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove all staples and
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against

the documents.

)
& Note: When the original documents are detected, the automatic document feeder confirmation indicator

LED illuminates.
2. At the printer control panel, press the Home button.
3. Touch Server Fax.

4, To clear previous app settings, touch Reset.
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Enter recipients.
e If the entry screen appears, touch an option, or touch X.

e To select a contact or group from the Device Address Book, touch the Device Address Book option, then
select a recipient.

e To enter the fax number manually, touch Manual Entry. In the Enter Fax Number field, enter the fax
number, then touch Add.

e To add more recipients, touch Add Recipient, then repeat the procedure.

f Note: To insert a pause as needed, touch Dial Pause. To enter longer pauses, touch Dial Pausemultiple

times.
Adjust server fax settings as needed.

e To scan more documents using the document glass, or to change settings for different sections of the job,
touch Build Job.

e If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
For details about available features, refer to Apps Features.

Touch Send.

If Build Job is enabled, touch Scan, then, when prompted, do these steps.

e To change settings, touch Program Next Segment.

e To scan another page, touch Scan Next Segment.

e To finish, touch Submit.

To return to the Home screen, press the Home button.

SENDING A DELAYED SERVER FAX

You can set a time in the future for the printer to send your fax job. The delay can range from 15 minutes through
24 hours.

f Note: Before you use this feature, set the printer to the current time.

To specify the time to send your server fax:

1.

A

Load your original documents.

At the printer control panel, press the Home button.

Touch Server Fax.

Add server fax recipients, then adjust server fax settings as needed. For details, refer to Sending a Server Fax.
Touch Delay Send.

Touch Delay Send, then set the time to send the server fax:

e To set the hour, touch the Hour field, then use the numeric keypad, or touch the arrows.

e To set the minutes, touch the Minute field, then use the numeric keypad, or touch the arrows.

e If your printer is set to display the 12-hour clock, touch AM or PM.
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7. Touch OK.
8. Touch Send. The fax is scanned and saved, then sent at the time you specified.

9. To return to the Home screen, press the Home button.
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Internet Fax

INTERNET FAX OVERVIEW

You can use the Internet Fax App to scan images and attach them to emails. You can
specify the file name and format of the attachment, and include a subject heading and
message for the email.

For details on configuring and customizing the Apps, refer to the System Administrator Guide at www.xerox.com/

support/ALB80XXdocs.

For information about all the App features and available settings, refer to Apps Features.

SENDING A SCANNED IMAGE IN AN INTERNET FAX

To send a scanned image in an email:
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1.

Load your original documents.

For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in
the upper-left corner of the document glass.

For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any staples or
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against
the document originals.

)
& Note: When the original documents are detected, the automatic document feeder confirmation indicator
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LED illuminates.

At the printer control panel, press the Home button.

Touch Internet Fax.

To clear previous app settings, touch Reset.

Enter recipients.

If the entry screen appears, to enter a recipient, touch an option, or touch X.

To select a contact from the Address Book, touch the Device Address Book option. Select a recipient, then
touch OK.

To enter an Internet fax address manually, touch Manual Entry. In the Enter an Internet Fax Address field,
enter the Internet fax address, then touch Add.

To add more recipients, touch Add Recipient, then repeat the procedure.
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6. To organize the recipients, touch one of the recipients on the list, then from the menu, select To: or Cc:.

7. Adjust the Internet fax settings as needed:

To change the subject, touch Subject, enter a new subject, then touch OK.

To save the scanned document as a specific filename, touch the attachment filename, enter a new name,
then touch OK.

To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

To change the Internet fax message, touch Message, enter a new message, then touch OK.

To scan more documents using the document glass, or to change settings for different sections of the job,
touch Build Job.

If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.

For details about available features, refer to Apps Features.

8. To start the scan, touch Send.

9. If Build Job is enabled, touch Scan, then, when prompted, do these steps.

To change settings, touch Program Next Segment.
To scan another page, touch Scan Next Segment.

To finish, touch Submit.

10. To return to the Home screen, press the Home button.

Xerox® AltaLink® B80XX Series Multifunction Printer User Guide 131



Xerox® Apps

Print From

PRINT FROM OVERVIEW

[ You can use the Print From App to print jobs from various sources. You can print jobs
H stored in a print-ready format from a USB stick. You can also print Saved Jobs and jobs
(=] stored in a Mailbox.

To create a print-ready file, when you print your documents from programs such as Microsoft Word, select the Print
to File option. Check with your specific publishing application for options to create print-ready files.

PRINTING FROM A USB FLASH DRIVE

You can print single or multiple files stored on a USB Flash drive. The USB port is on the front of the printer.
f Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To print from a USB Flash drive:

1. Insert the USB Flash drive into the USB port on the printer.
2. At the USB Drive Detected screen, touch Print from USB.

f Note: If the Print from USB feature does not appear, enable the feature, or contact your system
administrator. For details, refer to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

3. To select a file for printing, browse to the file, then touch the check box. If multiple files require printing, browse
to each file, then select the check box for each file.

4. Touch OK.
A list of files selected for printing appears.
5. To remove files from the printing list:
e Toremove a single file, touch the file, then select Remove. To confirm removal, touch Remove.
e Toremove all the files, touch a file, then select Remove All. To confirm removal, touch Remove All.
6. Adjust the feature settings as needed.
7. Touch Print.
8. When you are finished, remove the USB Flash drive.
9

To return to the Home screen, press the Home button.

PRINTING FROM SAVED JOBS

To print from saved jobs:

1. At the control panel, press the Home button, then touch Print From.

2. Touch Saved Jobs, then touch the name of the folder that contains the saved job.

3. Touch the name of the saved job that you want to print.
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4. Select the options for paper supply, quantity, 2-sided printing, and finishing.
5. Touch Print.
f Note: To print a private saved job, at the Passcode Required screen, enter the passcode, then touch OK.

6. After the job prints, to return to the list of saved jobs, touch Change File.

7. To return to the Home screen, press the Home button.

PRINTING FROM MAILBOX

Print from mailbox allows you to print a file that is stored in a folder on the printer hard drive.
To print from a mailbox:

1. At the control panel, press the Home button, then touch Print From.

2. Select Mailboxes, then touch the name of the folder containing the document.

j’ Note: If Mailboxes does not appear, enable the feature or contact the system administrator. For details, refer
to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

Touch the name of the document that you want to print.
Select the options for paper supply, quantity, 2-sided printing, and finishing.
Touch Print.

After the job prints, to return to the mailbox folder, touch Change File.
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To return to the Home screen, press the Home button.
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Printing Overview

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected to an active
network. Ensure that you have the correct print driver software installed on your computer. For details, refer to
Installing the Print Driver Software.

1.
2.
3.

136

Select the appropriate paper.
Load paper in the appropriate tray. At the printer control panel, specify the paper size, color, and type.

Access the print settings in your software application. For most software applications, press CTRL+P for
Windows, or CMD+P for Macintosh.

Select your printer.

To access the print driver settings, for Windows, select Printer Properties, Print Options, or Preferences. For
Macintosh, select Xerox Features. The title of the button can vary depending on your application.

Modify the print driver settings as necessary, then click OK.
To send the job to the printer, click Print.
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Print Workflows

Printing options, also called print driver software options, are specified as Printing Preferences in Windows, and
Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page layout, and print quality.
Printing options that are set from Printing Preferences become the default setting. Printing options that are set from
within the software application are temporary. The application and the computer do not save the settings after the
application is closed.

PRINT DRIVER HELP

Xerox® print driver software Help information is available from the Printing Preferences window. Click the Help ( ?)
button in the bottom left corner of the Printing Preferences window to see the Help.
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Information about Printing Preferences appears in the Help window on two tabs:

e Contents provides a list of the tabs at the top and the areas at the bottom of the Printing Preferences window.
Use the Contents tab to find explanations for each of the fields and areas in Printing Preferences.

e Search provides a field where you can enter the topic or function for which you need information.

WINDOWS PRINTING OPTIONS

Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings specified in the Printing
Preferences window. You can specify your most common printing options and save them so that you do not have to
change them every time you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in Printing
Preferences.
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1. Navigate to the list of printers on your computer:

For Windows Server 2008 and later, click Start > Settings > Printers.

For Windows 7, click Start > Devices and Printers.

For Windows 8, click Start > Control Panel > Devices and Printers.

For Windows 10, click Start > Settings > Devices > Printers & scanners. Scroll down in the window, then
under Related settings, click Devices and printers.

j’ Note: If you are using a custom Start Menu application, it can change the navigation path to your list of
printers.

2. Inthe list of printers, right-click the icon for your printer, then click Printing preferences.

3. Inthe Printing Preferences window, click a tab, then select the options. To save the settings, click OK.

j’ Note: For more information about Windows print driver options, click the Help button ( ?) in the Printing
Preferences window.

Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, you can change the Printing Preferences before sending the job
to the printer.

1. With the document open in your software application, access the print settings. For most software applications,
click File > Print or press CTRL+P for Windows.

2. To open the Printing Preferences window, select your printer, then click the Printer Properties, Print Options,
or Preferences button. The title of the button can vary, depending on your application.

3. Click a tab in the Printing Preferences window, then make selections.
4. To save your selections and close the Printing Preferences window, click OK.

5. To send the job to the printer, click Print.

Selecting Finishing Options for Windows

If your printer has a finisher installed, you can select finishing options in the Properties window of the print driver.
Finishing options allow you to select how your document is delivered. For example, you can select hole-punching,
stapling, folding, or printing in a booklet format.

j’ Note: Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

To select finishing options in the PostScript and PCL print drivers:
1. In the print driver, click the Printing Options tab.

2. To select a finishing option, for Finishing, click the arrow.

j’ Note: The print driver displays stapling positions for paper fed on the long edge. If paper feeds on the short
edge instead of the long edge, the finisher can insert the staple in the wrong location.
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To select the output tray, for Output Destination field, click the arrow, then select an option:

e Automatic: You can use this option to have the printer determine the output destination based on the
number of sets and the stapling option selected. The printer sends multiple sets or stapled sets to the
finisher output tray.

e Folder Tray: You can use this option to select the output tray for the CZ Folder.

e Top Tray: You can use this option to select the output tray on top of the Office Finisher or the High Volume
Finisher.

e Stacker Tray: You can use this option to select the output tray in the middle of the Office Finisher or the
High Volume Finisher.

e Booklet Maker Bin: You can use this option to select the output tray on the bottom of the High Volume
Finisher.

4. To send the job to the printer, click OK, then click Print.

Selecting Printing Defaults in Windows for a Shared Network Printer

1.

Navigate to the list of printers on your computer:

e For Windows Server 2008 and later, click Start > Settings > Printers.
e For Windows 7, click Start > Devices and Printers.

e For Windows 8, click Start > Control Panel > Devices and Printers.

e For Windows 10, click Start > Settings > Devices > Printers & scanners. Scroll down in the window. For
Related settings, click Devices and printers.

f” Note: If the Control Panel icon does not appear on the desktop, right-click the desktop, then select

Personalize > Control Panel Home > Devices and Printers.
In the list of printers, right-click the icon for your printer, then select Printer properties.
In the printer Properties dialog box, click the Advanced tab.
On the Advanced tab, click Printing Defaults.
Make your selections on the print driver tabs as needed, then click Apply.

To save the settings, click OK.

Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1.
2.
3.

With the document open in your application, click File > Print.
Select the printer, then click Properties. Click the tabs in the Properties window, then select the desired settings.

To save the settings, click the arrow to the right of the Saved Settings field at the bottom of the window, then
click Save As.

Type a name for the set of printing options, then to save the set of options in the Saved Settings list, click OK.

To print using these options, select the name from the list.
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MACINTOSH PRINTING OPTIONS

Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.
1. With the document open in your application, click File > Print.

2. Select your printer.

3. Inthe Print Options menu, select Xerox Features.
f Note: To see all printing options, click Show Details.

4. Select any other required printing options from the lists.

5. To send the job to the printer, click Print.

Selecting Finishing Options for Macintosh

If your printer has a finisher installed, select finishing options in the Xerox® Features of the print driver.
To select finishing options in the Macintosh print driver:

1. In the Print window, in the print options list, click Xerox Features.

2. To select stapling options, for Finishing, click the arrow, then select an option.

3. To select the output tray, for Output Destination, click the arrow, then select an option.

e Automatic: You can use this option to have the printer determine the output destination based on the
number of sets and the stapling option selected. The printer sends multiple sets or stapled sets to the
finisher output tray.

e Folder Tray: You can use this option to select the output tray for the CZ Folder.

e Top Tray: You can use this option to select the output tray on top of the Office Finisher or the High Volume
Finisher.

e Stacker Tray: You can use this option to select the output tray in the middle of the Office Finisher or the
High Volume Finisher.

e Booklet Maker Bin: You can use this option to select the output tray on the bottom of the High Volume
Finisher.

4. To send the job to the printer, click Print.

Saving a Set of Commonly Used Printing Options for Macintosh

You can define and save a set of options, so that you can apply them to future print jobs.
To save a set of printing options:

1. With the document open in your application, click File > Print.

2. Select your printer from the Printers list.
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3. Select the required printing options from the lists in the Print dialog box.
j’ Note: To see all printing options, click Show Details.

4. Click Presets > Save Current Settings as Preset.
5. Type a name for the printing options. To save the set of options in the Presets list, click OK.

6. To print using these options, select the name from the Presets list.
LINUX PRINTING OPTIONS

Launching Xerox Printer Manager

To launch Xerox® Printer Manager from a terminal window prompt as root, type xeroxprtmgr, then press Enter or
Return.

Printing from a Linux Workstation
To print from a Linux workstation:
1. Create a print queue.

2. With the desired document or graphic open in your application, open the Print dialog box. For most software
applications, click File > Print or press CTRL+P.

Select the target print queue.
Close the Print dialog box

In the Xerox® GUI print driver, select the available printer features.
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Click Print.

The Xerox® print driver accepts job ticket settings files that select additional settings or features. You can also
submit print requests through the command line using lp/lpr.

Creating a job ticket using the Xerox® GUI print driver
1. Open the Xerox® GUI print driver.
2. Select the desired options.

3. Click Save As, then store the job ticket in a public location, such as /tmp.

j’ Note: Personally identifiable information, such as a Secure Print passcode, is not saved in the job ticket. You
can specify the information on the command line.

Creating a job ticket using the command line
1. Onthe command line, as the root user, type xeroxprtmgr.
2. Select the desired options.

3. Click Save As, then store the job ticket in a public location, such as /tmp.

j’ Note: Personally identifiable information, such as a Secure Print passcode, is not saved in the job ticket. You
can specify the information on the command line.
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The following commands are examples of how to print using a job ticket:

e |p-d{Target_Queue} -0JT={Absolute_Path_To_Job_Ticket} {Path_To_Print_File}

e |p -dMyQueue -oJT=/tmp/DuplexedLetterhead /home/user/PrintReadyFile

e |p -dMyQueue -0JT=/tmp/Secure -oSecurePasscode=1234 /home/user/PrintReadyFile

MOBILE PRINTING OPTIONS

This printer can print from iOS and Android mobile devices.

Printing with Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smartphone, using Wi-Fi
Direct.

For details, refer to Connecting with Wi-Fi Direct.

For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device.

f Note: Depending on which mobile device you are using, the printing procedure varies.

Printing from a Mopria-Enabled Mobile Device

Mopria is a software feature that enables users to print from mobile devices without requiring a print driver. You can
use Mopria to print from your mobile device to Mopria-enabled printers.

¢ Note:

e Mopria and all of its required protocols are enabled by default.

e Ensure that you have the latest version of the Mopria Print Service installed on your mobile device. You
can obtain a free download from the Google Play Store.

e Wireless devices must join the same wireless network as the printer.

e The name and location of your printer appears in a list of Mopria-enabled printers on connected devices.

To print using Mopria follow the directions provided with your mobile device.
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Print Jobs

MANAGING JOBS

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs. You can pause,
delete, print, or view job progress or job details for a selected job. When you send a secure print job, the job is held
until you release it by typing a passcode at the control panel. For details, refer to Printing Special Job Types

From the Jobs window in the Embedded Web Server, you can view a list of active and saved print jobs.

Pausing, Promoting, or Deleting a Job Waiting to Print
1. At the printer control panel, press the Home button.
2. Touch Jobs, then touch the name of the desired print job.
3. Select a task.
f Note: If you do not make a selection, the job automatically resumes after the set timeout period.
e To pause the print job, touch Hold. To resume the print job, touch Release.
e To delete the print job, touch Delete. At the prompt, touch Delete.
e To move the job to the top of the list, touch Promote.
e To view the status of the job, touch Job Progress.
e To view information about the job, touch Job Details, then touch Job Settingsor Required Resources.

4. To return to the Home screen, press the Home button.

¢ Note:

e The system administrator can restrict users from deleting jobs. If a system administrator has restricted
job deletion, you can view the jobs, but cannot delete them.

e Only the user that sent the job, or the system administrator, can delete a Secure Print job.

Printing a Job Held for Resources
1. At the printer control panel, press the Home button.
2. Touch Jobs.

3. From the jobs list, touch the held job name. The resources required for the job appear on the control panel.
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4. Do one of the following steps.

To print the job, replenish the resources required. The job resumes automatically when the required
resources are available. If the job does not print automatically, touch Resume.

To choose an alternative paper source to enable the job to print, touch Print On Alternate Paper. Select a
paper tray, then touch OK.

e To delete the print job, touch Delete. At the prompt, touch Delete.

j’ Note: The Print On Alternate Paper option is enabled using the Embedded Web Server. For details about the
Print On Alternate Paper option, refer to the System Administrator Guide at www.xerox.com/support/
ALB80XXdocs.

5. Toreturn to the Home screen, press the Home button.

PRINTING SPECIAL JOB TYPES

Special job types allow you to send a print job from your computer, then print it from the printer control panel.
Select special job types in the print driver, Printing Options tab, under Job Type.

Saved Job

Saved Jobs are documents sent to the printer and stored there for future use. All users can print or delete a Saved
Job.

On the control panel, from the Print From menu, you can view and print saved jobs. In the Embedded Web Server,
on the Jobs window, you can view, print, and delete saved jobs, and you can manage where jobs are stored.

To print a saved job from the control panel, refer to Printing from Saved Jobs.

Printing using Saved Job

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button can vary.
e For Macintosh, in the Print window, in the print options list, click Xerox Features.
3. For Job Type, select Saved Job.
a. Type ajob name or select a name from the list.
b. Type a folder name or select a name from the list.
c. To add a passcode, click Private, type the passcode, then confirm the passcode.
d. Click OK.
4. Select other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.
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Print, Delete, Move, or Copy a Saved Job in the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

In the Embedded Web Server, click Home.
Click Jobs.
Click the Saved Jobs tab.

For the job that you want to process, select the check box.

o v &~ W N

From the menu, select an option.

e Print Job: This option prints a job immediately.

e Delete Job This option deletes the saved job.

e Move Job: Use this option to move the job to another folder location.
e Copy Job: Use this option to duplicate the job.

7. Click Go.

Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the printer until
you enter your passcode at the printer control panel.

After a Secure Print job is printed, it is deleted automatically.

Printing using Secure Print

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Secure Print.

4. Type the passcode, confirm the passcode, then click OK.

5. Select any other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Secure Print job

1. At the printer control panel, press the Home button.
Touch Jobs.

To view Secure Print jobs, touch Personal & Secure Jobs.

Touch your folder.

v W N

Enter the passcode number, then touch OK.
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6. Select an option:

e To print a Secure Print job, touch the job.

To print all the jobs in the folder, touch Print All.
e To delete a Secure Print job, touch the Trash icon. At the prompt, touch Delete.
e To delete all the jobs in the folder, touch Delete All.

j’ Note: After a Secure Print job is printed, it is deleted automatically.

7. To return to the Home screen, press the Home button.

Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining copies. After
reviewing the sample set, you can either print the remaining copies or delete them at the printer control panel.

Sample Set is a type of saved job with these features:

e A Sample Set job appears in a folder named after the user ID associated with the print job.

e A Sample Set job does not use a passcode.

e Any user can print or delete a Sample Set job.

e A Sample Set prints one copy of a job to allow you to proofread the job before printing any remaining copies.
After a Sample Set job is printed, it is deleted automatically.

To print a Sample Set, refer to Printing using Sample Set.

Printing using Sample Set

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Sample Set.

4. Select any other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Sample Set
1. At the printer control panel, press the Home button.
2. To view available jobs, touch Jobs.

3. Touch the Sample Set job.

j’ Note: The Sample Set file description shows the job as Held for Future Printing, and shows the number of
remaining copies of the job.
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4, Select an option.
e To print the remaining copies of the job, touch Release.
e To delete the remaining copies of the job, touch Delete.

5. To return to the Home screen, press the Home button.
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Printing Features

SELECTING PAPER OPTIONS FOR PRINTING

There are two ways to select the paper for your print job. You can let the printer select which paper to use based on
the document size, paper type, and paper color you specify. You can also select a specific tray loaded with the
desired paper.

e To locate paper options in Windows, in the print driver, click the Printing Options tab.

e To locate paper options on Macintosh, in the Print window, in the print options list, click Xerox Features. Within
Xerox Features, in the options list, click Paper/Output.

Scaling
Scaling reduces or enlarges the original document to match the selected output paper size.

e To locate scale options in Windows, on the Printing Options tab, for Paper, click the arrow, select Other Size,
then click Advanced Paper Size.

e To locate scale options on Macintosh, in the Print window, click Show Details.
The following scaling options are available:

e Automatically Scale scales the document to fit the selected Output Paper Size. The scaling amount appears in
the percentage box below the sample image.

» No Scaling does not change the size of the page image printed on the output paper, and 100 % appears in the
percentage box. If the original size is larger than the output size, the page image is cropped. If the original size
is smaller than the output size, extra space appears around the page image.

e Manually Scale scales the document by the amount entered in the percentage box below the preview image.
PRINTING ON BOTH SIDES OF THE PAPER

Printing a 2-Sided Document

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print driver uses
the settings for portrait or landscape orientation from the application for printing the document.

j’ Note: Ensure that the paper size and weight are supported. For details, refer to Supported Paper Sizes and
Weights for Automatic 2-Sided Printing.

2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. These settings
override the application page orientation settings.
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e 1-Sided Print: This option prints on one side of the media. Use this option when printing on envelopes, labels,
or other media that cannot be printed on both sides.

e 2-Sided Print: This option prints the job on both sides of the paper to allow binding on the long edge of the
paper. The following illustrations show the result for documents with portrait and landscape orientations,
respectively:

12 B

e 2-Sided Print, Flip on Short Edge: This option prints on both sides of the paper. The images print to allow
binding on the short edge of the paper. The following illustrations show the result for documents with portrait
and landscape orientations, respectively:

' T2

f Note: 2-Sided Printing is part of the Earth Smart settings.

To change your default print driver settings, refer to Setting Default Printing Options for Windows.

PRINT QUALITY

The Windows Postscript print driver and the Macintosh print drivers provide the highest print-quality modes:
e High Resolution: This print-quality mode prints halftones at 1200 x 1200 dpi.

e Standard: This print-quality mode prints halftones at 600 x 600 dpi.

o Toner Saver: This print-quality mode prints halftones at 600 x 600 dpi.

IMAGE OPTIONS

Image options controls how the printer uses lightness and contrast to produce your document. The Windows
PostScript print driver and the Macintosh print drivers provide the widest range of controls on the Image Options
tab.

e To locate Image Options in Windows, in the print driver, click the Image Options tab.

e To locate Image Options on Macintosh, in the Print window, in the print options list, click Xerox Features.
Within Xerox Features, in the options list, click Image Options.

Lightness

The Lightness feature allows you to adjust the overall lightness or darkness of the text and images in your printed
job.

Contrast

You can use the Contrast feature to adjust the variation between light and dark areas of the print job.
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PRINTING MULTIPLE PAGES TO A SINGLE SHEET

When printing a multiple-page document, you can print more than one page on a single sheet of paper.
Toprint 1, 2, 4,6, 9, or 16 pages per side, on the Page Layout tab, select Pages Per Sheet.

e To locate Pages Per Sheet in Windows, on the Document Options tab, click Page Layout.

e To locate Pages Per Sheet on Macintosh, in the Print window, in the print options list, click Layout.

1 4

To print a border around each page, select Page Borders.

PRINTING BOOKLETS

With 2-sided printing, you can print a document in the form of a small booklet. You can create booklets from any
paper size that is supported for 2-sided printing.

The print driver automatically reduces each page image and prints four page images per sheet of paper, two page
images on each side. The pages are printed in the correct order so that you can fold and staple the pages to create
the booklet.

e To locate booklet creation in Windows, on the Document Options tab, click Page Layout.

e To locate booklet creation on Macintosh, in the Print window, in the print options list, click Xerox Features.
Within Xerox Features, in the options list, click Booklet Layout.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter and creep.
e QGutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm (1/72 in.).

e Creep: Specifies how much the page images shift outward in tenths of a point. Shifting compensates for the
thickness of the folded paper, which can cause the page images to shift outward slightly when folded. You can
select a value from zero to 1 point.

GUTTER CREEP

—

‘&Q Note: To print a border around each page, select Page Borders.
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USING SPECIAL PAGES
The Special Pages options control how covers, inserts, and exception pages are added to your printed document.
e To locate Special Pages in Windows, on the Document Options tab, click Special Pages.

e To locate Special Pages on Macintosh, in the Print window, in the print options list, click Xerox Features. Within
Xerox Features, in the options list, click Special Pages.

Printing Cover Pages

A cover page is the first or last page of a document. You can select paper sources for the cover pages that are
different from the source used for the body of a document. For example, you can use your company letterhead for
the first page of a document. You can use heavyweight paper for the first and last pages of a report. You can use
any applicable paper tray as the source for printing cover pages.

The following options are available:

¢ No Covers: This option does not print cover pages. No cover pages are added to the document.

» Front Only: This option prints the first page on paper from the specified tray.

e Back Only: This option prints the back page on paper from the specified tray.

e Front and Back: Same: This option prints the front and back cover pages from the same tray.

e Front and Back: Different: This option prints the front and back cover pages from different trays.

After you make a selection for printing the cover pages, you can select the paper for the front and back covers by
size, color, or type. You can use blank or pre-printed paper, and you can print side one, side two, or both sides of the
cover pages.

Printing Insert Pages

You can add blank or pre-printed insert pages before page one of each document or after designated pages within
a document. Adding an insert after designated pages within a document separates sections, or acts as a marker or
placeholder. Ensure that you specify the paper to use for the insert pages.

e Insert Options: Provides the options to place an insert After Page X, where X is the specified page, or Before
Page 1.

¢ Quantity: Specifies the number of pages to insert at each location.

e Pages: Specifies the page or range of pages that use the exception page characteristics. Separate individual
pages or page ranges with commas. Specify pages within a range with a hyphen. For example, to specify pages
1,6,9,10,and 11, type 1,6,9-11.

o Paper: Displays the default size, color, and type of paper selected in Use Job Settings. To specify a different
paper size, color, or type, for Paper, click the arrow, then select an option.

e Job Setting: Displays the attributes of the paper for the remainder of the job.
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Printing Exception Pages

Exception pages have different settings from the rest of the pages in the job. You can specify differences such as
page size, page type, and page color. You can also change the side of the paper on which to print as your job
requires. A print job can contain multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one side of a special paper, and
the remainder of the pages printed 2-sided on regular paper. You can use exception pages to print the job.

In the Add Exceptions window, you can set the characteristics of the exception pages and select the alternate
paper source:

e Pages: Specifies the page or range of pages that use the exception page characteristics. Separate individual
pages or page ranges with commas. Specify pages within a range with a hyphen. For example, to specify pages
1,6,9,10,and 11, type 1,6,9-11.

e Paper: Displays the default size, color, and type of paper selected in Use Job Settings.
e 2-Sided Printing allows you to select 2-sided printing options. Click the Down arrow to select an option:
— 1-Sided Print prints the exception pages on one side only.

— 2-Sided Print prints the exception pages on both sides of the paper and flips the pages on the long edge.
The job then can be bound on the long edge of the pages.

— 2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and flips the
pages on the short edge. The job then can be bound on the short edge of the pages.

— Use Job Setting prints the job using the attributes shown in the Job Settings box.

e Job Setting: Displays the attributes of the paper for the remainder of the job.

j’ Note: Some combinations of 2-sided printing with certain paper types and sizes can produce unexpected
results.

PRINTING WATERMARKS FOR WINDOWS

A watermark is special-purpose text that can be printed across one or more pages. For example, you can add a word
like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before distribution.

¢ Note:

e This feature is available only on a Windows computer printing to a network printer.

e Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

e Watermarks are not supported for some print drivers when booklet is selected or when more than one
page is printed on a sheet of paper.

To print a watermark:

1. In the print driver, click the Document Options tab.
2. Click the Watermark tab.

3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or create a
customized watermark. You can also manage watermarks from this menu.

152 Xerox® AltaLink® B80XX Series Multifunction Printer User Guide



Printing

4. Under Text, select an option:
e Text: Enter the text in the field, then specify the font.
e Time Stamp: Specify the date and time options, then specify the font.
e Picture: To locate the picture, click the Browse icon.

5. Specify the scaling angle and position of the watermark:

e Select the scaling option that specifies the size of the picture in relation to the original image. Use the
arrows to scale the image in increments of 1%.

o To define the angle of the image on the page, specify the position option or to rotate the image left or
right by increments of 1, use the arrows.

« To define the location of the image on the page, specify the position option, or to move the image in each
direction in increments of 1, use the arrows.

6. Under Layering, select how to print the watermark:
e Print in Background: This option prints the watermark behind the text and graphics in the document.

e Blend: This option combines the watermark with the text and graphics in the document. A blended
watermark is translucent, so you can see both the watermark and the document content.

e Print in Foreground: This option prints the watermark over the text and graphics in the document.
7. Click Pages, then select the pages to print the watermark:

e Print on All Pages: This option prints the watermark on all pages of your document.

e Print on Page 1 Only: This option prints the watermark only on the first page of the document.
8. If you select a picture as a watermark, specify the lightness settings for the image.

9. Click OK.

ORIENTATION
Orientation allows you to select the direction that the page prints.

e To locate orientation options in Windows, on the Document Options tab, click Orientation.

f Note: The orientation setting in your application print dialog box can override the orientation options in the
print driver.

e To locate orientation options on Macintosh, in the Print window, click Show Details.
The following options are available:

o Portrait: Orients the paper so that the text and images print across the short dimension of the paper.

e Landscape: Orients the paper so that the text and images print across the long dimension of the paper.

A
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¢ Rotated Landscape: Orients the paper so that the content is rotated 180 degrees and with the long bottom
side up.

v

fo Note: For Macintosh, to print portrait text and images in landscape orientation, clear the Auto Rotate check
box.

ADVANCED TAB

You can use the Advanced tab to set advanced printing options. Selections on this tab apply to all jobs that you
print with the print driver.

f Note: Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

e To locate advanced printing options in Windows, in the print driver, click the Advanced tab.

e To locate advanced printing options on Macintosh, in the Print window, in the print options list, click Xerox
Features. Within Xerox Features, in the options list, click Advanced.

Job Identification

You can use the Job ID feature to change the job identification setting for your print job. You can print the job
identification on a separate banner page or on the pages of your document.

To change the job identification setting from the Advanced tab:
1. Click Job ID or Job Identification.
2. Select an option.
e Disable Job ID: This option directs the printer not to print a banner page.
e Print ID on a Banner Page: This option prints the job identification on a banner page.

e Print ID in Margins - First Page Only: This option prints the job identification on the first page of the
document in the top-left margin.

e Print ID in Margins - All Pages: This option prints the job identification in the top-left margin on every
page of the document.

3. Click OK.

Printing Mirror Images

If the PostScript print driver is installed, you can print pages as a mirror image. Images are mirrored left-to-right
when printed.

e To locate mirror output in Windows, on the Advanced tab, for Advanced Settings, click Mirror Output.

e To locate mirror output on Macintosh, within Xerox Features, in the Advanced window, click Mirrored Output.
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Selecting Job Completion Notification for Windows

You can select to be notified when your job finishes printing. A message appears on your computer screen with the
name of the job and the name of the printer where it was printed.

j’ Note: This feature is only available on a Windows computer printing to a network printer.

To select job completion notification from the Advanced tab:
1. Click Notifications.
2. Click Notify for Completed Jobs, then select an option.
e Enabled: This option turns on notifications.
e Disabled: This option turns off the Notification feature.
3. Click OK.

Document Encryption for Windows Print Jobs

You can select encryption for your print job. The print file is encrypted before it is transmitted to the printer. The
print file is decrypted before it is printed.

j’ Note: This feature is available on a Windows computer that is printing to a network printer. It applies to the
PostScript and PCL print drivers.

To locate the setting to enable or disable document encryption, in the print driver, click the Advanced tab.

j’ Note: This feature is available only when Document Encryption is set to Manually Encrypt Documents in the
printer properties of the printer. For details, refer to Setting Encryption Defaults in Windows.
Setting Encryption Defaults in Windows
1. Navigate to the list of printers on your computer:
e For Windows Server 2008 and later, click Start > Settings > Printers.
e For Windows 7, click Start > Devices and Printers.
e For Windows 8, click Start > Control Panel > Devices and Printers.

e For Windows 10, click the Windows Start > Settings > Devices > Printers & Scanners. Scroll to Related
settings, then click Devices and printers.

j’ Note: If the Control Panel icon does not appear on the desktop, right-click the desktop, then select
Personalize. Select Control Panel Home > Devices and Printers.

2. Inthe list of printers, right-click the icon for your printer, then select Printer properties.

3. Inthe printer Properties dialog box, click the Administration tab.
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4. Under Configurations, click Document Encryption, then select an option:
e Disabled: This option disables encryption for all documents that you send to the printer.
e Encrypt All Documents: This option encrypts all documents that you send to the printer.

e Manually Encrypt Documents: This option allows you to set encryption for specific jobs that you send to
the printer.

j’ Note: Manually Encrypt Documents is the default printer setting.

5. Click Apply.
6. To save the settings, click OK.
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Using Custom Paper Sizes

You can print on custom paper sizes that are within the minimum and maximum size range supported by the
printer. For details, refer to Supported Custom Paper Sizes.

PRINTING ON CUSTOM PAPER SIZES

L
f Note: Before printing on a custom paper size, use the Custom Paper Sizes feature in Printer Properties to
define the custom size. For more information, refer to Defining Custom Paper Sizes.

Printing on Custom Paper Size from Windows
j’ Note: Before printing on custom-size paper, define the custom size in the Printer Properties.

1. Load the custom-size paper in the tray.

In the application, click File > Print, then select your printer.

In the Print dialog box, click Printer Properties.

On the Printing Options tab, from the Paper list, select the required custom paper size and type.

Select any other required options, then click OK.
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In the Print dialog box, click Print.

Printing on Custom Paper Size from Macintosh
1. Load the custom-size paper. For details, refer to Loading Paper.
In the application, click File > Print.

From the Paper Size list, select the custom paper size.

&owN

Click Print.

DEFINING CUSTOM PAPER SIZES

To print custom paper sizes, define the custom width and length of the paper in the print driver software and on the
printer control panel. When setting the paper size, ensure that you specify the same size as the paper in the tray.
Setting the wrong size can cause a printer error. Print driver settings override control panel settings when you print
using the print driver software on your computer.

Creating and Saving Custom Paper Sizes in the Print Driver

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print driver and
are available for you to select in all your applications.

For details on supported paper sizes for each tray, refer to Supported Custom Paper Sizes.

Creating and Saving Custom Sizes for Windows

1. In the print driver, click the Printing Options tab.
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5.

For Paper, click the arrow, then select Other Size > Advanced Paper Size > Output Paper Size > New.
In the New Custom Paper Size window, enter the height and width of the new size.

To specify the units of measurement, at the bottom of the window, click the Measurements button, then
select Inches or Millimeters.

To save, in the Name field, type a title for the new size, then click OK.

Creating and Saving Custom Sizes for Macintosh

1.
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In the application, click File > Print.

Click Paper Size, then select Manage Custom Sizes.

To add a new size, in the Manage Paper Sizes window, click the plus sign ( +).
Double-click Untitled, then type a name for the new custom size.

Enter the height and width of the new custom size.

Click the arrow for the Non-Printable Area field, then select the printer from the list. Or, for User Defined
margins, set the top, bottom, right, and left margins.

To save the settings, click OK.

Defining a Custom Paper Size at the Control Panel

You

can print custom-size paper from Tray 5. If Trays 1 and 2 are set to Fully Adjustable mode, you can print

custom-size paper from Trays 1 and 2. Custom-size paper settings are saved in the print driver and are available for

you

to select in all your applications.

j’ Note: To configure the tray settings for Fully Adjustable or Dedicated mode, refer to Configuring Tray

v W N

158

Settings.
Open the paper tray, then load the custom-size paper.
Close the tray.
At the control panel, to define the new paper size, touch Size, then touch Custom.
In the Custom Paper Size window, enter the height and width of the new paper size, then touch OK.

To confirm the settings, touch Confirm.
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Print From

PRINTING FROM A USB FLASH DRIVE

You can print single or multiple files stored on a USB Flash drive. The USB port is on the front of the printer.
j’ Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To print from a USB Flash drive:
1. Insert the USB Flash drive into the USB port on the printer.
2. At the USB Drive Detected screen, touch Print from USB.

f Note: If the Print from USB feature does not appear, enable the feature, or contact your system
administrator. For details, refer to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

3. To select a file for printing, browse to the file, then touch the check box. If multiple files require printing, browse
to each file, then select the check box for each file.

4. Touch OK.
A list of files selected for printing appears.
5. To remove files from the printing list:
e Toremove a single file, touch the file, then select Remove. To confirm removal, touch Remove.
e Toremove all the files, touch a file, then select Remove All. To confirm removal, touch Remove All.
Adjust the feature settings as needed.
Touch Print.

When you are finished, remove the USB Flash drive.

0 N o

To return to the Home screen, press the Home button.

PRINTING FROM SAVED JOBS

To print from saved jobs:

1. At the control panel, press the Home button, then touch Print From.

Touch Saved Jobs, then touch the name of the folder that contains the saved job.
Touch the name of the saved job that you want to print.

Select the options for paper supply, quantity, 2-sided printing, and finishing.
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Touch Print.

f Note: To print a private saved job, at the Passcode Required screen, enter the passcode, then touch OK.
6. After the job prints, to return to the list of saved jobs, touch Change File.

7. To return to the Home screen, press the Home button.
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PRINTING FROM MAILBOX

Print from mailbox allows you to print a file that is stored in a folder on the printer hard drive.
To print from a mailbox:

1. At the control panel, press the Home button, then touch Print From.

2. Select Mdailboxes, then touch the name of the folder containing the document.

j’ Note: If Mailboxes does not appear, enable the feature or contact the system administrator. For details, refer
to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

Touch the name of the document that you want to print.
Select the options for paper supply, quantity, 2-sided printing, and finishing.
Touch Print.

After the job prints, to return to the mailbox folder, touch Change File.

N o v &~ W

To return to the Home screen, press the Home button.

PRINTING FROM THE EMBEDDED WEB SERVER

You can print .pdf, .ps, .pcl, and .xps files directly from the Embedded Web Server without need of another
application or the print driver. The files can be stored on a local computer hard drive, mass storage device, or
network drive.

To print from the Embedded Web Server:

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter
or Return.

f Note: If you do not know the IP address of your printer, refer to Finding the IP Address of Your Printer.
2. Inthe Embedded Web Server, click the Print tab.

3. To select the file from a local network or remote location, for File Name, click Browse, select the file, then click
Open.

4. For Printing, select the desired options for the job.
e Normal Print prints a job immediately.
e Secure Print prints a job after you enter your passcode at the printer control panel.

e Sample Set, or Proof Print, prints one copy of a multiple-copy print job and holds the remaining copies at
the printer.

e Save Job for Reprint saves a print job in a folder on the print server for future printing. You can specify a
job name and folder.

Delay Print prints a job at a specified time up to 24 hours from the original job submission.
5. If Accounting is enabled, enter your User ID and account information.

6. Click Submit Job.

f Note: To ensure that the job was sent to the queue, wait for the job submission confirmation message to
appear before you close this page.
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Paper and Media Overview

The printer has five paper trays:

e Trays 1 and 2 are adjustable trays that can hold a range of paper sizes.

e Trays 3 and 4 are high-capacity trays that can hold A4-size or Letter-size paper.
e Tray 5 is designed for loading small amounts of special paper.

The printer has three optional paper trays:

e The Envelope Tray can replace Tray 2.

e Tray 6 is a high-capacity paper tray that can hold A4-size or Letter-size paper. When one of the optional
conversion kits is installed, the kit can feed more paper sizes.

e Tray 7 is a paper inserter tray for use with the High-Volume Finisher.

The printer can use various media types, such as plain, recycled, or colored paper, letterhead, pre-printed, cardstock,
labels, transparencies, and envelopes. Ensure that you use the correct media for the tray that you are loading. You
can load all types of media in Tray 5.

Labels affixed inside each tray show the correct orientation for loading certain types of media in the tray. The MAX
label shows the maximum fill line for the tray.
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Supported Paper

Your printer is designed to use various paper and other media types. To ensure the best print quality and to avoid
jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

RECOMMENDED MEDIA
A list of paper and media recommended for your printer is available at:
e www.xerox.com/rmlna Recommended Media List (United States)

e www.xerox.com/rmleu Recommended Media List (Europe)

ORDERING PAPER

To order paper, transparencies, or other media, contact your local reseller or go to www.xerox.com/supplies.

GENERAL PAPER LOADING GUIDELINES

e Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.

e Adjust the paper guides to fit the paper size.

e Fan paper before loading it in the paper tray.

e If excessive jams occur, use paper or other approved media from a new package.

e Use only recommended Xerox® transparencies. Print quality could vary with other transparencies.
e Do not print on label media once a label has been removed from a sheet.

e Use only paper envelopes. Print envelopes 1-sided only.

PAPER THAT CAN DAMAGE YOUR PRINTER

Some paper and other media types can cause poor output quality, increased paper jams, or damage your printer.
Do not use the following:

e Rough or porous paper

e Inkjet paper

e Non-laser glossy or coated paper

e Paper that has been photocopied

e Paper that has been folded or wrinkled

e Paper with cutouts or perforations

e Stapled paper

e Envelopes with windows, metal clasps, side seams, or adhesives with release strips

e Padded envelopes
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e Plastic media

e Iron on transfer paper

@ Caution: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does not
cover damage caused by using unsupported paper or special media. The Xerox® Total Satisfaction
Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Contact
your Xerox representative for details.

PAPER STORAGE GUIDELINES
Storing your paper and other media properly contributes to optimum print quality.

e Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from ultraviolet and
visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly damaging to paper.

e Reduce the exposure of paper to strong lights for long periods of time.

e Maintain constant temperatures and relative humidity.

« Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect moisture.
o Store paper flat, either on pallets, cartons, shelves, or in cabinets.

e Avoid food or drinks in the area where paper is stored or handled.

e Do not open sealed packages of paper until you are ready to load them into the printer. Leave stored paper in
the original packaging. The paper wrapper protects the paper from moisture loss or gain.

e Some special media is packaged inside resealable plastic bags. Store the media inside the bag until you are
ready to use it. Keep unused media in the bag and reseal it for protection.

SUPPORTED PAPER TYPES AND WEIGHTS
LAS PAPER TYPES WEIGHTS
Trays 1-4 2-sided 60-200 g/m?

Bond

Covers

Glossy

Hole punched

Index

Labels (Trays 1 and 2 only)

Letterhead

Plain

Pre-printed

Recycled

Transparencies (Tray 2 only)
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PAPER TYPES
Lightweight Cardstock

Cardstock

WEIGHTS
106-160 g/m?
161-216 g/m?

Paper and Media

Tray 5

2-sided

Bond

Covers

Glossy

Hole punched
Index

Labels
Letterhead
Plain
Pre-printed
Recycled
Transparencies

Envelopes

60-216 g/m>

Lightweight Cardstock

Cardstock

106-160 g/m?
161-216 g/m?

Tray 6

2-sided

Bond

Covers

Glossy

Hole punched
Index
Letterhead
Plain
Pre-printed
Recycled

60-200 g/m?

Lightweight Cardstock
Cardstock

106-160 g/m?
161-216 g/m?

Tray 7

Bond

Covers

60-216 g/m?
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TRAYS PAPER TYPES WEIGHTS

Glossy

Hole punched
Index
Letterhead
Plain
Pre-printed

Recycled

Lightweight Cardstock

Cardstock

106-160 g/m?
161-216 g/m?

Envelope Tray

Envelopes

80-90 g/m>

w2
f Note: Pre-cut tabs are not supported.

SUPPORTED STANDARD PAPER SIZES

TRAY NUMBER EUROPEAN STANDARD SIZES NORTH AMERICAN STANDARD SIZES

Trays 1 and 2

A5 (148 x 210 mm, 5.8 x 8.3 in.)

A4 (210x 297 mm, 8.3 x 11.7in.)

A3 (297 x 420 mm, 11.7 x 16.5in.)

B5 (176 x 250 mm, 6.9 x 9.8 in.)

B4 (250 x 353 mm, 9.8 x 13.9in.)
JISBS5 (182 x 257 mm, 7.2 x 10.7 in.)
JISB4 (257 x 364 mm, 10.1 x 14.3in.)

Statement (140 x 216 mm, 5.5 x 8.5 in.)
Executive (184 x 267 mm, 7.25 x 10.5in.)
Letter (216 x 279 mm, 8.5x 11 in.)

US Folio (216 x 330 mm, 8.5 x 13 in.)
Legal (216 x 356 mm, 8.5 x 14 in.)
Tabloid (279 x 432 mm, 11 x 17 in.)

Trays 3 and 4

A4 (210x 297 mm, 8.3 x 11.7 in.)

Letter (216 x 279 mm, 8.5x 11 in.)

Tray 5 A6 (105 x 148 mm, 4.1 x 5.8 in.) Statement (140 x 216 mm, 5.5 x 8.5 in.)

A5 (148 x 210 mm, 5.8 x 8.3 in.) Executive (184 x 267 mm, 7.25x 10.5in.)
A4 (210x 297 mm, 8.3 x 11.7 in.) Letter (216 x 279 mm, 8.5x 11 in.)
A3 (297 x 420 mm, 11.7 x 16.5in.) US Folio (216 x 330 mm, 8.5 x 13 in.)
B5 (176 x 250 mm, 6.9 x 9.8 in.) Legal (216 x 356 mm, 8.5 x 14in.)
JISB5 (182 x 257 mm, 7.2 x 10.1in.) Tabloid (279 x 432 mm, 11 x 17 in.)
JISB4 (257 x 364 mm, 10.1 x 14.3 in.)
C5 envelope (162 x 229 mm, 6.4 x 9 in.)
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TRAY NUMBER EUROPEAN STANDARD SIZES NORTH AMERICAN STANDARD SIZES
Tray 6 A4 (210x 297 mm, 8.3 x 11.7 in.) Letter (216 x 279 mm, 8.5x 11 in.)
Tray 7 A4 (210x 297 mm, 8.3 x 11.7 in.) Letter (216 x 279 mm, 8.5x 11 in.)

A3 (297 x 420 mm, 11.7 x 16.5in.)

US Folio (216 x 330 mm, 8.5 x 13 in.)
Legal (216 x 356 mm, 8.5 x 14 in.)

Tabloid (279 x 432 mm, 11 x 17 in.)

SUPPORTED PAPER SIZES AND WEIGHTS FOR AUTOMATIC 2-SIDED PRINTING

EUROPEAN STANDARD SIZES NORTH AMERICAN STANDARD SIZES

A5 (148 x 210 mm, 5.8 x 8.3 in.)

A4 (210 x 297 mm, 8.3 x 11.7 in.)

A3 (297 x 420 mm, 11.7 x 16.5in.)
JISB5 (182 x 257 mm, 7.2 x 10.1in.)
JIS B4 (257 x 364 mm, 10.1 x 14.3in.)

Statement (140 x 216 mm, 5.5 x 8.5 in.)
Executive (184 x 267 mm, 7.25x 10.5in.)
Letter (216 x 279 mm, 8.5x 11in.)

US Folio (216 x 330 mm, 8.5x 13 in.)
Legal (216 x 356 mm, 8.5 x 14 in.)
Tabloid (279 x 432 mm, 11 x 17 in.)

In addition to the standard sizes, you can use custom-size paper within the following ranges for 2-sided printing:

e Minimum size 125 x 138 mm (4.9 x 5.4 in.)
e  Maximum size 297 x 432 mm (11.7 x 17 in.)

Paper weights from 50 g/m? through 160 g/m? can be used for automatic 2-sided printing.

f Note: Do not use transparencies, envelopes, labels, or reloaded paper for automatic 2-sided printing.

SUPPORTED PAPER SIZES FOR THE ENVELOPE TRAY

EUROPEAN STANDARD SIZES

NORTH AMERICAN STANDARD SIZES

DL (110 x 220 mm, 4.33 x 8.66 in.)
C6 (114 x 162 mm, 4.5x 6.38in.)
C5(162x 229 mm, 6.4 x9in.)

Monarch (98 x 190 mm, 3.9 x 7.5 in.)
No.9 (98 x 225 mm, 3.9 x 8.9 in.)
No. 10 (105 x 241 mm, 4.1 x 9.5 in.)
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SUPPORTED CUSTOM PAPER SIZES

TRAY NUMBER PAPER SIZES

Trays 1 and 2

Minimum: 139 x 210 mm (5.5 x 8.3 in.)
Maximum: 297 x 432 mm (11.7 x 17 in.)

Trays 3 and 4

A4 (210 x 297 mm, 8.3 x 11.7 in.)
or Letter (216 x 279 mm, 8.5x 11 in.)

Tray 5 Minimum: 105 x 135 mm (4.25 x 5.3in.)
Maximum: 297 x 432 mm (11.7 x 17 in.)
C5 envelopes only

Tray 6 A4 (210 x 297 mm, 8.3 x 11.7 in.) or Letter (216 x 279
mm, 85 x 11 in.)
With narrow SEF kit: A4 (210 x 297 mm, 8.3 x 11.7 in.),
Letter (216 x 279 mm, 8.5 x 11 in.), or Legal (216 x
356 mm, 8.5 x 14 in.), short-edge feed
With wide SEF kit: A3 (297 x 420 mm, 11.7 x 16.5in.)
or Tabloid (279 x 432 mm, 11 x 17 in.), short-edge
feed

Tray 7 A4 (210 x 297 mm, 8.3 x 11.7 in.) or Letter (216 x 279

mm, 8.5x 11 in.)
US Folio (216 x 330 mm, 8.5 x 13in.)
Legal (216 x 356 mm, 8.5 x 14 in.)

A3 (297 x 420 mm, 11.7 x 16.5in.) or Tabloid (279 x
432 mm, 11 x17in.)
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Paper Tray Settings

CONFIGURING TRAY SETTINGS

The system administrator can set Trays 1 and 2 to Fully Adjustable or Dedicated mode. When a paper tray is set to
Fully Adjustable mode, you can change paper settings each time that you load the tray. When a paper tray is set to
Dedicated mode, the control panel prompts you to load a specific paper size, type and color.

To configure the tray settings:
1. At the printer control panel, touch Device.
2. Touch Tools, then touch Device Settings > Paper Management.
3. Touch Tray Settings, then select a tray.
e To set the mode, touch Fully Adjustable or Dedicated.

e To specify the paper settings for a dedicated tray, touch Edit, then set the paper size, type, and color. Touch
OK.

e To configure the printer to select the tray automatically, for Auto Selection, touch Enabled.

e To set the priority for each tray, touch the number field. To enter a number, use the alphanumeric keypad,
or touch plus icon ( +) or the minus icon ( -). The printer uses paper from the Priority 1 tray first. If that tray
is empty, the printer uses paper from the Priority 2 tray.

4, Touch OK.
5. To close Tray Settings, touch X.

6. To close Tools, touch X.

f Note: To access the Paper Management menu, log in as the system administrator. For details, referto the
System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

CHANGING PAPER SIZE, TYPE, AND COLOR

When a paper tray is set to Fully Adjustable mode, you can change paper settings each time that you load the tray.
When you close the tray, the control panel prompts you to set the paper size, type, and color of paper loaded.

When a paper tray is set to Dedicated mode, the control panel prompts you to load a specific paper size, type, and
color. If you move the guides to load a different paper size, the control panel displays an error message.

To configure the tray settings for Fully Adjustable or Dedicated mode, refer to Configuring Tray Settings.
To set the paper size, type, or color when a tray is set to Fully Adjustable:
1. Open the paper tray, then load the required paper.
2. Close the tray.
3. At the control panel, select the correct paper size, type, and color:
e To select a new paper size, touch Size.
e To select a new paper type, touch Type.

e To select a new paper color, touch Color.
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4. To confirm the settings, touch Confirm.
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Loading Paper

LOADING PAPER IN TRAYS 1 AND 2

The system administrator can configure Trays 1 and 2 to Fully Adjustable or Dedicated mode. Each time a tray is
opened and closed, the paper settings appear on the control panel:

e The Fully Adjustable mode allows you to confirm or change the media settings. The tray guides automatically
detect the size of paper loaded.

e When the Dedicated mode is configured, the control panel displays the media settings for the tray. If the wrong
media is loaded, or the paper tray guides are set incorrectly, a warning message appears on the control panel.

j’ Note: Only the system administrator can change the media settings for a Dedicated tray.

When the paper in a tray is in short supply, or when a tray is empty, a warning message appears on the control
panel.

To load paper in Trays 1 and 2:

1. Pull out the tray until it stops.

2. Ensure that the paper guides are set in the correct position for the paper that you are loading. For details, refer
to Adjusting the Paper Guides in Trays 1 and 2.

3. Remove any paper that is a different size or type.

4. To move out the length or width paper guides, release the guide lock, then slide out the length or width paper
guides.
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5. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This
procedure separates any sheets that are stuck together and reduces the possibility of jams.

w2
/ Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to use it.
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6. Load paper in the tray. Position the paper against the left side of the tray.

e For long-edge feed, insert letterhead and pre-printed paper face down with the top edge toward the front
of the tray. Load hole-punched paper with the holes to the left.

e Load labels face up with the top edge toward the front of the tray.

e Load paper-backed transparencies face up in the tray. Load striped transparencies with the stripe face down
on the left edge of the tray.

f Note: Load transparencies in Tray 2 only.

/N

7 -

e For short-edge feed, insert letterhead and pre-printed paper face down with the top edge to the left. Load
hole-punched paper with the holes toward the rear of the printer.

WAV %
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7. Adjust the length and width paper guides until they touch the edges of the paper.

e

9. At the control panel, if a prompt appears, select the correct paper size, type, and color.

e To select a new paper size, touch Size.

e To select a new paper type, touch Type. For letterhead paper, select Letterhead. For pre-printed paper,
select Pre-Printed. For hole-punched paper, select Hole Punched. For index or covers, select Cardstock.

e To select a new paper color, touch Color.

j’ Note: If a prompt does not appear, and you have changed the paper size, type, or color, update the
Required Paper Policies. For details, refer to the System Administrator Guide at www.xerox.com/support/

ALB80OXXdocs.

10. To confirm the settings, touch Confirm.

j’ Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring Tray
Settings.

ADJUSTING THE PAPER GUIDES IN TRAYS 1 AND 2

You can adjust the guides in Trays 1 and 2 to accommodate standard or custom paper size papers. In the standard
position, the guides move into the supported standard paper settings. In the custom position, the guides move in 1

mm (0.04 in.) increments.

To move the paper guides from the standard to the custom paper size position:
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1. Pull out the tray until it stops.

2. To expand the length or width paper guide, release the guide lock, then slide out the length or width paper
guide until it stops.

3. Load the custom-size paper in the tray.

4. To engage the fine-adjustment block, release the guide lock, then slide in the length or width paper guide. The
paper guides move in increments of Tmm (0.04 in.).

5. Adjust the length and width paper guides until they touch the edges of the paper.
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LOADING PAPER IN TRAYS 3 AND 4

Trays 3 and 4 are high-capacity paper trays. They are set as dedicated trays and hold A4-size (210 x 297 mm) or
Letter-size (8.5 x 11 in.) paper only. Tray 3 holds 1600 sheets of paper. Tray 4 holds 2000 sheets of paper.

The control panel displays a warning message when the paper in the tray is in short supply, or when a tray is empty.
To change the paper size, refer to Configuring Trays 3 and 4.

To load paper in Trays 3 and 4:
1. Pull out Tray 3 or Tray 4 until it stops. Wait for the tray to lower and stop.
2. The control panel displays the paper tray settings. Ensure that you load the correct paper type.

f Note: Do not load custom-size paper into Trays 3 or 4.

3. Fan the edges of the paper before loading it into the paper trays. This procedure separates any sheets of paper
that are stuck together and reduces the possibility of paper jams.

f Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary.

4. Stack the paper against the left rear corner of the tray as shown.

e Insert letterhead and pre-printed paper face down with the top edge toward the front of the tray.

e Load hole-punched paper with the holes to the left.
f Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.

5. Close the tray.
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LOADING PAPER IN TRAY 5

Tray 5 is located on the left side of the printer. You can close the tray when it is not in use. You can use the tray for
small jobs or for jobs that use special media such as labels, transparencies, and envelopes.

When the printer detects media in Tray 5, the control panel displays the paper settings for the tray. Confirm or
change the settings for the media that is loaded in the tray.

_yQ Note: Ensure that you select the correct media type for the paper that is loaded in the tray. The printer
detects different types of media as each page travels through the paper path. If a paper-type setting does
not match the paper type loaded in the printer, the job stops printing.

To load paper in Tray 5:

1. Open Tray 5, then for larger paper sizes, pull out the extension tray. Remove any paper that is a different size or
type.

2. Move the width guides to the edges of the tray.
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3. Load the paper in the tray.
For long-edge feed, insert letterhead and pre-printed paper face up with the top edge toward the front of
the tray. Load hole-punched paper with the holes to the right.

e Load labels face down, long-edge or short-edge feed.

Load plain transparencies face down with the long edge leading into the printer. Load striped
transparencies with the stripe face up on the edge leading into the printer.

j’ Note: Do not load paper-backed transparencies in Tray 5.

For short-edge feed, insert letterhead and pre-printed paper face up with the top edge leading into the
printer. Load hole-punched paper with the holes toward the rear of the printer.

fo Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.
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4. Adjust the width guides until they touch the edges of the paper.

5. At the control panel, select the correct paper size, type, and color:
e To select a new paper size, touch Size.

e Toselect a new paper type, touch Type. For letterhead paper, select Letterhead. For pre-printed paper,
select Pre-Printed. For hole-punched paper, select Hole Punched.

e Toselect a new paper color, touch Color.

6. To confirm the settings, touch Confirm.

LOADING PAPER IN TRAY 6

Tray 6 is an optional, high-capacity, dedicated paper tray. It is on the left side of the printer. The basic
configuration holds only A4-size (210 x 297 mm) or Letter-size (8.5 x 11 in.) paper. The tray capacity is 3300 sheets.

f Note:
e If the narrow short-edge feed conversion kit is installed, the tray feeds A4-size (210 x 297 mm), Letter-
size (8.5x 11 in.) or Legal-size (8.5 x 14 in.) paper.

e If the wide short-edge feed conversion kit is installed, the tray feeds A3-size (297 x 420 mm) or Tabloid-
size (11 x 17 in.) paper.

e The tray has a capacity of 1250 sheets when either of the conversion kits are installed.

e The Tray 6 conversion kits are not supported on all printers. For more information, refer to Printer
Configurations and Options.

The control panel displays a warning message when the paper in the tray is in short supply, or when the tray is
empty.

To change the paper size, refer to Configuring Tray 6.
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1. Open the door to Tray 6.

2. Wait for the tray to lower and stop.

j’ Note: When a conversion kit is installed, the door to Tray 6 is absent. Press the white button on the right side
of the door frame to lower and raise the paper tray.

3. The control panel displays the paper tray settings. Ensure that you load the correct paper type into the tray.
j’ Note: Do not load custom-size paper into Tray 6.

4. Fan the edges of the paper before loading it into the paper trays. This procedure separates any sheets of paper
that are stuck together and reduces the possibility of paper jams.

j’ Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary.
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5. Load the paper against the right side of the tray:
e Place letterhead or pre-printed paper face up with the top edge toward the front of the tray.
e Place hole-punched paper with the holes toward the right side of the tray.

fo Note: Do not load paper above the maxiumum fill line. Overfilling can cause paper jams.

6. Close the tray door.

LOADING PAPER IN TRAY 7

Tray 7 is an optional paper tray that you can use with the High-Volume Finisher. Use Tray 7 to add, or insert, post-
process sheets into your print jobs. Tray 7 provides a convenient and efficient way to add pre-printed covers or
inserts to a copy job.

Load A4-size (210 x 297 mm) paper or Letter-size (8.5 x 11 in.) paper long-edge or short-edge feed. Load larger
paper sizes with the short edge leading into the printer.

j’ Note: Pre-cut tabs are not supported.

The labels on the tray show orientation of media in the automatic document feeder and Tray 7.
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1. Load paper in Tray 7 in the correct orientation for the job:

e For long-edge feed, load original documents face up in the automatic document feeder.

fo Note: To insert special pages into the job, in Tray 7, load the pages face up and rotated 180 degrees from
the pages in the automatic document feeder.

e For short-edge feed, load original documents with landscape content face up in the automatic document
feeder.

fo Note: To insert special pages into the job, in Tray 7, load the pages face up and rotated 180 degrees from
the pages in the automatic document feeder.
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e For short-edge feed, load original documents with portrait content face up in the automatic document
feeder.

fo Note: To insert special pages into the job, in Tray 7, load the pages face up and rotated 180 degrees from
the pages in the automatic document feeder.

2. Adjust the width guides until they touch the edges of the paper.

j’ Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.
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Printing on Special Paper

To order paper or other media, contact your local reseller or visit www.xerox.com/supplies.
For reference:

e www.xerox.com/rmlna Recommended Media List (United States)

e www.xerox.com/rmleu Recommended Media List (Europe)

ENVELOPES

You can print C5 envelopes from Tray 5. If the optional Envelope Tray is installed, you can print a range of envelope
sizes from Tray 2.

Envelopes must have a body length of greater than 135 mm (5.3 inches), with the flap closed, to be run from the
bypass tray. Any envelope with a body length of 135 mm (5.3 inches) or less requires the optional Envelope Tray Kit
to feed envelopes from tray 2. For example, number 10 envelopes and DL (Dimensions Lengthwise) envelopes
require the Envelope Tray Kit.

Guidelines for Printing Envelopes
e Use only paper envelopes.
¢ Do not use envelopes with windows or metal clasps.

e Print quality depends on the quality and construction of the envelopes. If you do not get the desired results, try
another envelope brand.

e Maintain constant temperatures and relative humidity.

e Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect print quality
and cause wrinkling. Excessive moisture can cause the envelopes to seal before or during printing.

e Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book on top of
them.

e In the print driver software, select Envelope as the paper type.
e Do not use padded envelopes. Use envelopes that lie flat on a surface.
e Do not use envelopes with heat activated glue.

e Do not use envelopes with press and seal flaps.

Loading Envelopes in Tray 5

To print envelopes from the bypass tray, envelopes must have a body length greater than 135 mm (5.3 in.) with the
flap closed. Any envelope with a body length of 135 or fewer mm (5.3 or fewer in.) requires the optional Envelope
Tray Kit to feed envelopes from tray 2. For example, number 10 envelopes and DL (Dimensions Lengthwise)
envelopes require the Envelope Tray Kit.
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1. Open tray 5. For larger envelopes, pull out the extension tray. Remove any paper or envelopes that are a
different size or type.

2.
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3. Load envelopes into the tray.
j’ Note: Load C5 envelopes only into the tray.

e For envelopes with the flap on a long edge, load the envelopes face down with the flaps open, and the flaps
on the leading edge, toward the left.

e For envelopes with the flap on a short edge, load the envelopes face down with the flaps closed, and the
flaps toward the front of the printer.

4. Center the stack of envelopes, then slide the paper guides until they lightly touch the edges of the envelopes.
5. Ensure that there are no more than 20 envelopes loaded in the tray.
6. At the control panel, select the correct paper size and color:

e Ensure that the paper size is set to C5 Envelope. To select a new paper size, touch Size.

e To select a new paper color, touch Color.

j’ Note: When the paper size is set to C5 Envelope, the paper type defaults to Envelope.

7. To confirm the settings, touch Confirm.

186 Xerox® AltaLink® B80XX Series Multifunction Printer User Guide



Paper and Media

Loading the Envelope Tray

You can use the optional Envelope Tray in place of tray 2. The Envelope Tray is a dedicated tray and holds the
following envelope sizes:

e Monarch, No. 9, and No.10
e DL, C6,and C5
To load envelopes:

1. Pull out the Envelope Tray until it stops.
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2. Load envelopes in the tray.

e For DL, Monarch, No. 9, No. 10, C5, and C6 envelopes with the flap on a long edge, load the envelopes face
up with the flaps open, and the flaps toward the right.

e For C5 envelopes with the flap on a short edge, load the envelopes face up with the flaps closed, and the
flaps toward the front of the printer.

‘&Q Note: Do not load custom-sized envelopes in the Envelope Tray.
3. Adjust the paper guides so that they rest lightly against the edges of the envelopes.

4. Ensure that the maximum fill line is visible or that there are no more than 50 envelopes loaded in the tray.

5. Close the tray.
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6. At the control panel, if a prompt appears, select the correct envelope size and color.

e To select a new envelope size, touch Size.

e To select a new envelope color, touch Color.
¢ Note:

e If a prompt does not appear and you have changed the envelope size or color, update the Required
Paper Policies. For details, refer to the System Administrator Guide at www.xerox.com/support/
ALB80XXdocs.

e When the Envelope Tray is installed, the paper type is set to Envelope.

7. To confirm the settings, touch Confirm.

LABELS

You can print labels from Tray 1, Tray 2, and Tray 5.

To print labels from Trays 1 and 2, refer to Loading Paper in Trays 1 and 2.

Guidelines for Printing Labels

Use labels designed for laser printing.

Do not use vinyl labels.

Do not feed a sheet of labels through the printer more than once.

Do not use dry gum labels.

Print only on one side of the sheet of labels. Use full sheet labels only.

Store unused labels flat in their original packaging. Leave the sheets of labels inside the original packaging until
ready to use. Return any unused sheets of labels to the original packaging and reseal it.

Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing them in
extreme conditions can cause print-quality problems or cause them to jam in the printer.

Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and jam in the
printer.

In the print driver software, select Label as the paper type.

Before loading labels, remove all other paper from the tray.

(D Caution: Do not use any sheet where labels are missing, curled, or pulled away from the backing sheet.
It could damage the printer.
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Loading Labels in Tray 5

1. Open Tray 5, then for larger sizes of paper, pull out the extension tray. Remove any paper that is a different size
or type.
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3. Load labels in the tray.

For long-edge feed, load labels face down with the top edge toward the front of the printer:

fo Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.

4. Adjust the width guides until they touch the edges of the paper.

5. At the control panel, select the correct paper size, type, and color:
e Ensure that the paper type is set to Labels. To select a new paper type, touch Type.
e Toselect a new paper size, touch Size.
e Toselect a new paper color, touch Color.

6. To confirm the settings, touch Confirm.
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GLOSSY MEDIA

You can print glossy media, up to 200 g/m 2, from any tray. You can print heavyweight glossy media from Tray 5
only.

Guidelines for Printing on Glossy Paper

e Do not open sealed packages of glossy paper until you are ready to load them into the printer.

e Leave glossy paper in the original wrapper, and leave the packages in the shipping carton until ready to use.
e Remove all other paper from the tray before loading glossy paper.

e Load only the amount of glossy paper that you are planning to use. Do not leave glossy paper in the tray when
you are finished printing. Reinsert unused paper in the original wrapper and seal.

e Rotate paper frequently. Long periods of storage in extreme conditions can cause glossy paper to curl and jam
in the printer.

e In the print driver software, select the desired glossy paper type or select the tray loaded with the desired paper.

Loading Gloss Paper in the Bypass Tray
1. Before you load glossy paper, remove all other paper from the tray.
Load only the amount of paper you plan to use.

Load the paper with the glossy side or print side down.

&wN

At the control panel, select the correct paper size, type, and color:

e Ensure that the paper type is set to Glossy. To select a new paper type, touch Type.
e To select a new paper size, touch Size.

e To select a new paper color, touch Color.

5. To confirm the settings, touch Confirm.

TRANSPARENCIES

You can print transparencies from Tray 2 and Tray 5:
e Load clear transparencies in Tray 2 or Tray 5.

e Load striped transparencies in Tray 2 or Tray 5.

e Load paper-backed transparencies in Tray 2 only.

For best results, use only recommended Xerox® transparencies.

(D Caution: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not cover
damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction Guarantee is
available in the United States and Canada. Coverage could vary outside these areas. Please contact your
local representative for details.
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Guidelines for Printing on Transparencies

e Before you load transparencies in the tray, remove all paper.

e Handle transparencies by the edges using both hands. Fingerprints or creases can cause poor print quality.
e Do not load more than 20 transparencies. Overloading the tray can cause the printer to jam.

e Load clear or non-strip transparencies face down.

o Do not fan transparencies.

e On the control panel, ensure that you change the paper type to Transparency.

o In the print driver software, for paper type, select Transparency.
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General Precautions

& Warning:

Internal parts of the printer can be hot. Use caution when doors and covers are open.
Keep all cleaning materials out of the reach of children.

Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays contain
explosive mixtures and are not suitable for use in electrical applications. Use of pressurized spray
cleaners increases the risk of fire and explosion.

Do not remove the covers or guards that are fastened with screws. You cannot maintain or service any
parts that are behind these covers and guards. Do not attempt any maintenance procedure that is not
described in the documentation supplied with your printer.

(D Caution:
L
e When cleaning your printer do not use organic or strong chemical solvents or aerosol cleaners. Do not
pour fluids directly into any area. Use supplies and cleaning materials only as directed in this
documentation.
e Do not place anything on top of the printer.
e Do not leave the covers and doors open for any length of time, especially in well-lighted places. Light
exposure can damage the drum cartridges.
e Do not open covers and doors during printing.
e Do not tilt the printer while it is in use.
e Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print
quality to deteriorate.
e Ensure that any parts removed during cleaning are replaced before you plug in the printer.
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Cleaning the Printer

CLEANING THE PRINTER EXTERIOR
Regular cleaning keeps the touch screen and control panel free from dust and dirt.

To clean the printer exterior:

1. To avoid activating buttons and menus, press the Power/Wakebutton, then touch Sleep.

3. To return the printer to Ready mode, press the Power/Wake button.

4. Use a soft, lint-free cloth to clean the outside of the output tray, paper trays, and other exterior areas of your
printer.
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Cleaning the Scanner

To ensure optimum print quality, clean the document glass regularly. Cleaning helps avoid output with streaks,
smears, and other marks that transfer from the glass while scanning documents.

1. Slightly dampen a soft, lint-free cloth with water.
Remove any paper or other media from the output tray.

Open the document cover.

= oW N

Wipe the surfaces of the document glass and CVT (Constant Velocity Transport) glass until they are clean and
dry.

j’ Note: For best results, use Xerox® Glass Cleaner to remove marks and streaks.

6. Close the document cover.

Cleaning the Document Feed Rollers

Dirt on the document feed rollers can cause paper jams or deteriorate print quality. For best performance, clean the
document feed rollers once a month.
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1. Open the top cover of the document feeder.

2. While turning the rollers, wipe them with a clean, lint-free cloth moistened with water.

@ Caution: Do not use alcohol or chemical cleaners on the document feed rollers.

3. Close the document feeder top cover.
CLEANING THE PRINTER INTERIOR

Cleaning the Print Head

The LED printhead requires regular cleaning to maintain print quality. Clean the printhead every time that you
replace the toner cartridge or if print quality starts to degrade.

& Warning: Do not perform this procedure when the printer is copying or printing.
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1. Open the front door of the printer.

2. Rotate the orange print cartridge locking lever counterclockwise until it clicks. The lever is to the right of the
print cartridge unit.

3. Locate the blue handle at the top right of the print cartridge. Pull out the print cartridge about 40 cm or 16 in,,
until it stops.

4. To clean the printhead, push the blue handle gently back into the printer.

5. Pull the blue handle out of the printer and push it in again two more times.
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6. To latch the print cartridge and printhead cleaning tool in place, rotate the orange print cartridge locking lever
clockwise.
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Supplies

CONSUMABLES

Consumables are printer supplies that become depleted during the operation of the printer. Consumable supplies
for this printer include the following:

e Genuine Xerox® Black Toner Cartridge
e Staple Cartridges for the Optional Office Finisher or Office Finisher with Booklet Maker

e Staple Cartridges for the Optional High Volume Finisher, High Volume Finisher with Booklet Maker or High
Volume Finisher with Booklet Maker and C/Z folder

f Note:

e Each consumable includes installation instructions. To replace consumables, refer to the instructions
included with the consumable supply.

e Only install new cartridges in your printer. If a used toner cartridge is installed, then the toner-remaining
amount displayed can be inaccurate.

e To ensure print quality, the toner cartridge is designed to cease functioning at a predetermined point.

(D Caution: Use of toner other than genuine Xerox® Toner can affect print quality and printer reliability.
Xerox® Toner is the only toner designed and manufactured under strict quality controls by Xerox for
specific use with this printer.

ROUTINE MAINTENANCE ITEMS

Routine maintenance items are printer parts that have a limited life and require periodic replacement.
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable.

j’ Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:
e Print Cartridge

e Fuser Module

e Transfer Roller

e Hole-Punch Waste Container
ORDERING SUPPLIES

When to Order Supplies

A warning appears on the control panel when supplies near their replacement time. Verify that you have
replacements on hand. It is important to order these items when the messages first appear to avoid interruptions to
your printing. An error message appears on the control panel when supplies must be replaced.
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Order supplies from your local reseller or go to www.xerox.com/supplies.

(D Caution: Use of non-Xerox supplies is not recommended. The Xerox® Warranty and Service Agreement
do not cover damage, malfunction, or degradation of performance caused by the use of non-Xerox
supplies, or the use of Xerox supplies not specified for this printer.

Supply Status

You can check the status and percentage of life remaining for your printer supplies at the control panel or from the
Embedded Web Server. When printer supplies near the time for replacement, warning alerts can appear on the
control panel, depending on the printer alerts setting.

You can customize the alerts that appear on the control panel and configure email alert notifications using the
Embedded Web Server.

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System Administrator
Guide at www.xerox.com/support/ALB80XXdocs.

To check the supplies status at the control panel:
1. At the printer control panel, press the Home button.
2. To view status information for the printer supplies, touch DeviceSupplies.

3. To view more details about a specific item, including the part number for reordering, touch Toner Cartridge,
Print Cartridge, Fuser Module, or Transfer Roller.

4. To return to the Supplies screen, touch X.
5. To return to the Device screen, touch X.

6. To return to the Home screen, touch Home.
TONER CARTRIDGES

General Precautions

& Warning:

e When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid contact with
clothes, skin, eyes, and mouth. Do not inhale the toner dust.

e Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, have the child
spit out the toner, and rinse the mouth with water. Consult a physician immediately.

e Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills. Electric sparks
inside the vacuum cleaner can cause a fire or explosion. If you spill a large volume of toner, contact
your local Xerox representative.

e Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can catch fire and
cause burn injuries or an explosion.
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Replacing a Toner Cartridge
A message appears on the control panel when a toner cartridge must be replaced.
When replacing the toner cartridge, clean the LED print head. For details, refer to Cleaning the Print Head.

Note: Each toner cartridge includes installation instructions.

PRINTER STATUS MESSAGE CAUSE AND SOLUTION

Reorder Toner The toner cartridge is low. Order a new toner cartridge.

Out of Toner The toner cartridge is empty. Replace the toner
cartridge with a new one.

To replace the toner cartridge:

1. Open the front door of the printer.
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3. Pull the toner cartridge straight out of the printer.

4. Remove the new toner cartridge from the packaging. Tilt the cartridge up and down, then left and right 10
times.

5. Push the new toner cartridge into the printer slowly until it stops.
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7. Close the front door of the printer.

8. To confirm that you have replaced the toner cartridge, at the Replace Toner Cartridge (R1) screen, touch Yes.

PRINT CARTRIDGE

General Precautions

& Warning: When replacing consumables do NOT remove the covers or guards that are fastened with
screws. You cannot maintain or service any of the parts that are behind these covers and guards. Do NOT
attempt any maintenance procedure that is NOT specifically described in the documentation supplied with
your device.

& Warning: Keep print cartridges upright, to avoid spillage, and do not place on unprotected surfaces.

Replacing a Print Cartridge

A message appears on the control panel when a print cartridge must be replaced.

f Note: Each print cartridge includes installation instructions.

PRINTER STATUS MESSAGE CAUSE AND SOLUTION

Reorder Print Cartridge The print cartridge is nearing the end of its life. Order a
new print cartridge.

Replace Print Cartridge The print cartridge has reached the end of its life.
Replace the print cartridge with a new one.

To replace the print cartridge:
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1. Open the front door of the printer.

3. Rotate the orange print cartridge locking lever counterclockwise until it clicks. The lever is to the right of the
print cartridge unit.
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4. Unpack the new print cartridge.

5. Lift the orange cartridge handle slightly and pull the cartridge half out of the printer.

6. Lift the carrying handle on the top of the cartridge and use it to support the weight while you remove the
cartridge from the printer.

7. Place the used print cartridge in the plastic bag that shipped with the new cartridge, then seal the bag. Place
the sealed bag in the box in which the new cartridge was shipped.

8. Tilt the new print cartridge up and down, then left and right 10 times.
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9. Lift the orange handle on top of the new print cartridge, then insert the new cartridge into the printer.

11.  Close the left side door of the printer.

Xerox® AltaLink® B80XX Series Multifunction Printer User Guide 209



Maintenance

12.  Close the front door of the printer.

fo Note: If you are prompted to confirm that the toner cartridge has been replaced, touch No.

REPLACING STAPLE CARTRIDGES

If the printer has any of the following optional devices installed, the control panel displays a message when a staple
cartridge is empty and needs replacement:

e Office Finisher

e Office Finisher with Booklet Maker

e High Volume Finisher

e High Volume Finisher with Booklet Maker

Replacing Staples in the Office Finisher

& Warning: Do not perform this procedure when the printer is copying or printing.

Replacing Staples in the Main Stapler of the Office Finisher

1. Open the finisher door.

2. Locate the staple cartridge unit.

3. To access the staple cartridge unit, turn the green staple-head movement wheel fully clockwise.
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4. To remove the staple cartridge, grasp the orange tab and pull it firmly toward you.

5. Unpack a new staple cartridge.
6. Toinsert the staple cartridge, push the cartridge into the staple cartridge unit until it clicks into place.

7. Rotate the staple-head movement wheel counterclockwise, until it is back in position.

8. Close the finisher door.
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Replacing Staples in the Booklet Maker for the Office Finisher

1. Open the finisher door.

2. Locate the staple cartridges in the upper left part of the cavity at the bottom of the unit.

3. Toremove a staple cartridge, pull the orange tab on the cartridge to the right and then down.

4. Unpack a new staple cartridge.

5. Toinsert a staple cartridge, push the cartridge up and then to the left, until it clicks into place.

6. Repeat the procedure for the other booklet maker staple cartridge.
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7. Close the finisher door.

Replacing Staples in the High Volume Finisher

& Warning: Do not perform this procedure when the printer is copying or printing.

Replacing Staples in the Main Stapler of the High Volume Finisher

1. Open the finisher door.

2. Locate the staple cartridge unit to the right of green tabs labeled 5b and 5c.

3. Toremove the staple cartridge, gently lift the orange tab, then pull out the staple cartridge.

4. Unpack a new staple cartridge.
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5. Toinsert the staple cartridge, push the cartridge in and then down, until it clicks into place.

6. Close the finisher door.

Replacing Staples in the Booklet Maker for the High Volume Finisher

1. Open the finisher door.
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3. To access the staple cartridge unit, pull down the green tab.

4. To remove a staple cartridge, grip the cartridge, then pull it out of the staple cartridge unit.

5. Unpack a new staple cartridge.

6. Toinsert a staple cartridge, push the staple cartridge into the staple cartridge unit until it clicks into place.

7. Repeat the procedure for the other booklet maker staple cartridge.

8. To close the staple cartridge unit, push the green tab up.

9. Using the handle labeled 6b, push the booklet maker into the finisher.
10.  Close the finisher door.

Replacing Staples in the Convenience Stapler

1. Lift the lever at the rear of the convenience stapler, then gently rotate the staple head toward you.
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2. Grip the staple cartridge and pull it out of the stapler head.

3. Unpack the new staple cartridge. Remove any partial strips and any staple strips that are not flat.
4. Install the new staple cartridge in the convenience stapler. The staple cartridge clicks into place.

5. Release the lever at the front of the convenience stapler, then gently rotate the staple head away from you.

EMPTYING THE HOLE-PUNCH WASTE CONTAINER

If the printer has the optional Office Finisher or High Volume Finisher installed, the control panel displays a
message when the hole-punch waste container is full.

A Warning: Do not perform this procedure when the printer is copying or printing.

Emptying the Hole-Punch Waste Container in the Office Finisher

1. Open the finisher door.
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2. Slide the hole-punch waste container out of the finisher.

3. Dispose of the waste.

4. Slide the emptied hole-punch waste container back into the finisher.

5. Close the finisher door.

Emptying the Hole-Punch Waste Container in the High Volume Finisher
1. Open the finisher door.
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2. Slide the hole-punch waste container out of the finisher.

N

3. Dispose of the waste.

4. Slide the emptied hole-punch waste container back into the finisher.

5. Close the finisher door.

FUSER MODULE

General Precautions

& Warning: When replacing consumables do NOT remove the covers or guards that are fastened with
screws. You cannot maintain or service any of the parts that are behind these covers and guards. Do NOT
attempt any maintenance procedure that is NOT specifically described in the documentation supplied with

your device.
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Replacing the Fuser Module
A Low Supply Warning message may appear on the control panel when the fuser module is nearing end of life.

If print output shows smears of toner, check the percentage of remaining life for the fuser module. Replace the
fuser module when the percentage of remaining life is less than 20 percent. For details, refer to Supply Status.

f Note: Each fuser module includes installation instructions.
To replace the fuser:

1. Power off the printer, then disconnect the power cord from the printer.

2. Remove any paper from Tray 5. Open the left side door of the printer, then wait for 5 minutes.

& Warning: The area around the fuser can be hot. Use caution to avoid injury.

3. Locate the fuser module, labeled R3, in the side of the printer.

4. To release the fuser module, rotate the orange thumbscrews counterclockwise. The thumbscrews are at each
end of the fuser module.
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5. Pull out the used fuser module.

6. Unpack the new fuser module. Retain the packaging.

7. Insert the new fuser module as shown.

9. Place the used fuser module in the packaging that shipped with the new fuser module.

10. Close the left side door of the printer. Reconnect the printer to the power cord, then power on the printer.
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TRANSFER ROLLER

General Precautions

& Warning: When replacing consumables do NOT remove the covers or guards that are fastened with
screws. You cannot maintain or service any of the parts that are behind these covers and guards. Do NOT
attempt any maintenance procedure that is NOT specifically described in the documentation supplied with
your device.

Replacing the Transfer Roller
A Low Supply Warning message may appear on the control panel when the transfer roller is nearing end of life.

If ghosting appears in printed output, check the percentage of remaining life for the transfer roller. Replace the
transfer roller when the percentage of remaining life is less than 20 percent. For details, refer to Supply Status.

f Note: Each transfer roller includes installation instructions.

To replace the transfer roller:
1. Power off the printer, then disconnect the power cord from the printer.
2. Remove any paper from Tray 5.

3. Open the left side door of the printer.

& Warning: The area around the fuser can be hot. Use caution to avoid injury.

4, Locate the transfer roller, labeled R4, in the printer side door.
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5. To remove the used transfer roller, squeeze the orange tabs at both ends of the transfer roller, then lift the
transfer roller out of the printer.

‘&Q Note: Do not touch any toner adhering to the transfer roller.
6. Unpack the new transfer roller. Retain the packaging.

7. Toinstall the new transfer roller, position the transfer roller in the side door as shown. Squeeze the orange tabs
at both ends of the transfer roller, then press down gently, until it clicks into place.

8. Place the used transfer roller in the packaging that shipped with the new transfer roller.

9. Close the left side door of the printer.

10. Reconnect the printer to the power cord, then power on the printer.
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Resetting Supply Life Counters
You must reset the supply life counters when you replace some supplies.
1. At the printer control panel, press the Home button.

2. Touch the Log In button, enter the system administrator login information, then touch Done. For details, refer
to the System Administrator Guide at www.xerox.com/support/ALB80XXdocs.

Touch Device > Tools > Device Settings > Supplies.

Touch Supply Counter Reset.

To select an item to reset, touch the supply item in the list, then touch Reset Counter.
On the confirmation screen, touch Reset.

To return to the Tools screen, touch X, then touch X again.

To return to the Home screen, press the Home button.

© 0 N o v W

Touch the Log In button, then touch Logout.

RECYCLING SUPPLIES

For more information on the Xerox® supplies recycling program, go to www.xerox.com/recycling.
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Managing the Printer

VIEWING THE METER READING

The Billing/Usage menu displays the total number of impressions that the printer generated or printed during its
lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper. For example, a sheet of
paper that is printed on two sides counts as two impressions.

j’ Note: If you provide regular billing information for your device, you can use the Remote Services Upload
feature to simplify the process. You can enable Remote Services to send billing meter readings to Xerox
automatically so that you do not have to collect the readings manually. Refer to the System Administrator
Guide for further information.

To view the billing information for your printer:

1. At the printer control panel, press the Home button.

Touch Device > Billing/Usage.

To view more details, touch Usage Counters, then select an option.

After viewing the usage readings, to return to the Device screen touch X, then touch X again.

v W N

To return to the Home screen, press the Home button.

PRINTING THE BILLING SUMMARY REPORT

The Billing Summary Report provides information about the device and a detailed listing of the billing meters and
sheet counts.

To print the Billing Summary Report:
1. At the printer control panel, press the Home button.
Touch Device > Information Pages.

Touch Billing Summary, then touch Print.

& W N

To return to the Home screen, press the Home button.
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Moving the Printer

Before you move the printer:

o Ensure that you always power off the printer and wait for it to shut down completely.
e Ensure that no jobs are in the print queue.

e Disconnect the power cord and other cables from the back of the printer.

e Unlock the printer casters.

A Warning: To prevent electric shock, never touch the power plug with wet hands. When removing the
power cord, ensure that you pull the plug and not the cord. Pulling the cord can damage it, which can lead
to fire or electric shock.

f Note:

e When moving the printer, do not tilt it more than 10 degrees in any direction. Tilting the printer more
than 10 degrees can cause toner spillage.

e When moving the printer over a long distance, remove the print cartridge and toner cartridges to prevent
toner from spilling. Ensure that the printer is protected with appropriate packaging. For assistance,
contact your Xerox representative.

(D Caution: Do not expose the print cartridge to direct sunlight or strong indoor fluorescent lighting. Do not
touch or scratch the surface of the print cartridge.

(D Caution: Failure to repackage the printer properly for shipment can result in damage not covered by the
Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty, Service
Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by improper
moving.

After you move the printer:
1. Reinstall any parts that you removed.
Reconnect the printer to the cables and power cord.

Plug in and power on the printer.

& W N

Lock the printer casters.
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General Troubleshooting

This section contains procedures to help you locate and resolve problems. Resolve some problems by simply

restarting the printer.

PRINTER DOES NOT POWER ON

@ Caution: Plug the three-wire cord with grounding prong directly into a grounded AC outlet.

The power switch is not turned on.

PROBABLE CAUSES SOLUTIONS

At the printer control panel, press the Power/Wake
button. For more information, refer to Powering On the
Printer or Exiting Sleep Mode.

The power cord is not plugged into the outlet correctly.

Power off the printer, then plug the power cord
securely into the outlet.

The printer requires a full reset.

Power off the printer, then unplug the power cord and
wait 30 seconds. Plug the power cord into the outlet
securely, then press the Power/Wake button.

Something is wrong with the outlet connected to the
printer.

Plug another electrical appliance into the outlet, then
check if it operates properly.

Try a different outlet.

The printer is connected to an outlet with a voltage or
frequency that does not match the printer
specifications.

Use a power source with the specifications listed in the
Electrical Specifications.

PRINTER RESETS OR POWERS OFF FREQUENTLY

PROBABLE CAUSES SOLUTIONS

The power cord is not plugged into the outlet correctly.

Power off the printer. Confirm that the power cord is
plugged in correctly to the printer and the outlet, then
power on the printer.

A system error occurred.

Power off the printer, then power on again. If the error
persists, contact your Xerox representative.

The printer is connected to an uninterruptible power
supply (UPS), extension cord, or power strip.

Only use an extension cord designed to handle the
electrical current capacity of the printer. For details,
refer to Electrical Specifications.
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PROBABLE CAUSES SOLUTIONS

A network configuration problem exists. Unplug the network cable. If the problem is not
resolved, contact your system administrator to
reconfigure your network installation.

The printer is connected to an outlet with a voltage or | Use a power source with the specifications listed in
frequency that does not match the printer Electrical Specifications.
specifications.

PRINTER DOES NOT PRINT

PROBABLE CAUSES SOLUTIONS

The printer is in Power Saver mode. On the control panel, press the Power/Wake button.

The printer has an error. If the Status LED is blinking amber, follow the
instructions on the control panel to clear the error. If
the error persists, contact your Xerox representative.

The printer is out of paper. Load paper into the tray.

A toner cartridge is empty. Replace the empty toner cartridge.

The print cartridge has reached end of life. Replace the print cartridge.

No control panel indicators are lighted. Power off the printer, confirm that the power cord is

plugged in correctly to the printer and the outlet, then
power on the printer. If the error persists, contact your
Xerox representative.

The printer is busy. e If the Status LED is flashing blue, a previous print
job could be the problem.

1 At your computer, use the printer properties to
delete all print jobs in the print queue.

2 At the control panel, touch Jobs, then delete all
pending print jobs.

e Load the paper in the tray.

e If the Status LED does not flash once after you
send a print job, check the connection between the
printer and the computer. Power off the printer,
then power on.

The printer cable is disconnected. If the Status LED does not flash once after you send a
print job, check the connection between the printer
and the computer.
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PROBABLE CAUSES SOLUTIONS

There is a wireless or network connectivity issue.

To test the printer, print an Information Page, such as
the Configuration Report. If the page prints, there
could be a wireless or network connectivity issue.

Contact your system administrator or refer to the
System Administrator Guide at System Administrator
Guide at www.xerox.com/support/ALB80XXdocs.

Incorrect print driver.

Check that you have the latest print driver installed. For
details, go to www.xerox.com/support/
ALB80XXsupport.

PRINTING TAKES TOO LONG

PROBABLE CAUSES

The printer is set to print on a paper type that requires
slower printing.

SOLUTIONS

Certain paper types, like heavyweight paper and
transparencies, take more time to print. Ensure that the
print driver and control panel are set to the proper

paper type.

The printer is in Power Saver mode.

Wait. It takes time for printing to start after the printer
exits Power Saver mode.

The way the printer was installed on the network could
be an issue.

e Determine if a print spooler or a computer sharing
the printer is buffering all print jobs and then
spooling them to the printer. Spooling can slow
print speeds.

e To test the speed of the printer, print multiple
copies of an Information Page, such as the
Configuration Report. If the page prints at the
rated speed of the printer, there could be a network
or printer installation issue. For more help, contact
the system administrator.

The job is complex.

Certain jobs, such as jobs using the booklet maker, take
longer to process.

Wait. No action needed.
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DOCUMENT FAILS TO PRINT

Troubleshooting

PROBABLE CAUSES SOLUTIONS

Selected tray has wrong paper size loaded, or paper
type or color is not available.

To view the Job Status for a failed print on the touch

screen:

1 At the printer control panel, press the Home
button.

Touch Jobs.

3 From the jobs list, touch the held job name. The
resources required for the job appear on the control
panel.

4 Do one of the following:

e To print the job, replenish the resources
required. The job resumes automatically when
the required resources are available. If the job
does not print automatically, touch Resume.

e To choose an alternative paper source to enable
the job to print, touch Print On Alternate
Paper. Select a paper tray, then touch OK.

e To delete the print job, touch Delete. At the
prompt, touch Delete.

f Note: The Print On Alternate Paper option
is enabled using the Embedded Web
Server.

5 To return to the Home screen, press the Home
button.

Incorrect network settings.

To reset network settings, contact your system
administrator or refer to the System Administrator
Guide at www.xerox.com/support/ALB80XXdocs.

The way the printer was installed on the network could
be an issue.

e Ensure that the printer is connected to the network.

e Determine if a print spooler or a computer sharing
the printer is buffering all print jobs and then
spooling them to the printer. Spooling can slow
print speeds.

e To test the printer, print an information page, such
as the Configuration Report. If the page prints,
there could be a network or printer installation
issue. For help, contact the system administrator.

Application and print driver have conflicting tray
selections.

For details, see Document Prints from Wrong Tray.
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DOCUMENT PRINTS FROM WRONG TRAY

PROBABLE CAUSES SOLUTIONS
Application and print driver have conflicting tray 1 Check the tray selected in the print driver.
selections. 2 Access the page setup or printer settings of the

application from which you are printing.

3 Set the paper source to match the tray selected in
the print driver or set the paper source to
Automatically Select.

4 Check that you have the latest print driver installed.
For details, go to www.xerox.com/support/
ALB8OXXsupport.

/Q Note: To have the print driver select the tray, set
the tray used as the paper source to Auto
Selection Enabled.

PRINTER IS MAKING UNUSUAL NOISES

PROBABLE CAUSES SOLUTIONS
One of the trays is not installed correctly. Open and close the tray from which you are printing.
There is an obstruction or debris inside the printer. Power off the printer and remove the obstruction or

debris. If you cannot remove the obstruction, contact
your Xerox® service representative.

The printer beeps at each touch on the control panel. Check the Alerts setting. For details, refer to the System
Administrator Guide at www.xerox.com/support/
ALB80XXdocs.

AUTOMATIC 2-SIDED PRINTING PROBLEMS

PROBABLE CAUSES SOLUTIONS

Unsupported or incorrect paper. Ensure that you are using the correct paper. Do not use
transparencies, envelopes, labels, or reloaded paper for
automatic 2-sided printing. For details, see Supported
Paper Sizes and Weights for Automatic 2-Sided
Printing.

Incorrect setting. On the print driver Printing Options tab, select 2-Sided
Print.
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DATE AND TIME ARE INCORRECT

PROBABLE CAUSES SOLUTIONS

The Date and Time Setup is set to Manual (NTP To change the Date and Time to Automatic, in the
Disabled). Embedded Web Server, enable NTP. For details, refer to
the System Administrator Guide at www .xerox.com/
support/ALB80XXdocs.

The time zone, date, or time is set incorrectly. Set the time zone, date, and time manually. For details,
refer to the System Administrator Guide at www.xerox.
com/support/ALB80XXdocs.

SCANNER ERRORS

PROBABLE CAUSES SOLUTIONS

Scanner is not communicating. Power off the printer, and check the scanner cable.
Wait two minutes and power on the printer again.

If the problem is not resolved, contact your Xerox®
service representative.
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Paper Jams

LOCATING PAPER JAMS

& Warning: Never touch a warning-labeled area in the fuser. You can get burned. If a sheet of paper is
wrapped around the inside the fuser, do not try to remove it immediately. Power off the printer
immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the printer has cooled.
If the error persists, contact your Xerox representative.

® Caution: Do not attempt to clear any paper jams using tools or instruments. This can permanently
damage the printer.

The following illustration shows where paper jams can occur along the paper path:

1. Tray 5
Fuser Areq, Left Side Door
Duplex Automatic Document Feeder

Finisher Areas

v B W N

Trays 1-4

MINIMIZING PAPER JAMS

The printer is designed to function with minimal paper jams using Xerox-supported paper. Other paper types can
cause jams. If supported paper is jamming frequently in one areq, clean that area of the paper path.

The following can cause paper jams:

e Selecting the incorrect paper type in the print driver
e Using damaged paper

e Using unsupported paper

e Loading paper incorrectly
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e Overfilling the tray

e Adjusting the paper guides improperly

Most jams can be prevented by following a simple set of rules:

e Use only supported paper. For more information, refer to Supported Paper.
e Follow proper paper handling and loading techniques.

e Always use clean, undamaged paper.

e Avoid paper that is curled, torn, moist, creased, or folded.

o To separate the sheets before loading into the tray, fan the paper.

e Do not load paper above the maximum fill line.

e After loading paper in the trays, adjust the paper guides in all trays. A guide that is not properly adjusted can
cause poor print quality, misfeeds, skewed prints, and printer damage.

e After loading paper in the trays, at the control panel, select the correct paper type and size.
e Before printing, select the correct paper type and size in the print driver.

e Store paper in a dry location.

The following can cause paper jams:

e Polyester-coated paper that is designed especially for inkjet printers

e Paper that is folded, wrinkled, or excessively curled

» Loading more than one type, size, or weight of paper in a tray at the same time

e Loading paper above the maximum fill line in the paper tray

e Allowing the output tray to become overfilled

For a detailed list of supported paper, refer to Supported Paper.

CLEARING PAPER JAMS

To clear jams, watch the video and follow the instructions on the control panel. To resolve the error that appears on
the control panel, remove all paper from the areas shown. If the error does not clear, check the jam areas again to
ensure that all paper has been removed. Ensure that all levers, covers, and doors have been closed correctly.

To avoid damage, always remove jammed paper carefully without tearing it. Try to remove the paper in the same
direction it normally moves through the printer. Even a small piece of paper left in the printer can cause a jam. Do
not reload paper that has jammed.

j’ Note: Do not touch the printed side of the paper when removing it. The printed side of jammed pages could
smudge, and the toner could stick to your hands. Avoid spilling any toner inside the printer.

& Warning: If you accidentally get toner on your clothes, lightly dust them off as best as you can. If some
toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on your skin,
wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out immediately with
cool water and consult a doctor.
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Clearing Document Feeder Jams

To resolve the error that appears on the control panel, follow the instruction provided and remove all paper from the
Duplex Automatic Document Feeder areas.

1. Open the top cover of the document feeder.

2. Carefully remove the original documents from the document feeder.

3. If the original document is not visible when the top cover is opened, lift the document feeder.

4. To remove the original document from the feeder, pull the green tab to open the cover. Rotate the green wheel
clockwise, then carefully pull out the document.

5. If the original document is not visible when the document cover is opened, lift the feeder tray, then remove the
document.

6. Lower the feeder tray.

7. If the original document is not wrinkled or torn, then follow the instructions on the touch screen to reload the
document into the feeder.

fo Note: After clearing a paper jam from the Duplex Automatic Document Feeder, reload the entire original
document, including the pages already scanned. The printer automatically skips the scanned pages and
scans the remaining pages.

@ Caution: Torn, wrinkled, or folded original documents can cause jams and damage the printer. To copy
torn, wrinkled, or folded original documents, use the document glass.

Clearing Paper Jams from Trays 1 and 2

To resolve the error that appears on the control panel, follow the instructions provided. Remove all paper from the
Tray 1 and Tray 2 areas.
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1. Open the left side door of the printer. Remove any jammed paper from the left side door areas.

2. Close the left side door, then wait 10 seconds. Any paper currently in transport inside the printer moves to the
left side area.

3. Open the left side door. Remove any jammed paper from the left side door areas.
4. Pull out the tray until it stops.

5. Remove the paper from the tray.

If the paper is torn, remove the tray completely, then check inside the printer for torn pieces of paper.
Close the left side door.

Reload the tray with undamaged paper, then push the tray in until it stops.

o0 N o

At the control panel, if a prompt appears, select the correct paper size, type, and color.
e To select a new paper size, touch Size.

e To select a new paper type, touch Type.

e To select a new paper color, touch Color.

e To confirm the settings, touch Confirm.

j’ Note: If a prompt does not appear, and you have changed the paper size, type, or color, update the
Required Paper Policies. For details, refer to the System Administrator Guide at www.xerox.com/support/

ALB80XXdocs.

10. To return to the Home screen, press the Home button.
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Clearing Paper Jams from Trays 3 and 4

To resolve the error that appears on the control panel, follow the instructions provided and remove all paper from
the Tray 3 and Tray 4 areas.

1. Open the left side door of the printer. Remove any jammed paper from the left side door areas.

2. Close the left side door, then wait 10 seconds. Any paper currently in transport inside the printer moves to the
left side area.

3. Open the left side door. Remove any jammed paper from the left side door areas.

4. Pull out the tray until it stops.
j’ Note: If you are unable to open Tray 4 completely, paper may be jammed behind the tray.

a. Close Tray 4.

b. To access the area behind Tray 4, remove Tray 2.
¢.  Remove any damaged paper from behind Tray 4.
d. Replace Tray 2.

e. Open Tray 4.

5. Remove any paper from Tray 3 or 4.

6. Reload the tray with undamaged paper, then push the tray in until it stops.
7. Toreturn to the Home screen, press the Home button.

8. Close the left side door.
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Clearing Paper Jams from Tray 5

To resolve the error that appears on the control panel, follow the instructions provided and remove all paper from
the Tray 5 area.

1. Remove the jammed paper from the tray.

2. Ensure that the paper-feed entrance where the tray connects to the printer is clear.

3. Open the left side door of the printer. Remove any jammed paper from the left side door areas.

4. If the paper is torn, check inside the printer for pieces of paper, then gently remove them. For details, refer to
Clearing Paper Jams from the Left Side Door Areas.

Close the left side door.
Fan the paper that you removed and ensure that all four corners align neatly.

Load paper into the tray. Ensure that the leading edge of the paper lightly touches the paper-feed entrance.

G N o wu

At the prompt, verify the paper settings:

e To select a new paper size, touch Size.

e To select a new paper type, touch Type.
e To select a new paper color, touch Color.
e To confirm the settings, touch Confirm.

9. To return to the Home screen, press the Home button.

Xerox® AltaLink® B80XX Series Multifunction Printer User Guide 239



Troubleshooting

Clearing Paper Jams from Tray 6

To resolve the error that appears on the control panel, follow the instructions provided and remove all paper from
the Tray 6 area.

1. Pull Tray 6 away from the side of the printer until the tray stops. Remove any jammed paper from the back of
the tray.

3. Close the left side door, then wait 10 seconds. Any paper currently in transport inside the printer moves to the
left side area.

4. Open the left side door. Remove any jammed paper from the left side door areas.

5. Close the left side door.

240 Xerox® AltaLink® B8OXX Series Multifunction Printer User Guide



Troubleshooting

6. Open the door to Tray 6, then wait for the tray to lower and stop. Remove any paper from the tray.

fo Note: If a paper feed conversion kit is installed, the door to Tray 6 is absent.
e To lower or raise the paper tray, ensure that the printer is not in Power Saver mode.
e Press the white button on the right side of the door frame.
7. Reload the tray with undamaged paper, then close the door to Tray 6.

8. Push Tray 6 back into place so that it is connected to the printer.

Clearing Paper Jams from the Left Side Door Areas

To resolve the error that appears on the control panel, follow the instructions provided and remove all paper from
the left side door areas.

1. Open the left side door of the printer.

& Warning: The area around the fuser can be hot. Use caution to avoid injury.

@ Caution: Do not touch the transfer roller. Touching the roller can reduce image quality.

f Note: Toner can adhere to the transfer roller. This does not affect print quality.

2. Locate the fuser, labeled R3. Use the green tab to open cover 1q, then carefully remove any jammed paper.
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3. Inthe left side door, use the green tab to lift cover 1b, then carefully remove any jammed paper.

w2
f Note: If the paper is torn, remove all torn pieces from the printer.

4. To close the left side door, push the door firmly, until it clicks into place.
TROUBLESHOOTING PAPER JAMS

Multiple Sheets Pulled Together

PROBABLE CAUSES SOLUTIONS

The paper tray is too full. Remove some of the paper. Do not load paper past fill
line.

The edges of the paper are not even. Remove the paper, align the edges, and then reload it.

The paper is moist from humidity. Remove the paper from the tray, and replace it with

new dry paper.

Too much static electricity is present. Try a new ream of paper.

Using unsupported paper. Use only Xerox®-approved paper. For details, refer to
Supported Paper.

The feed rollers are dirty. With a clean, lint-free cloth moistened with water, wipe
the feed rollers until they are clean. For details, refer to
Cleaning the Printer.

Paper Misfeeds

PROBABLE CAUSES SOLUTIONS

The paper is not correctly positioned in | «  Remove the misfed paper and reposition it properly in the tray.
the tray. e Adjust the paper guides in the tray to match the size of the paper.
The paper tray is too full. Remove some of the paper. Do not load paper past the fill line.

The paper guides are not correctly Adjust the paper guides in the tray to match the size of the paper.
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PROBABLE CAUSES SOLUTIONS

adjusted to the paper size.

The tray contains warped or wrinkled Remove the paper, smooth it out, and reload it. If it still misfeeds, do
paper. not use that paper.
The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper.

Using paper of the wrong size, thickness, | Use only Xerox approved paper. For more information, refer to
or type. Supported Paper.

Printer.

The feed rollers are dirty. With a clean, lint-free cloth moistened with water, wipe the feed
rollers until they are clean. For more information, refer to Cleaning the

Label and Envelope Misfeeds

PROBABLE CAUSES SOLUTIONS

The label sheet is facing the wrong way in the tray.

e Load label sheets according to the instructions from
the manufacturer.

e Load labels in the correct orientation for the tray.

For information about loading and using labels, refer to
Labels.

Labels are missing, curled, or pulled away from the
backing sheet.

Do not use any sheet where labels are missing, curled,
or pulled away from the backing sheet.

Envelopes are loaded incorrectly.

You can print C5 envelopes from Tray 5. If the optional
Envelope Tray is installed, you can print a range of
envelopes from Tray 2.

For information about loading and using envelopes,
refer to Envelopes.

Envelopes are wrinkling.

e The heat and pressure of the laser printing process
can cause wrinkling.

e Use supported envelopes. For details, refer to
Guidelines for Printing Envelopes.

f Note: When you load envelopes long-edge feed,
ensure that you specify landscape orientation in
the print driver.
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Paper Jam Message Stays On

PROBABLE CAUSES SOLUTIONS

Paper remains jammed in the printer or finisher. Recheck the paper path and ensure that you have
removed all jammed paper from the printer and
finisher areas.

Open the left side door and check that the paper
sensors are clean.

One of the printer doors is open. Check the doors on the printer. Close any door that is
open.

fe Note: Check for, and remove, torn pieces of paper in the paper path.

Jams During Automatic 2-Sided Printing

PROBABLE CAUSES ‘ SOLUTIONS

Using paper of the wrong size, thickness, or | Use paper of the correct size, thickness, or type. For more
type. information, refer to Supported Paper Sizes and Weights for
Automatic 2-Sided Printing.

Paper is loaded in the wrong tray. Ensure that paper is loaded into the correct tray. For more
information, refer to Supported Paper.

Tray is loaded with mixed paper. Load the tray with only one type and size of paper.

CLEARING FINISHER JAMS

Clearing Jams in the Office Finisher

To clear jams in the Office Finisher areas, watch the video and follow the instructions on the control panel.

Ensure that you have removed all jammed paper, and that jam area covers are closed correctly.
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Clearing Jams in the High Volume Finisher

To clear jams in the High Volume Finisher areas, watch the video and follow the instructions on the control panel.

Ensure that you have removed all jammed paper, and that jam area covers are closed correctly.

Clearing Jams in the CZ Folder

To clear jams in the CZ folder areas, watch the video and follow the instructions on the control panel.

Ensure that you have removed all jammed paper, and that jam area covers are closed correctly.

Clearing Staple Jams

Clearing Staple Jams in the Convenience Stapler

If a flashing light appears on top of the Convenience Stapler, check the staple cartridge. Remove the staple
cartridge from the stapler head, then remove any misfed staples. Remove any partially used staple strips and any
staple strips that are not flat, then reinstall the staple cartridge.

For details, refer to Replacing Staples in the Convenience Stapler.
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Clearing Staple Jams in the Office Finisher

If the printer stops printing and reports a stapler jam, remove the staple cartridge, then remove any misfed staples.
Remove any partially used staple strips and any staple strips that are not flat, then reinstall the staple cartridge.

For details, refer to Replacing Staples in the Office Finisher.

After you replace the staple cartridge, locate then remove any paper jams.

Clearing Staple Jams in the Booklet Maker of the Office Finisher

If the printer stops printing and reports a stapler jam, remove both staple cartridges, then remove any misfed
staples. Remove any partially used staple strips from the staple cartridges, then reinstall the staple cartridges.

For details, refer to Replacing Staples in the Office Finisher.

After you replace the staple cartridges, locate then remove any paper jams.

Clearing Staple Jams in High Volume Finisher

If the printer stops printing and reports a stapler jam, remove the staple cartridge, then remove any misfed staples.
Remove any partially used staple strips and any staple strips that are not flat, then reinstall the staple cartridge.

For details, refer to Replacing Staples in the High Volume Finisher.

After you replace the staple cartridge, locate then remove any paper jams.

Clearing Staple Jams in the Booklet Maker of the High Volume Finisher

If the printer stops printing and reports a stapler jam, remove both staple cartridges, then release any misfed
staples. Remove any partially used staple strips from the staple cartridges, then reinstall the staple cartridges.

For details, refer to Replacing Staples in the High Volume Finisher.

After you replace the staple cartridges, locate then remove any paper jams.

Clearing Hole Punch Jams

Clearing Hole-Punch Jams in Office Finisher

If the printer stops printing and reports a hole-punch jam, empty the hole-punch waste container. For details, refer
to Emptying the Hole-Punch Waste Container.

After you empty the hole-punch waste container, locate then remove any paper jams.

Clearing Hole-Punch Jams in High Volume Finisher

If the printer stops printing and reports a hole-punch jam, empty the hole-punch waste container. For details, refer
to Emptying the Hole-Punch Waste Container.

After you empty the hole-punch waste container, locate then remove any paper jams.
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Print, Copy, and Scan Problems

IDENTIFYING PRINT, COPY, AND SCAN PROBLEMS

Problems with the output quality of your printer can be a print-related, copy-related, or scan-related problem. A
quick test can help you to identify where a problem lies.

To identify if a problem is print-related or scan-related, do the following:
1. Print the Quick Use Guide.

a. At the printer control panel, press the Homebutton.

b. Touch Device, then touch Information Pages.

¢.  Touch Quick Use Guide, then touch Print.

d. To return to the Home screen, press the Homebutton.
2. Check the quality of the print output.

3. If the print quality appears poor, the problem is print-related. Check for the symptom in the Solving Print
Quality Problems table.

4. If the print quality is good, the problem is likely to be scanner-related.
a. Copy the Quick Use Guide that you have printed.
b. Check the quality of the copy output.

c.  For any symptom of poor print quality, refer to the Copy and Scan Problems table.

PRINT-QUALITY PROBLEMS

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, use the
information in this section to troubleshoot the problem. For more information, go to www.xerox.com/support/
ALB80OXXsupport.

(D Caution: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not cover
damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction Guarantee is
available in the United States and Canada. Coverage could vary outside these areas. Contact your local
Xerox representative for details.

f Note: To ensure consistent print quality, the toner cartridges and print cartridges for many devices are
designed to cease functioning at a predetermined point.

Controlling Print-Quality

Various factors can affect the quality of the output of your printer. For consistent and optimum print quality, use
paper designed for your printer and set the paper type correctly. Follow the guidelines in this section to maintain
optimum print quality from your printer.

Temperature and humidity affect the quality of the printed output. The guaranteed range for optimal print quality
is 10-28°C (50-83°F) and 15-85% relative humidity.
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Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this section for the best
print quality and to avoid jams:

e Use only Xerox approved paper. For details, refer to Supported Paper.

e Use only dry, undamaged paper.

e/

(1) Caution: Some paper and other media types can cause poor output quality, increased paper jams,
or damage your printer. Do not use the following:

Rough or porous paper

Inkjet paper

Non-laser glossy or coated paper

Paper that has been photocopied

Paper that has been folded or wrinkled

Paper with cutouts or perforations

Stapled paper

Envelopes with windows, metal clasps, side seams, or adhesives with release strips
Padded envelopes

Plastic media

e Ensure the paper type selected in your print driver matches the paper type on which you are printing.

e If you have the same size paper loaded in more than one tray, ensure that the proper tray is selected in the
print driver.

e Store your paper and other media properly for optimum print quality. For details, refer to Paper Storage
Guidelines.

Solving Print-Quality Problems

When the print quality is poor, to correct the problem, select the closest symptom from the following table and refer
to the corresponding solution.

If the print quality does not improve after performing the appropriate action, contact your Xerox representative.

f Note: To maintain print quality, a warning message appears when the toner level is low or when the print
cartridge is nearing the end of life. When the toner cartridge is empty, or when the print cartridge has
reached end of life, a second message appears. The second message prompts you to replace the expired
cartridge. The printer stops printing until you install a new toner cartridge or print cartridge.
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SYMPTOM SOLUTIONS

The output is too light.  To check the toner level, check the control panel,
N use the print driver, or the Embedded Web Server. If
N the toner cartridge is near empty, replace it. For

details, refer to Supply Status.

e Verify that the toner cartridge is approved for use in
this printer, and replace it as needed. For best
results, use a genuine Xerox toner cartridge.

e Replace the paper with a recommended size and
type, and confirm that your printer and print driver
settings are correct.

e Verify that the paper is dry and that supported
paper is used. If not, change the paper.

e Change the Paper Type settings in the print driver.
In the print driver, on the Printing Options tab,
select Paper, then change the Other Type setting.

e Check the Print Quality setting in the print driver. In
the print driver, on the Printing Options tab, if the
Print Quality is set to Toner Saver, change the
setting to Standard.

e Change the Darken Image setting. For details, refer
to the System Administrator Guide at www .xerox.
com/support/ALB80XXdocs.

Toner smears or print rubs off. e Change the Paper Type settings in the print driver.
For example, change Plain to Lightweight

The output has stains on the back side.
Cardstock. In the print driver, on the Printing

\\\\ // Options tab, select Paper, then change the Other
[ ] Type setting.
AB C ° » Verify that the paper is the correct size, type, and

weight. If not, change the paper settings.

D E ‘ PY o Verify that the printer is plugged into an outlet that

is providing the correct voltage and power. Review
the electrical specification of the printer with an
electrician if necessary. For details, refer to Electrical
Specifications.

e Check the percentage of remaining life for the fuser
module. For details, refer to Supply Status. Replace
the fuser module when the percentage of
remaining life is less than 20 per cent. For details,
refer to Replacing the Fuser Module.

Random spots on the output, or the image is blurry. e Ensure that the toner cartridge is installed correctly.

e If you used a non-genuine brand toner cartridge,
install a genuine Xerox toner cartridge.

e Use the Rough paper type setting, or try a paper
with a smoother surface.
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SYMPTOM SOLUTIONS

. e Ensure that the humidity in the room is within
F N\ specifications. For details, see Relative Humidity.

A.B ¢ Replace the print cartridge.
DEF

The output is blank. o Power off the printer, then power on again.

F\\\ Clean the LED printhead. For details, refer to Cleaning
the Print Head.

e Remove, then re-install the print cartridge.
e Replace the print cartridge.

e If the error persists, contact your Xerox
representative.

Black or white streaks appear in the output. Clean the LED printhead. For details, refer to Cleaning
the Print Head.

e Replace the print cartridge.

AN
B e If the error persists, contact your Xerox
representative.

The output has a mottled appearance. « Verify that the paper is the correct size, type, and
b weight. If not, change the paper settings.
h e Ensure that the humidity in the room is within
- specifications. For details, refer to Relative Humidity.
- e (Choose a different paper type at the control panel,

in the application, and in the print driver.
e Replace the paper.

e If the error persists, contact your Xerox
representative.

Ghosting appears in the printed output. « Verify that the paper is the correct size, type, and
weight. If not, change the paper settings.

e Change the Paper Type settings in the print driver.
In the print driver, on the Printing Options tab,
select Paper, then change the Other Type setting.

e Check the percentage of remaining life for the
transfer roller. For details, refer to Supply Status.
Replace the transfer roller when the percentage of
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SYMPTOM

SOLUTIONS

remaining life is less than 20 per cent. For details,
refer to Replacing the Transfer Roller.

Replace the print cartridge.

If the error persists, contact your Xerox
representative.

Auger marks appear on the printed output.

To check the toner level, check the control panel,
use the print driver, or the Embedded Web Server.
For details, refer to Supply Status. If the toner
cartridge is near empty, replace it.

Verify that the toner cartridge is approved for use in
this printer, and replace it as needed. For best
results, use a genuine Xerox toner cartridge.
Replace the print cartridge.

If the error persists, contact your Xerox
representative.

The output print is wrinkled or stained.

Verify that the paper is the correct size, type, and
weight for the printer and that it is loaded properly.
If not, change the paper.

Try a new ream of paper.

Change the Paper Type settings in the print driver.
In the print driver, on the Printing Options tab,
select Paper then change the Other Type setting.

Envelopes are wrinkled or creased when printed.

Check if the crease is within 30mm (1.2 in.) of the four
edges of the envelope.

If yes, it is printing as expected. Your printer is not
faulty.

If not, take the following actions:
Ensure that only C5 envelopes are loaded in Tray 5.

Ensure that envelopes are loaded properly in Tray 5.
For details, refer to Loading Envelopes in Tray 5.

Follow the guidelines for printing on envelopes. For
details, refer to Guidelines for Printing Envelopes.
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SYMPTOM SOLUTIONS

The top margin is incorrect.

ABC
DEF

e Ensure that the paper is loaded properly.

e Ensure that the margins are set correctly in the
application you are using.

The printed surface of the paper is bumpy.

ABC’
DEF,

e Clean the fuser rollers:

1 Print a solid image over the entire surface of
one sheet of paper.

2 Load the printed sheet into the tray with the
printed side face down.

3 Print five blank pages to remove debris from the
fuser rollers.

e Check the percentage of remaining life for the fuser
module. For details, refer to Supply Status. Replace
the fuser module when the percentage of
remaining life is less than 20 per cent. For details,
refer to Replacing the Fuser Module.

COPY AND SCAN PROBLEMS

If the copy or scan quality is poor, refer to the following table.

SYMPTOMS ‘ SOLUTIONS

Lines or streaks only present in copies made from the
document feeder.

There is debris on the document glass. When scanning,
the paper from the document feeder passes over the
debris, creating lines or streaks. Clean all glass surfaces
with a lint-free cloth.

Spots present in copies made from the document glass.

There is debris on the document glass. When scanning,
the debris creates a spot on the image. Clean all glass
surfaces with a lint-free cloth.

The reverse side of the original document is showing
on the copy or scan.

Turn on Background Suppression.

Image is too light or too dark.

e Copy: Use the Image Quality settings to lighten,
darken, or adjust contrast.

e Scan: Use the Advanced Settings Tab to lighten,
darken, or adjust contrast.
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SYMPTOMS SOLUTIONS

Colors are inaccurate. Confirm that the correct Original Type is set prior to
scanning.
The output pages are blank. The document was loaded incorrectly.

e If using the document feeder, place the original
document face up.

e If using the document glass, place the original
document face down.

If the problem persists, for online support information, go to www.xerox.com/support/ALB80XXsupport.
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Fax Problems

If your printer cannot send and receive faxes, ensure that the printer is connected to an approved analog telephone
line. The fax machine cannot send or receive faxes when it is connected directly to a digital telephone line without

the use of an analog filter.

f Note: If the fax connection is poor, transmit the fax at a lower rate. For the Starting Rate, select Forced

(4800 bps).

PROBLEMS SENDING FAXES

SYMPTOMS

The document is not feeding
properly through the document
feeder.

PROBABLE CAUSES

The document is too thick, too thin,

or too small.

SOLUTIONS

Use the document glass.

The document is scanned at an
angle.

The document feeder width guides
are not adjusted to fit the width of
the document.

Adjust the document feeder width
guides so that they fit against the
document.

The fax received by the recipient is
blurry.

The document is positioned
incorrectly.

Position the document correctly.

The document glass is dirty.

Clean the document glass.

The text in the document is too
light.

Adjust the resolution. Adjust the
contrast.

There is a problem with the
telephone connection.

Verify that the telephone line is
working, then send the fax again.

There is a problem with one of the
fax machines.

Make a copy to verify that the
printer can make clean copies and
prints. If the copy prints correctly,
have the recipient verify that their
fax machine is operating correctly.

The fax received by the recipient is
blank.

The document was loaded
incorrectly.

If using the document feeder, place
the original document face up.

If using the document glass, place
the original document face down.

Fax send and receive works
intermittently.

An incorrect fax card may be
installed.

Check that the phone port on the
fax card is yellow. If not, replace the
fax card with the correct fax card
for your printer.

The system software for your
printer needs updating.

Download the latest version of the
system software. For details, refer to
the System Administrator Guide at
Www.xerox.com/support/
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SYMPTOMS

PROBABLE CAUSES

Troubleshooting

SOLUTIONS
ALB80XXdocs.

Fax was not transmitted.

The fax number is wrong.

Verify the fax number.

The telephone line is connected
incorrectly.

Verify the telephone line
connection. If the telephone line is
disconnected, connect it.

There is a problem with the fax
machine of the recipient.

Contact the recipient.

The fax feature is not installed or is
not enabled.

Ensure that the fax feature is
installed and enabled.

Server fax is enabled.

Ensure that server fax is disabled.

An access number is required to
connect to an outside line.

If the printer is connected to a PBX
system, it could be necessary to
enter a number to access the
outside telephone line.

The fax number needs a pause
between the prefix for an outside
line and the telephone number.

To insert a pause, touch the Dial
Pause button. A comma ( ,)
appears in the corresponding
location.

If the problem persists, for online support information, go to www.xerox.com/support/ALB80XXsupport.

PROBLEMS RECEIVING FAXES

SYMPTOMS

The fax received by the recipient is
blank.

‘ PROBABLE CAUSES

There is a problem with the
telephone connection or with the
fax machine of the sender.

‘ SOLUTIONS

Verify that the printer can make
clean copies. If it can, have the
sender fax the document again.

The sender loaded the pages
incorrectly.

Contact the sender.

The printer answers the call but
does not print the fax.

The memory is full.

To increase available memory,
delete stored jobs and wait for the
existing jobs to complete.

The received fax size is reduced in
size.

The paper supply in the printer does
not match the document size sent.

Confirm the original size of the
documents, then load the
appropriate paper size in the
printer.

Faxes are not received
automatically.

The printer is set to receive faxes
manually.

Set the printer to receive faxes
automatically.

The memory is full.

If the printer is out of paper, faxes
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SYMPTOMS PROBABLE CAUSES SOLUTIONS

and print jobs can deplete the
printer of memory. Load paper and
print the jobs stored in the memory.

The telephone line is connected Verify the telephone line
incorrectly. connection. If the telephone line is
disconnected, connect it.

There is a problem with the fax Make a copy to verify that the
machine of the sender. printer can make clean copies and
prints. If the copy prints correctly,
have the recipient verify that their
fax machine is operating correctly.

If the problem persists, for online support information, go to www.xerox.com/support/ALB80XXsupport.

PRINTING FAX REPORTS

You can print the following fax reports from the printer control panel:
e Activity Report

e Protocol Report

e Fax Address Book Report

e Options Report

e Pending Jobs Report

To print a fax report:

1. At the printer control panel, press the Home button.
Touch Device.

Touch Tools.

Touch App Settings > Fax App.

Touch Print Fax Reports.

Touch the required report, then touch Print.

To return to the Device screen, touch X, then touch X again.

L N o U &~ W N

To return to the Home screen, press the Home button.

If the Print Fax Reports feature does not appear, contact your system administrator or refer to the System
Administrator Guide at www.xerox.com/support/ALB80XXdocs.
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Getting Help

Your printer includes utilities and resources to help you troubleshoot printing problems.

VIEWING ERROR AND ALERT MESSAGES ON THE CONTROL PANEL

When an error or warning condition occurs, the printer alerts you of the problem. A message appears on the control
panel and the LED status light on the control panel flashes amber or red. Alerts inform you about printer conditions,
such as low supplies or open doors that require your attention. Error messages warn you about printer conditions
that prevent the printer from printing or degrade printing performance. If more than one condition occurs, only one
appears on the control panel.

To view a complete list of active error and alert messages:
1. At the printer control panel, press the Home button.
Touch Device.

Touch Notifications.

Touch Faults & Alerts, Alerts, or Faults.

To view details, touch a fault or alert.

To exit the Notifications screen, touch X.

N o v W N

To return to the Home screen, press the Home button.

VIEWING THE ERROR HISTORY ON THE CONTROL PANEL

When errors occur on the device, they are logged into an error history file by date, time, and associated fault code.
You can use this list to identify trends and resolve problems.

To view the error history:

1. At the printer control panel, press the Home button.
Touch Device.

Touch Notifications.

Touch Fault History.

To exit, touch X.

To exit the Notifications screen, touch X.

N o v &~ W N

To return to the Home screen, press the Home button.

THE EMBEDDED WEB SERVER

The Embedded Web Server is the administration and configuration software that is installed in the printer. It allows
System Administrators to modify network and system settings on the printer remotely using a Web browser.

You can check the status of the printer, monitor paper and supply levels, and submit and track print jobs. All these
functions can be accessed from the convenience of your computer.

The Embedded Web Server requires:
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e ATCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux environments.
e TCP/IP and HTTP enabled in the printer.

e A network-connected computer with a Web browser that supports JavaScript.

ONLINE SUPPORT ASSISTANT

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to solve your
printer problems. You can find solutions for print-quality problems, paper jams, software installation issues, and
more.

To access the Online Support Assistant, go to www.xerox.com/support/ALB80XXsupport.

INFORMATION PAGES

Your printer has a set of information pages that you can print. These pages include configuration and font
information, demonstration pages, and more. For details, refer to Information Pages.

MORE INFORMATION

You can obtain more information about your printer from these sources:

RESOURCE ‘ LOCATION

Installation Guide Packaged with the printer.

Quick Use Guide Print from the control panel. For details, refer to
Information Pages.

Other documentation for your printer www.xerox.com/support/ALB80XXdocs

Recommended Media List United States: www.xerox.com/rmlna

European Union: www.xerox.com/rmleu

Technical support information for your printer, www.xerox.com/support/ALB80XXsupport
including online technical support, Online Support
Assistant, and print driver downloads.

Information Pages Print from the control panel. For details, refer to
Information Pages.

Embedded Web Server information In the Embedded Web Server, click Help.
Order supplies for your printer www.xerox.com/supplies
A resource for tools and information, including www.xerox.com/businessresourcecenter

interactive tutorials, printing templates, helpful tips,
and customized features to meet your individual needs.

Local sales and Technical Customer Support www.xerox.com/worldcontacts
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RESOURCE LOCATION

Printer registration www.xerox.com/register

Xerox® Direct online store www.direct.xerox.com/

Locating the Serial Number

When you order supplies or contact Xerox for assistance, you need the serial number of your device. You can obtain
the serial number in several ways. To locate the serial number, print the Configuration Report. You can view the
serial number on the control panel or on the Embedded Web Server home page. The serial number is printed on a
label that is affixed to the printer. To view the label, open the left side door.

For details on how to print the Configuration Report, refer to Information Pages.
To view the serial number on the control panel:
1. At the printer control panel, press the Home button.
2. Touch Device.
3. Touch About.
The model, serial number, and software version is displayed.

4. To return to the Home screen, press the Home button.
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Specifications

Printer Configurations and Options

STANDARD FEATURES

The printer provides the following features:

Copy, Print, Email, Scan, Internet Fax, and Server Fax
Scan to USB and Print from USB mass storage devices
Scan to Mailbox, Scan to Network, Scan to Home, Single Touch Scan

Searchable PDF, Single/Multiple-Page PDF / XPS / TIFF, Encrypted / Password-Protected PDF, and Linearized PDF
/ PDF/A file formats

Copy speed of up to 90 ppm for black and white on A4 (210 x 297 mm) or Letter (8.5 x 11 in.) paper
1200 x 1200 dpi, 256 shades of gray

Copy document sizes up to A3/11 x 17 in.

Print document size, with short-edge feed, up to SRA3/12 x 19 in.

Center Tray

Automatic 2-sided printing

Duplex Automatic Document Feeder

Color touch screen control panel

Trays 1-2 each with 500-sheet capacities

Tray 5 with 100-sheet capacity

High-Capacity Tandem Tray with total 3600 A4/Letter sheet capacity

2-GByte memory plus 1-GByte page memory

Internal 250-GByte hard drive

Ethernet 10/100/1000Base-TX

High-Speed USB 2.0 direct print

Adobe PostScript and PCL fonts and support

Xerox® Mobile Express Driver®, Xerox® Global Print Driver®, and Xerox® Pull Print Driver support

Automated supplies replenishment and management using Xerox ® MeterAssistant®, Xerox®SuppliesAssistant®,
and MaintenanceAssistant

Remote driver installation

Remote Control Panel and Configuration Cloning
Bonjour, SSDP, and SAP device discovery

Unified Address Book

Xerox® Standard Accounting

Encrypted Secure Print, Secure Fax, Secure Scan, Secure Email
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e McAfee data security

e HDD Overwrite, AES 256-bit Encryption (FIPS 140-2 compliant), SHA-256 Hash Message Authentication
e Xerox® Extensible Interface Platform

e Xerox® Earth Smart Driver Settings

e Embedded Web Server

o Xerox® CentreWare ® Web

e Email Alerts

e Support for mobile printing, mobile printing connectivity, and mobile Apps
o Xerox® App Gallery supported

e Xerox® Copier Assistant

e NFC printing

e Support for Mopria ®

e Support for AirPrint ®

e Support for Google Cloud Print™

OPTIONS AND UPGRADES
o High-Capacity Feeder (HCF) Tray 6: 3000 sheets, size 8.5 x 11 in. / A4 long-edge feed
e High-Capacity Feeder Kits: 1250-sheet 11 x 17 in. Short Edge Kit or 1250-sheet Letter/Legal Short Edge Kit

j’ Note: The HCF Short Edge Feed and Long Edge Feed Media Kits are only available for 65-90 ppm
models.

e Envelope Tray (replaces Tray 2): Up to 50 envelopes: #10 commercial, monarch, DL, C5
o Office Finisher: 2000-sheet plus 250-sheet trays, 50-sheet multi-position stapling, optional hole punch

e Office Finisher with Booklet Maker: 2000-sheet plus 250-sheet trays, 50-sheet multi-position stapling, saddle-
stitch booklet making, optional hole punch

e High Volume Finisher (HVF): 3000-sheetplus 250-sheet trays, 100-sheet multi-position stapling, optional hole
punch

e High Volume Finisher with Booklet Maker: 3000-sheet plus 250-sheet trays, 100-sheet multi-position stapling,
saddle-stitch booklet making, optional hole punch

e ZFold / C Fold Unit (optional with HVF with Booklet Maker): Adds letter-size Z-folding and C-folding
e Post-Process Inserter (optional with HVF and HVF with Booklet Maker): Adds pre-printed inserts

e Convenience Stapler includes Work Surface

e Envelope Tray

e Keyboard Kit (wired or USB)

e One-Line and Dual-Line Fax Kits (includes Fax card)

e Fax forward to Email or SMB
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e Xerox Secure Access Unified ID System

e Xerox® Common Access Card Enablement Kit

e Xerox® Network Accounting Enablement

e Wireless Network Adapter

e Wi-Fi Direct with optional Wireless Network Adapter

e Foreign Device Interface

e McAfee Integrity Control Enablement Kit and McAfee enhanced security features

e XPS Print Option Kit

e Smart Card Enablement Kit

e Xerox® Integrated RFID Card Reader E1.0

e Unicode print

e Xerox® Scan to PC Desktop® Professional

FINISHING OPTIONS

FINISHING
OUTPUT DEVICE CAPACITY VAR WEIGHTS OPTIONS
Center Tray 400 sheets All supported sizes All supported NA
weights
Office Finisher Top Tray: 250 sheets | A6—-A3 4.25 x 5.85 60-216 g/m? Multiple-position
unstapled in.to 11 x 17 in. stapling: 50 sheets
Stacking: 2000 A5-A3 5.5x8.5in.
sheets unstapled to 11 x 17 in.
Office Finisher with | Top Tray: 250 sheets | A6—A3 4.25 x 5.85 60-216 g/m? Multiple-position
Booklet Maker unstapled in.to 11 x 17 in. stapling: 50 sheets
Stacking: 2000 A5-A3 5.5x8.5in.
sheets unstapled, to 11 x 17 in.
1000 sheets single-
stapled, or 750
sheets dual-stapled
Booklet Tray: Up to | A4 SEF (Short-Edge Saddle-stapling: 2—
30 booklets 1-5 Feed), Letter SEF, B4 15 sheets of 60-90
sheets, 20 booklets | SEF, Legal SEF, A3 g/m?
6-10 sheets, 10 SEF, 11 x 17 in. SEF
booklets 11-15
sheets
High Volume Top Tray: 250 sheets | A6-A3 4.25 x 5.85 60-216 g/m? 100 sheets single,
Finisher in.to 11 x17in. dual, front, rear, SEF,
Stacking: 3000 and 4-stitch
sheets
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FINISHING
OUTPUT DEVICE CAPACITY SIZES WEIGHTS OPTIONS
High Volume Top Tray: 250 sheets | A6—-A3 4.25 x 5.85 60-216 g/m? 100 sheets single,
Finisher with Booklet . in.to 11 x 17 in. dual, front, rear, SEF,
Maker Stacking: 3000 and 4-stitch
sheets
Booklet Tray with A4 SEF, Letter SEF, Saddle-stapling and
tray stop up: Upto | B4 SEF, Legal SEF, Fold: 2-15 sheets
30 booklets Booklet | A3 SEF, 11 x 17 in. )
Tray with tray stop | SEF V-Fold: 5 sheets
down: Unlimited
CZ Fold Unit 50 sheets or A4 [ Letter 60-216 g/m? C-Fold and Z-Fold
unlimited capacity
with tray stop down
Convenience Stapler | NA Any supported size | Any supported Single stapling: 50
weight sheets

f Note: Sheet quantities for tray capacities and finishing options are based on 80 g/m?. Quantities are
reduced for heavier media and must be within the specified weight range.
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Physical Specifications

BASE CONFIGURATION

e Width: 850 mm (33.5in.)

e Depth: 665 mm (26.2 in.)
e Height: 1150 mm (45.3 in.)
e Weight: 120 Kg (264.5 |b.)

CONFIGURATION WITH OFFICE FINISHER
e Width: 1305 mm (51.4in.)

e Depth: 665 mm (26.2 in.)

e Height: 1150 mm (45.3 in.)

e Weight: 149.5 Kg (329.5 Ib.)

CONFIGURATION WITH OFFICE FINISHER WITH BOOKLET MAKER
e Width: 1365 mm (53.7 in.)

e Depth: 665 mm (26.2 in.)

e Height: 1150 mm (45.3in.)

e Weight: 165.4 Kg (364.5 Ib.)

CONFIGURATION WITH HIGH VOLUME FINISHER AND BOOKLET MAKER
e Width: 1775 mm (69.9 in.)

e Depth: 665 mm (26.2 in.)

e Height: 1150 mm (45.3 in.)

e Weight: 229 Kg (504.5 Ib.)

CONFIGURATION WITH HIGH VOLUME FINISHER, BOOKLET MAKER AND CZ FOLDER
e Width: 2085 mm (82.1 in.)

e Depth: 665 mm (26.2 in.)

e Height: 1150 mm (45.3in.)

e Weight: 249.3 Kg (549.5 Ib.)
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CONFIGURATION WITH HIGH VOLUME FINISHER, BOOKLET MAKER AND POST PROCESS
INSERTER

e Width: 1775 mm (69.9 in.)
e Depth: 665 mm (26.2 in.)

e Height: 1150 mm (45.3in.)
e  Weight: 236.2 Kg (520.5 |b.)

CONFIGURATION WITH HIGH VOLUME FINISHER, BOOKLET MAKER AND CZ FOLDER
e Width: 2085 mm (82.1 in.)

e Depth: 665 mm (26.2 in.)

e Height: 1150 mm (45.3in.)

e Weight: 256.5 Kg (565.5 |b.)

HIGH CAPACITY FEEDER - TRAY 6
e Width: 388.6 mm (15.3 in.)

e Depth: 510 mm (20.1 in.)

e Height: 574 mm (22.6 in.)

e Weight: 30 Kg (66 |b.)

CLEARANCE REQUIREMENTS

Clearance Requirements for Base Configuration
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Clearance Requirements for Configuration with Office Finisher

Clearance Requirements for Configuration with Office Finisher with Booklet Maker
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Clearance Requirements for Configuration with High Volume Finisher and Booklet Maker

Clearance Requirements for Configuration with High Volume Finisher, Booklet Maker and CZ Folder
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Clearance Requirements for Configuration with High Volume Finisher, Booklet Maker, CZ Folder and High

Capacity Feeder
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Environmental Specifications

TEMPERATURE

Operating: 10-28°C (50-83°F)

RELATIVE HUMIDITY

Operating: 15% to 85% (non-condensing)

ELEVATION

For optimum performance, use the printer at elevations below 3000 m (9842 ft.).
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Electrical Specifications

POWER SUPPLY

VOLTAGE FREQUENCY CURRENT REQUIRED
45-55 prints per minute 110-127 VAC +/-10% 50Hz +/- 3 Hz 15A
60 Hz +/- 3 Hz
220-240 VAC +/-10% 50 Hz +/- 3 Hz 10A
60 Hz +/- 3 Hz
65-90 prints per minute 110-127 VAC +/-10% 50Hz +/- 3 Hz 20A
60 Hz +/- 3 Hz
220-240 VAC +/-10% S50 Hz +/- 3 Hz 10A
60 Hz +/- 3 Hz
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Performance Specifications

PRINT SPEED

Xerox reports speeds for continuous printing using long-edge feed on A4 (210 x 297 mm, 8.27 x 11.69 in.) or Letter
(216 x 279 mm, 8.5 x 11 in.) Bond 60-105 g/m? (18-28 Ib.) paper from any tray except for the Bypass Tray.

Several factors affect print speed:

e Paper orientation: For faster print speeds, you can load paper long-edge feed.

e Paper size: Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the fastest print speed.
e Paper weight: Lightweight prints faster than heavier paper, such as Cardstock and Labels.
e Paper type: Plain prints faster than Glossy.

You can achieve maximum print speed when you print on Plain, Letter/A4 paper, using long-edge feed. The slowest
print speed is approximately 10 ppm when you print on envelopes or media 150 mm wide or less.

PRINTING RESOLUTION

Maximum Resolution: 1200 x 1200 dpi
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Environmental, Health, and Safety Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, contact:
e United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)

e FEurope: EHS-Europe@xerox.com

For product safety information in the United States and Canada, go to www.xerox.com/about-xerox/environment.

For product safety information in Europe, go to www.xerox.com/about-xerox/environment_europe.
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Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are designed to
mitigate interference caused or received by this printer in a typical office environment.

UNITED STATES FCC REGULATIONS

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio
frequency energy. If it is not installed and used in accordance with these instructions, it may cause harmful
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his/her own expense.

If this equipment does cause harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
e Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to operate
this equipment.

j’ Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

CERTIFICATIONS IN EUROPE

c € The CE mark applied to this product symbolizes a declaration of conformity by Xerox with
the following applicable Directives of the European Union:

e Low Voltage Directive 2014/35/EU
e Electromagnetic Compatibility Directive 2014/30/EU
e Radio Equipment Directive 2014/53/EU

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for the
environment.

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox.
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/\ Warning:

e Changes or modifications to this equipment not specifically approved by the Xerox Corporation may
void the user's authority to operate this equipment.

e External radiation from Industrial, Scientific, and Medical (ISM) equipment can interfere with the
operation of this Xerox device. If external radiation from ISM equipment interferes with this device,
contact your Xerox representative for assistance.

e Thisis aclass A product. In a domestic environment, this product can cause radio frequency
interference, in which case the user can be required to take adequate measures.

e To ensure compliance with European Union regulations 2014/30/EU, use shielded interface cables.

EUROPEAN UNION LOT 4 IMAGING EQUIPMENT AGREEMENT ENVIRONMENTAL INFORMATION

Environmental Information Providing Environmental Solutions and Reducing Cost

The following information has been developed to assist users and has been issued in relation to the European
Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging Equipment. This requires
manufacturers to improve environmental performance of in scope products and supports the EU action plan on
energy efficiency.

In scope products are Household and Office equipment that meet the following criteria:
e Standard monochrome format products with a maximum speed less than 66 A4 images per minute

e Standard color format products with a maximum speed less than 51 A4 images per minute

European Union Lot 19 on Light Sources

According to the European Commission Ecodesign Directive, the light source contained within this product or its
components is intended to be used for Image Capture or Image Projection only, and is not intended for use in
other applications.

Environmental Benefits of Duplex Printing

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to print on
both sides of the paper automatically, and therefore helps to reduce the use of valuable resources by reducing your
paper consumption. The Lot 4 Imaging Equipment agreement requires that on models greater than or equal to 40
ppm color or greater than or equal to 45 ppm monochrome the duplex function has been auto-enabled, during the
setup and driver installation. Some Xerox models below these speed bands may also be enabled with 2-sided
printing settings defaulted on at the time of install. Continuing to use the duplex function will reduce the
environmental impact of your work. However, should you require simplex/1-sided printing, you may change the
print settings in the print driver.

Paper Types

This product can be used to print on both recycled and virgin paper, approved to an environmental stewardship
scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper (60 g/m?), which contains
less raw material and thus saves resources per print, may be used in certain applications. We encourage you to
check if this is suitable for your printing needs.
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ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and
purchase of energy efficient models, which help to reduce environmental impact. Details
on the ENERGY STAR program and models qualified to ENERGY STAR can be found at the
following website: www.energystar.gov.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United States,
European Union, and Japanese governments and the office equipment industry to
promote energy-efficient copiers, printers, fax, multifunction printers, personal computers,
and monitors. Reducing product energy consumption helps combat smog, acid rain, and
long-term changes to the climate by decreasing the emissions that result from generating
electricity.

Power Consumption and Activation Time

The amount of electricity that a device consumes depends on the way the device is used. This device is designed
and configured to enable you to reduce your electricity usage.

Power Saver modes are enabled on your device to reduce energy consumption. After the last print, the device
transitions to Ready mode. In this mode, the device can print again immediately. If the device is not used for a
specified period, the device transitions to Sleep mode. In these modes, to enable reduced power consumption, only
essential functions remain active. The device takes longer to produce the first print after it exits the Power Saver
modes than it takes to print in Ready mode. This delay is the result of the system waking up and is typical of most
imaging devices on the market.

To save power, you can enable Auto Power Off mode on your device.

To change the Power Saver settings, refer to the User Guide at www.xerox.com/support/ALB80XXdocs. For further
assistance, contact your System Administrator or refer to the System Administrator Guide.

To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System Administrator
Guide at www.xerox.com/support/ALB80XXdocs.

To learn more about Xerox participation in sustainability initiatives, go to www.xerox.com/about-xerox/
environment/enus.html.

f Note: Changing the default Power Saver activation times can result in an overall higher energy consumption
of the device. Before you turn off Power Saver modes or set a long activation time, consider the increase in
device power consumption.

Default Power Saver Settings

The B8065, B8075, and B8090 devices are ENERGY STAR®-qualified under the ENERGY STAR Program
Requirements for Imaging Equipment. The transition time from Ready mode to Sleep mode can be set up to 30
minutes. The default value is O minutes.

To change the Power Saver settings, contact your System Administrator, or refer to the System Administrator Guide
at www.xerox.com/support/ALB80XXdocs.
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Environmental Choice Certified to Office Machines CCD-035
SN, This product is certified to Environmental Choice standard for office machines, meeting all
requirements for reduced environmental impact. As part of achieving certification, Xerox
Corporation has proven this product meets the Environmental Choice criteria for energy
efficiency. Certified copier, printer, multifunctional device, and fax products must also meet
criteria such as reduced chemical emissions and demonstrate compatibility with recycled
supplies. Environmental Choice was established in 1988 to help consumers find products
and services with reduced environmental impacts. Environmental Choice is a voluntary,
multi-attribute, and lifecycle-based environmental certification. This certification indicates
that a product has undergone rigorous scientific testing, exhaustive auditing, or both, to
prove its compliance with stringent, third-party, environmental performance standards.

GERMANY

Germany - Blue Angel

ég“""”% RAL, the German Institute for Quality Assurance and Labeling, has awarded this device the Blue
i \ Angel Environmental Label. This label distinguishes it as a device that satisfies Blue Angel criteria
%ﬁmmg for environmental acceptability in terms of device design, manufacture, and operation. For more

information, go to: www.blauer-engel.de.

Blendschutz

Das Gerdt ist nicht fur die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. Um
storende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren
Gesichtsfeld platziert werden.

Ldrmemission

Maschinenldrminformations-Verordnung - 3. GPSGV, der hochste Schalldruckpegel betragt 75dB(A) gemdss EN ISO
7779.

Importeur

Xerox GmbH
Hellersbergstrae 2-4
41460 Neuss

Deutschland

TURKEY ROHS REGULATION
In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”

“EEE yonetmeligine uygundur.”
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EURASIAN ECONOMIC COMMUNITY CERTIFICATION

Economic Community, or EurAsEC. The Eurasian Economic Community members anticipate

[ H [ Russia, Belarus, and Kazakhstan are working to establish a common customs union, the Eurasian
sharing a common regulatory scheme and common EurAsEC certification mark, the EAC Mark.

REGULATORY INFORMATION FOR 2.4 GHZ WIRELESS NETWORK ADAPTER

This product contains a 2.4 GHz Wireless LAN radio transmitter module which complies with the requirements
specified in FCC Part 15, Industry Canada RSS-210 and European Council Directive 99/5/EC.

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the user’s
authority to operate this equipment.

OZONE RELEASE

This printer produces ozone during normal operation. The amount of ozone produced is dependent on copy volume.
Ozone is heavier than air and is not produced in amounts large enough to harm anyone. Install the printer in a well-
ventilated room.

For more information in the United States and Canada, go to www.xerox.com/about-xerox/environment/enus.html.
In other markets, please contact your local Xerox representative or go to www.xerox.co.uk/about-xerox/
environment/engb.html.
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Copy Regulations

UNITED STATES

Congress, by statute, has forbidden the reproduction of the following subjects under certain circumstances. Penalties
of fine or imprisonment may be imposed on those guilty of making such reproductions.

1. Obligations or Securities of the United States Government, such as:
e Certificates of Indebtedness.
¢ National Bank Currency.
e Coupons from Bonds.
o Federal Reserve Bank Notes.
o Silver Certificates.
e (Gold Certificates.
e United States Bonds.
e Treasury Notes.
e Federal Reserve Notes.
e Fractional Notes.
e Certificates of Deposit.
e Paper Money.
e Bonds and Obligations of certain agencies of the government, such as FHA and so on.

e Bonds. United States Savings Bonds may be photographed only for publicity purposes in connection with
the campaign for the sale of such bonds.

e Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a canceled
revenue stamp, this may be done provided the reproduction of the document is performed for lawful
purposes.

e Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be photographed,
provided the reproduction is in black and white and is less than 75 % or more than 150 % of the linear
dimensions of the original.

e Postal Money Orders.
e Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.

e Stamps and other representatives of value, of whatever denomination, which have been or may be issued
under any Act of Congress.

e Adjusted Compensation Certificates for Veterans of the World Wars.
2. Obligations or Securities of any Foreign Government, Bank, or Corporation.

3. Copyrighted materials, unless permission of the copyright owner has been obtained or the reproduction falls
within the “fair use” or library reproduction rights provisions of the copyright law. Further information of these
provisions may be obtained from the Copyright Office, Library of Congress, Washington, D.C. 20559. Ask for
Circular R21.
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Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be photographed.
Passports. Foreign Passports may be photographed.
Immigration papers.

Draft Registration Cards.

© N o b

Selective Service Induction papers that bear any of the following Registrant’s information:
e Earnings or Income.

e Court Record.

e Physical or mental condition.

e Dependency Status.

e Previous military service.

e Exception: United States military discharge certificates may be photographed.

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the various
Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the head of such
department or bureau).

Reproducing the following is also prohibited in certain states:
e Automobile Licenses.

e Drivers’ Licenses.

e Automobile Certificates of Title.

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case of doubt,
consult your attorney.

For more information about these provisions contact the Copyright Office, Library of Congress, Washington, D.C.
20559. Ask for Circular R21.

CANADA

Parliament, by stature, has forbidden the reproduction of the following subjects under certain circumstances.
Penalties of fine or imprisonment may be imposed on those guilty of making such reproductions.

e Current bank notes or current paper money
e Obligations or securities of a government or bank
e Exchequer bill paper or revenue paper

e The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of a court of
law

e Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause same to
purport to have been printed by the Queens Printer for Canada, or the equivalent printer for a province)

e Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a province,
the government of a state other than Canada or a department, board, Commission, or agency established by
the Government of Canada or of a province or of a government of a state other than Canada

282 Xerox® AltaLink® B80XX Series Multifunction Printer User Guide



Regulatory Information

Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of a province
or by the government of a state other than Canada

Documents, registers, or records kept by public officials charged with the duty of making or issuing certified
copies thereof, where the copy falsely purports to be a certified copy thereof

Copyrighted material or trademarks of any manner or kind without the consent of the copyright or trademark
owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is assumed for its
completeness or accuracy. In case of doubt, consult your solicitor.

OTHER COUNTRIES

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be imposed on
those found guilty of making such reproductions.

Currency notes

Bank notes and checks

Bank and government bonds and securities

Passports and identification cards

Copyright material or trademarks without the consent of the owner

Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of doubt, contact
your legal counsel.
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Fax Regulations
UNITED STATES

Fax Send Header Requirements

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other
electronic device, including a fax machine, to send any message unless such message clearly contains in a margin
at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it is sent
and an identification of the business or other entity, or other individual sending the message and the telephone
number of the sending machine or such business, other entity, or individual. The telephone number provided may
not be a 900 number or any other number for which charges exceed local or long-distance transmission charges.

For instructions on programming the Fax Send Header information, refer to the section of the System Administrator
Guide on Setting Transmission Defaults.

Data Coupler Information

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative Council
for Terminal Attachments (ACTA). On the cover of this equipment is a label that contains, among other information,
a product identifier in the format US:AAAEQ#H#TXXXX. If requested, this number must be provided to the Telephone
Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must comply with
the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular
plug is provided with this product. It connects to a compatible modular jack that is also compliant. See installation
instructions for details.

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the compliant
telephone line cord (with modular plugs) provided with the installation kit. See installation instructions for details.

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be connected to a
telephone line. Excessive RENs on a telephone line could result in the devices not ringing in response to an incoming
call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices
that can be connected to a line, as determined by the RENSs, contact the local Telephone Company. For products
approved after July 23, 2001, the REN is part of the product identifier that has the format US:AAAEQ##TXXXX. The
digits represented by ## are the REN without a decimal point (for example, 03 is a REN of 0.3). For earlier products,
the REN is separately shown on the label.

To order the correct service from the local Telephone Company, you could also have to quote the codes in the
following list:

e Facility Interface Code (FIC) = 02LS2
e Service Order Code (SOC) = 9.0Y

(D Caution: Ask your local Telephone Company for the modular jack type installed on your line. Connecting
this machine to an unauthorized jack can damage telephone company equipment. You, not Xerox,
assume all responsibility and/or liability for any damage caused by the connection of this machine to an
unauthorized jack.
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If this Xerox® equipment causes harm to the telephone network, the Telephone Company could temporarily
discontinue service to the telephone line to which it is connected. If advance notice is not practical, the Telephone
Company notifies you of the disconnection as soon as possible. If the Telephone Company interrupts your service,
they can advise you of your right to file a complaint with the FCC if you believe that it is necessary.

The Telephone Company could change its facilities, equipment, operations, or procedures which could affect the
operation of the equipment. If the Telephone Company changes something that affects the operation of the
equipment, they should notify you in order for you to make necessary modifications to maintain uninterrupted
service.

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for repair or
warranty information. Contact information is contained in the Device app on the printer and in the back of the
Troubleshooting section of the User Guide. If the equipment is causing harm to the telephone network, the
Telephone Company may request you to disconnect the equipment until the problem is resolved.

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make repairs to the
printer. This applies at any time during or after the service warranty period. If unauthorized repair is performed, the
remainder of the warranty period is null and void.

This equipment must not be used on party lines. Connection to party line service is subject to state tariffs. Contact
the state public utility commission, public service commission, or corporation commission for information.

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that the
installation of this Xerox® equipment does not disable your alarm equipment.

If you have questions about what could disable alarm equipment, consult your Telephone Company or a qualified
installer.

CANADA
This product meets the applicable Innovation, Science and Economic Development Canada technical specifications.

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or alterations
made by the user to this device, or device malfunctions, could cause the telecommunications company to request
you to disconnect the equipment.

For user protection, make sure that the printer is properly grounded. The electrical ground connections of the power
utility, telephone lines, and internal metallic water pipe systems, if present, must be connected together. This
precaution could be vital in rural areas.

(D Caution: Do not attempt to make such connections yourself. Contact the appropriate electric inspection
authority, or electrician, to make the ground connection.

The Ringer Equivalence Number (REN) indicates the maximum number of devices allowed to be connected to a
telephone interface. The termination of an interface may consist of any combination of devices subject only to the
requirement that the sum of the RENs of all the devices not exceed five. For the Canadian REN value, please refer to
the label on the equipment.

Canada CS-03 Issue 9

This product has been tested to and is compliant with CS-03 issue 9.
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EUROPEAN UNION

Some equipment may be used in both a domestic/household and a professional/business application.

Radio Equipment and Telecommunications Terminal Equipment Directive

This device has been designed to work with the national public switched telephone networks and compatible PBX
devices of the following countries:

PAN-EUROPEAN ANALOG PSTN AND COMPATIBLE PBX CERTIFICATIONS

Austria Greece Netherlands
Belgium Hungary Norway
Bulgaria Iceland Poland

Cyprus Ireland Portugal

Czech Republic Ttaly Romania
Denmark Latvia Slovakia

Estonia Liechtenstein Slovenia

Finland Lithuania Spain

France Luxembourg Sweden
Germany Malta United Kingdom

If you have problems with your product, contact your local Xerox representative. This product can be configured to
be compatible with other country networks. Before reconnecting the device to a network in another country,
contact your Xerox representative for assistance.

f Note:

e Although this product can use either loop disconnect (pulse) or DTMF tone signaling, Xerox recommends
that you use DTMF signaling. DTMF signaling provides reliable and faster call setup.

e Modification of this product, or connection to external control software or control apparatus not
authorized by Xerox, invalidates its certification.
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NEW ZEALAND

1.

The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has accepted that the
item complies with minimum conditions for connection to its network. It indicates no endorsement of the
product by Telecom, it does not provide any sort of warranty, and it does not imply that any Telepermitted
product is compatible with all Telecom network services. Above all, it provides no assurance that any item will
work correctly in all respects with another item of Telepermitted equipment of a different make or model.

The equipment may not be capable of correct operation at the higher data speeds designated. 33.6kbps and
56kbps connections are likely to be restricted to lower bit rates when connected to some PSTN implementations.
Telecom will accept no responsibility for difficulties that arise in such circumstances.

Immediately disconnect this equipment should it become physically damaged, then arrange for its disposal or
repair.

This modem shall not be used in any manner which could constitute a nuisance to other Telecom customers.

This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is no
guarantee that Telecom lines will always continue to support pulse dialing.

Use of pulse dialing, when this equipment is connected to the same line as other equipment, may give rise to
‘bell tinkle' or noise and cause a false answer condition. If you encounter such problems, do not contact the
Telecom Faults Service.

DTMF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is readily
available on almost all New Zealand telephone exchanges.

Warning: No '111" or other calls can be made from this device during a mains power failure.

This equipment may not provide for the effective hand-over of a call to another device connected to the same
line.

Some parameters required for compliance with Telecom Telepermit requirements are dependent on the
equipment (computer) associated with this device. The associated equipment shall be set to operate within the
following limits for compliance with Telecom Specifications:

For repeat calls to the same number:

e There shall be no more than 10 call attempts to the same number within any 30 minute period for any
single manual call initiation, and

e The equipment shall go on-hook for a period of not less than 30 seconds between the end of one attempt
and the beginning of the next attempt.

For automatic calls to different numbers:

The equipment shall be set to ensure that automatic calls to different numbers are spaced such that there is no
less than five seconds between the end of one call attempt and the beginning of another.

For correct operation, total of the RNs of all devices connected to a single line at any time should not exceed
five.

SOUTH AFRICA

This modem must be used in conjunction with an approved surge-protection device.
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Safety Certification

This device is certified by the following Agencies using the following safety standards.

AGENCY STANDARD

TUV-Rheinland (US and Canada) UL 60950-1:2007:R10.14
CAN/CSA C22.2 No. 60950-1-07 +A1:2011 +A2:2014

TUV-Rheinland (Europe) IEC 60950-1:2005 +A1 +A2
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Material Safety Data Sheets

For Material Safety Data information regarding your printer, go to:

e North America: www.xerox.com/safety-data

e FEuropean Union: www.xerox.com/about-xerox/environment_europe

For the Customer Support Center phone numbers, go to www.xerox.com/worldcontacts.
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This appendix contains:
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Recycling and Disposal

All Countries

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, mercury,
perchlorate, and other materials whose disposal may be regulated due to environmental considerations. The
presence of these materials is fully consistent with global regulations applicable at the time that the product was
placed on the market. For recycling and disposal information, contact your local authorities. Perchlorate Material:
This product may contain one or more Perchlorate-containing devices, such as batteries. Special handling may
apply. For more information, go to www.dtsc.ca.gov/hazardouswaste/perchlorate.
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Recycling and Disposal

North America

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative (1-800-ASK-
XEROX) to determine if this Xerox product is part of the program. For more information about Xerox environmental
programs, visit www.xerox.com/about-xerox/environment, or for recycling and disposal information, contact your
local authorities.

Xerox® AltaLink® B80XX Series Multifunction Printer User Guide 293


https://www.xerox.com/en-us/about/ehs

Recycling and Disposal

European Union

Some equipment may be used in both a domestic/household and a professional/business application.

DOMESTIC/HOUSEHOLD ENVIRONMENT

Application of this symbol on your equipment is confirmation that you should not dispose of the
equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be
segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to designated
collection facilities free of charge. Please contact your local disposal authority for information.

In some member states, when you purchase new equipment, your local retailer may be required to take back your
old equipment free of charge. Please ask your retailer for information.

PROFESSIONAL/BUSINESS ENVIRONMENT

Application of this symbol on your equipment is confirmation that you must dispose of this
equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be
managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back information.
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COLLECTION AND DISPOSAL OF EQUIPMENT AND BATTERIES

These symbols on the products and/or accompanying documents mean that used
electrical and electronic products and batteries should not be mixed with general
household waste.

[ ] For proper treatment, recovery, and recycling of old products and used batteries, please
take them to applicable collection points, in accordance with your national legislation
and the Directive 2002/96/EC and 2006/66/EC.

By disposing of these products and batteries correctly, you will help to save valuable
resources and prevent any potential negative effects on human health and the
environment which could otherwise arise from inappropriate waste handling.

For more information about collection and recycling of old products and batteries, please
contact your local municipality, your waste disposal service or the point of sale where
you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in accordance with
national legislation.

Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for further
information.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you wish to discard these items, please contact your local
authorities or dealer and ask for the correct method of disposal.

BATTERY SYMBOL

This wheeled bin symbol may be used in combination with a chemical symbol. Use of
this symbol establishes compliance with the requirements set out by the Directive.

BATTERY REMOVAL

Batteries should only be replaced by a manufacturer-approved service facility.
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Recycling and Disposal

Other Countries

Please contact your local waste management authority to request disposal guidance.
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Apps Features

This appendix contains:
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Output Color

DESCRIPTION

Use Output Color to control the
color rendering of the output
image or print.

2-Sided Copying

and 2-Sided
Scanning

You can use the 2-Sided options to
set the device to scan one or both

sides of an original document. For

Copy jobs, you can specify 1-Sided
or 2-Sided output.

Paper Supply

Use Paper Supply to specify the
size, type and color of the paper
required, or the Paper Tray to use.
If Auto is selected, the printer
chooses the paper tray based on
the original document size and the
selected settings.

Collation

You can collate multiple-page
copy jobs automatically. For
example, when making three
1-Sided copies of a six-page
document, the copies are printed
in this order:

Apps Features

SCAN TO | COPY
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FEATURE

DESCRIPTION

1,2,3,4,56;1,2,3,4,56;1,2,
3,4,5,6.

SERVER
FAX

INTER-
NET FAX

WORK-
FLOW

SCAN-
NING/
SCAN TO

ID CARD
COoPY

Finishing

If finishing options are available,
use this option to choose the
finishing options required for your
printed output.

Reduce / Enlarge

You can reduce the image to as
little as 25 % of its original size or
enlarge it as much as 400%. Use
Proportional % to maintain
original proportions when resizing,
or use Independent % to adjust
the width and length of the image
by different percentages.

Original Type

The printer optimizes the image
quality of the copies based on the
type of images in the original
document and how the original
was created.
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Contrast

DESCRIPTION

You can use the Contrast feature
to adjust the variation between
light and dark areas of the image.

Lighten / Darken

Use the Lighten/Darken slider to
make the output image or print
lighter or darker.

Sharpness

Use this option to sharpen the
output image or print. For best
results, sharpen text images and
soften photos.

Saturation

Saturation allows you to adjust
the color strength and the amount
of gray in the color.

f Note: This feature is not
available when Output
Color is set to Black and
White or Grayscale.

Original
Orientation

You can use the Original
Orientation option to specify the
layout of the original images that
you scan. The printer uses the

Apps Features

SCAN TO | COPY
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FEATURE

DESCRIPTION

information to determine if
images require rotation to
produce the desired output.

WORK-
FLOW

SCAN-
SERVER | INTER- NING/
FAX NET FAX | SCAN TO

ID CARD
COoPY

Image Shift

Image Shift allows you to modify
the location of the image on the
page. You can shift the printed
image along the X and Y axes of
each sheet of paper.

Auto Background

Suppression

Use the Auto Background
Suppression setting to reduce the
sensitivity of the printer to
variations in light background
colors.

Edge Erase

You can erase content from the
edges of your images using the
Edge Erase feature. You can
specify the amount to erase on
the right, left, top, and bottom
edges.

Original Size

To ensure that you are scanning
the correct area of the documents,
specify the original document size.
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WORK-
FLOW

SCAN-
SERVER | INTER- NING/ ID CARD
FEATURE DESCRIPTION FAX NET FAX | SCAN TO | COPY

m Book Copying You can use the Book Copying .

feature to copy books, magazines,
or other bound documents.

Mirror Image Use Mirror Image to reverse the .
image and text on the page.

Negative Image | Negative Image reverses the light | e
and dark areas in your document,

and print it as though it were a
photo negative. Printing a
negative image is useful for
documents that have a substantial
amount of dark background or
light text and images.

covers and inserts to your job. You
can specify exception pages to
print on different paper than the
main body of the job. You can also
program Chapter start pages.

E‘D Special Pages Special Pages is used to add .
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WORK-
FLOW

SCAN-
SERVER | INTER- NING/ ID CARD
FEATURE DESCRIPTION FAX NET FAX | SCAN TO | COPY

Annotations You can add Annotations, such as | e
page numbers and the date, to
your copies.

Booklet Creation | The Booklet Creation feature .

prints two pages on each side of
the paper. The pages are
reordered so that they are in
numerical order when folded.

1] 2 Page Layout You can print the selected number | o
3|4 of pages on one side of a sheet of

paper. Selecting multiple pages
per sheet saves paper and
provides a way to review the
layout of a document.

r Sample Job Sample Job allows you to print a .
FO test copy of a job to inspect

before printing multiple copies.
This feature is useful for complex
or high-volume jobs. After you
print and inspect the test copy,
you can choose to print or cancel
the remaining copies.
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FEATURE

Transparency
Separators

DESCRIPTION

Use Transparency Separators to
add blank sheets of paper
between each printed
transparency. The size and
orientation of the separators must

be the same as the transparencies.

SERVER
FAX

INTER-
NET FAX

WORK-
FLOW
SCAN-
NING/
SCAN TO

ID CARD
COoPY

Build Job

Use Build Job for jobs that include
a variety of original documents
requiring different settings, or for
scanning multiple-page jobs from
the document glass. The job is
scanned in segments. After all the
segments are scanned, the job is
processed and completed.

Save Current
Settings

To use a particular combination of
copy settings for future copy jobs,
you can save the settings with a
name and retrieve them for later
use.

Retrieve Current
Settings

You can retrieve and use any
previously saved copy settings for
current jobs.
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FEATURE

DESCRIPTION

WORK-
FLOW

SCAN-
SERVER | INTER- NING/
FAX NET FAX | SCAN TO

ID CARD
COoPY

Quantity Use this option to enter the .
number of required ID card copies.
Resolution Resolution determines how fine or . . .

grainy graphic images appear.
Image resolution is measured in
dots per inch (dpi).

Remove Blank

Pages

Remove Blank Pages configures
the printer to ignore blank pages.

From

Use the From option to specify the
originator of the email.

f Note: The system
administrator can preset
this option to populate
automatically with your
user account details.

Reply To

Use the Reply To option to include
an email address you want the

recipient to reply to. This option is
useful if you want the recipient to
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Apps Features

FEATURE

DESCRIPTION

reply to your email address rather
than to the device.

P
& Note: The system
administrator can preset
this option.

SERVER
FAX

INTER-
NET FAX

WORK-
FLOW

SCAN-
NING/
SCAN TO

ID CARD
COoPY

Message

Use Message to enter information
to accompany the email.

Quality / File Size

The Quality/File Size option lets
you choose from three settings
that balance the quality of the
image and the size of the file.
Higher quality images result in
larger file sizes, which are not ideal
for sharing and transmitting over
the network.

File Format

Use the File Format option to
specify the format of the saved
image or to define a searchable
image. You can add a password to
protect the image or choose to
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FEATURE

DESCRIPTION

combine multiple images into a
single file.

WORK-
FLOW

SCAN-
SERVER | INTER- NING/
FAX NET FAX | SCAN TO

ID CARD
COoPY

If File Already
Exists

Use the If File Already Exists
option to define what action the
device takes when the file name is
used already.

File and
Attachment

Use the File and Attachment
option to specify a name for the
file containing the scanned
images.

Acknowledge-
ment Report

You can request to print a report
to confirm that each recipient has
received the scanned file. The
report contains delivery status
information.

P
f Note: The report depends
on recipient response time.

Update
Workflows

Use Update Workflows to refresh
the list of workflows displayed at
the control panel.
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FEATURE

Add File
Destinations

DESCRIPTION

Use this option to choose more
destinations for filing the scanned
images.

SERVER
FAX

INTER-
NET FAX

WORK-
FLOW
SCAN-
NING/
SCAN TO

ID CARD
COoPY

Book Faxing

You can use the Book Faxing
feature to scan images from
books, magazines, or other bound
documents for faxing.

Reduce/Split

Use the Reduce/Split option to
specify how your faxed document
is printed on the receiving fax
machine. If the image is too large
to fit on the paper size, you can
reduce the image to fit or split
across multiple pages.

Confirmation
Report

You can request a report to
confirm if your fax has been
received. To receive a
Confirmation Report only if an

error occurred during transmission,

choose Print on Error Only.
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FEATURE

Starting Rate

DESCRIPTION

Select the highest starting rate for
transmitting the fax, unless the
destination for the fax you are
sending has special requirements.
Forced (4800 bps) is the
recommended setting for lines
that may have transmission
interference.

WORK-

FLOW

SCAN-
SERVER | INTER- NING/
FAX NET FAX | SCAN TO

ID CARD
COoPY

Cover Sheet

You can use the Cover Sheet
option to add an introduction

page to the beginning of your fax.

You can add a short comment to
the cover sheet, and To and From
details.

Send Header Text

It is unlawful to send a message
from a fax machine without the
proper Transmission Header Text.
Ensure that the name and
telephone number of the sender,
and the date and time of the
transmission are included on all
faxes.
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FEATURE

Delay Send

DESCRIPTION

You can set a time in the future for
the printer to send your fax job.
You can delay the sending of your
fax job for up to 24 hours.

WORK-

FLOW

SCAN-
SERVER | INTER- NING/
FAX NET FAX | SCAN TO

ID CARD
COoPY

Polling

Fax Polling allows you to store a
fax document on the printer and
make it available for other fax
machines to poll. You can retrieve
faxes stored on other fax
machines. To use this feature, both
the polling printer and the remote
printer must have the Polling
feature.

Mailboxes

Use the Fax Mailboxes option to
store faxes that have been
retrieved from a remote fax
machine, or to store faxes for
retrieval by a remote fax machine.
The mailbox number is required to
access a mailbox. You can set a
passcode to secure confidential
documents.
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